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Welcome About This Guide ii
Welcome
Welcome to Sterling Commerce’s Gentran:Server electronic commerce software 
for the Workstation product level.

What is in this
guide

This guide provides instructions for maintaining your Gentran:Server installation. It 
also provides troubleshooting information to help you determine the cause and 
solution of problems that may occur with your installation.

Who should use
this guide

This guide is for administrators charged with managing electronic commerce 
application software. 

It can also be used by Gentran:Server users to determine the correct response to 
error or warning messages.
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About This Guide Chapter Contents  iii
Chapter Contents
This table describes the contents of chapters within this Maintenance and 
Troubleshooting Guide.

Chapter Title Description

About This Guide Explains the content, organization, and 
conventions in this guide. Explains how to get 
help if you cannot solve a problem by using the 
information provided in this guide. 

Introduction Describes the capabilities of each level of the 
Gentran:Server product line and describes 
supported hardware and software 
configurations. The chapter then provides a 
basic understanding of the elements of 
Gentran:Server.

System Messages Lists warning and error messages you may 
encounter when using Gentran:Server. 
Explains the meaning of the message and the 
action you should take to correct the situation. 
Includes UNIX and DISAM error messages.

Moving Files Overview Describes the process for moving files.

Planning the Move Explains how to describe the source and 
destination environments and choose a file 
transfer method.

Preparing to Move Files Describes preliminary actions required before 
moving Gentran:Server files.

Moving Files Explains how to move Gentran:Server files 
from one stand-alone PC to another.
Maintenance and Troubleshooting Guide – August 2004



Related Publications About This Guide iv
Related Publications

Gentran:Server
documentation

This table describes additional documentation for the Gentran:Server software.

Document Description

Upgrade and Data 
Conversion Guide

Instructions for upgrading from previous versions of 
Gentran:Server Workstation and Gentran:Server for 
UNIX. Also includes instructions for converting the files 
that are part of the upgrade.

Installation Checklist Description of the recommended sequence in which 
you should install and configure system components.

Gentran:Server 
Workstation Getting 
Started Guide 

Instructions for installing the Gentran:Server 
Workstation software and performing setup tasks.

Instructions for starting and exiting Gentran:Server and 
for setting preferences and default values. Also 
includes instructions for checking files in and out and 
saving files.

Application 
Integration User’s 
Guide

Instructions for performing mapping and translation 
tasks using the Gentran:Server Application Integration 
Mapper. 

Mapping and 
Translation Guide

Instructions for performing mapping and translation 
tasks using the Gentran:Server Visual Mapper.

Note
This guide is provided only if you maintain maps 
created with Gentran:Server version 5.3 or prior.

NCPCP User’s Guide Instructions for mapping and translating NCPDP files 
with the Application Integration system.

XML User’s Guide Instructions for mapping and translating XML files with 
the Application Integration system.

Note
This guide is provided only if your organization has the 
Gentran:Server XML translation option.

(Continued on next page)
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ODBC User’s Guide Instructions for mapping and translating ODBC files 
with the Application Integration system.

Note
This guide is provided only if your organization has the 
Gentran:Server ODBC translation option.

GENCOD User’s 
Guide

Instructions for mapping and translating GENCOD files 
with the Application Integration system and the Visual 
Mapper.

VDA User’s Guide Instructions for mapping and translating VDA files with 
the Application Integration system and the Visual 
Mapper.

Technical Reference 
Guide

Describes processes, lists command-line commands in 
alphabetical order, and describes file record layouts 
and data type formats.

Online Help Context-sensitive help screens describing the 
Gentran:Server dialog boxes for the mapping and 
translation features. Also includes procedures for using 
the mapping and translation and the data flow 
administration software.

 (Contd)
Document Description
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Other
documentation

This table lists other documentation you may need to refer to when installing and 
setting up Gentran:Server.

Description Source

Instructions for installing and using the operating 
system on your computer.

Your hardware vendor 

The computer 
manufacturer
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Documentation Conventions

Typographic
conventions

This table describes the typographic conventions used in this guide.

Symbols used
within syntax

statements

This table describes symbols used within syntax statements.

Convention Use

Italics This typeface is used for titles of other manuals and 
documents, names of files and file extensions, and to 
emphasize important information.

Example
Gentran:Server for UNIX and Workstation Application 
Integration User’s Guide

Bold Bold type is used for program names, key terms the 
first time they are used within a chapter, and entries 
you are to make on-screen.

Example
A password is a set of characters a user must enter to 
gain access to a system.

Symbol Use

< > Substitute a value for any term that appears within 
angle brackets. Do not enter angle brackets unless 
specifically told to do so. 

Example
rm <filename> means that you should type the name 
of the file you want to delete.

{ } Braces indicate a required part of a statement. Do not 
enter the braces.

Example
{-f <filename>} means you must enter the f parameter 
followed by a filename.

(Continued on next page)
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[ ] Brackets indicate an optional part of a statement. Do 
not enter the brackets.

Example
[-f <filename>] means you could type the f parameter 
followed by a filename, but you are not required to do 
so.

… An ellipse indicates that the immediately preceding 
item can be repeated indefinitely. Do not enter the 
ellipse.

Example
-e… means that you can repeat -e with other values.

( ) Parentheses should be entered as shown. They are 
part of the syntax of a statement and are not special 
symbols.

Example
(n) means that you should type a number enclosed by 
parentheses.

 (Contd)
Symbol Use
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Overview

Introduction This chapter describes the capabilities of each level of the Gentran:Server 
product line and then describes supported hardware and software configurations. 
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Product Levels

Product level
and feature table

This table lists the levels of the Gentran:Server product suite, and provides a brief 
description of the features available at each level. The table lists product levels in 
order of increasing functionality.

Product Level Description

Gentran:Server 
Workstation

Provides mapping and translation software for 
personal computers running Microsoft Windows 98®, 
Windows 2000®, or Windows NT 4.0. 

This software includes graphical interface for:

◗ Creating and editing maps
◗ Managing trading partnership information
◗ Managing audit data
◗ Managing archive data.

It also includes a Communications Toolkit utility which, 
combined with Cleo Communications, automates data 
communications between Gentran:Server Workstation 
and Trading Partners.

Gentran:Server for 
UNIX

Provides a Microsoft Windows 98®, Windows 2000®, 
or Windows NT 4.0 interface on client PCs to enable 
users to run mapping and translation software on a 
UNIX host.

Includes a Security Administration utility for managing 
access to user accounts, files, and software functions 
on the host computer.

Gentran:Server for 
UNIX with Process 
Control Manager

Adds basic data routing capabilities on the UNIX host. 
Enables process control for basic inbound and 
outbound data flows. 

Includes a Life Cycle utility that, combined with 
additional database software, creates audit records of 
each process performed on your data.

Gentran:Server for 
UNIX with EC 
Workbench

Provides sophisticated data routing capabilities on the 
UNIX host. Enables process control for multiple data 
flows. Includes the Life Cycle utility.

(Continued on next page)
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Note
Gentran:Server also supports the Gentran:Server WebSuite option.

Hardware and
operating

system
requirements

See the Gentran:Server installation instructions for hardware and operating 
system requirements.

Gentran:Server for 
UNIX with Advanced 
Data Distribution

Adds the mailbox capabilities of Gentran:Server 
Advanced Data Distribution software to 
Gentran:Server with EC Workbench.

 (Contd)
Product Level Description
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Log Files and Temporary Files

Introduction The directory to which the system directs the temporary files and log files that it 
produces depends upon the product level and whether you are operating in 
attended mode or unattended mode. 

Workstation
level

This table summarizes the location of log files and temporary files for 
Gentran:Server for Workstation product level.

File Type Workstation PC

Temporary (temp) 
files

Wrktmp subdirectory of the path you have configured 
for User Files on the Set Up Directories dialog box.

Log files The directory of the path you have configured for 
Report/Log files on the Set Up Directories dialog box.
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Overview

Introduction This chapter lists the messages you might see while using Gentran:Server’s 
mapping and translation features. 

How messages
are organized

The messages in this chapter are listed according to the following guidelines:

◗ Messages with numbers are listed in numerical order. All others are listed in 
alphabetical order. 

◗ Two or more messages with the same number are listed in alphabetical order 
by the program part. Articles (‘a’ and ‘the’) are included in the alphabetization. 

◗ Variables (surrounded by < >) appear first in the alphabetical list.

Information
included

This section identifies the information provided in addition to the message text.

Message type
This table describes the types of messages Gentran:Server displays.

Program module
The program module is the part of Gentran:Server issuing the message. This is 
obvious in some cases, but not in others. For example, most messages 
encountered while creating or editing mapping instructions are issued by the 
compiler.

(Continued on next page)

Message Type Function

Error Indicates that Gentran:Server cannot perform this 
process or has stopped performing the current process.

Warning Alerts you to a possible problem but allows processing to 
continue.

Prompt Elicits additional information that Gentran:Server needs 
in order to continue the process.

Informational 
message

Provides feedback about, or the status of, the process 
just completed.
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Explanation
Possible reasons for the error or warning or a detailed discussion of the type of 
information the message presents.

Procedure
The procedure or response you must follow or give to continue processing and/or 
ensure the integrity of your data.

Message
conventions

Messages may contain variables. Variables are enclosed in angle brackets (<  >) 
and indicate the position of the specific data that prompted Gentran:Server to 
display the message. 

Example
Input file: <path>\<file name> 

The message displays the actual path and name of the file in place of the 
variables <path> and <file name>.
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Messages in Numerical Order

Contents This section lists numerical messages. These messages appear in the xlcntl.err 
file stored in the Gentran:Server temporary directory.

References
◗ To find a message that begins with a variable, see the topic Messages in 

Alphabetical Order (Starting with Variables) in this chapter.
◗ To find a message that begins with an alphanumeric character (neither a 

number, nor a variable), see the topic Messages in Alphabetical Order (Not 
Starting with Variables) in this chapter.

000 Record encountered for set in error
TP Code: <TP Code>
Set Id:     <Set ID>

Message Type: Warning
Program Module: ediarc

Explanation:
The translator was unable to translate a set because it contained errors. The 
translator created no output for this set. 

Gentran:Server wrote a record to edistat.i/edistat.o indicating the error. The 
ediarc program then read the record and wrote a message to xlcntl.err instead of 
archiving the data.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Look at xlcntl.err to find the set identified by its Trading Partnership 
Code and Set ID.

2 Determine the nature of the errors, then decide whether the errors 
warrant retranslating the data.

3 Correct the errors and retranslate the data.
Maintenance and Troubleshooting Guide – August 2004



System Messages Messages in Numerical Order 2 - 5
000 Input file: <path>\<file name>
Output file: <path>\<file name>

Message Type: Informational
Program Module: edifrmat

Explanation:
The edifrmat program processed the specified input file and wrote the results to 
the specified output file.

Procedure:
No action is necessary. You can verify that the output file contains the data it 
should if the circumstances warrant that action.

000 Translated interchanges without errors: <number>
Untranslated interchanges with errors: <number>

Message Type: Informational
Program Module: Iftran

Explanation:
This message appears at the end of the xlcntl.err file after TRADACOMS 
translation is complete. 

Procedure:
No action is necessary.

(Continued on next page)
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001 Number of document sets archived: <number>
Number of FA records processed: <number>
Number of records/sets not processed: <number>
Total sets/records: <number>

Message Type: Informational
Program Module: ediarc

Explanation:
This message provides the results of the ediarc command.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Verify that ediarc was able to archive all document sets.

2 Check the number of records/sets not processed.

3 Use this table to determine your next action.

IF the number of unpro-
cessed record/sets is... THEN...

Zero (0) Take no further action.

One (1) or more 1. Review the ediarc error messages 
for more detailed information on each 
record/set not archived

2. Review the information on those 
error messages and the actions you 
should take.
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004 Compliance check error(s): 
Message Type: Warning or Error
Program Module: Iftran

Set up notes
If you select the Accept Sets with Errors option on either the Inbound or Outbound 
Translation Information part of the Trading Partnership Record, the translation 
continues and disregards the warning.

Also, the Accept Messages /Sets with error(s) option on the Inbound or 
Outbound EDI Information tab of the Trading Partnership Editor must be 
inactive to prevent Gentran:Server from accepting or sending sets that contain 
errors. 

Topic organization
There are several errors that prompt Gentran:Server to display this message. 
Each error is identified and explained below. Where appropriate, examples are 
provided. Additional procedures are provided when necessary. 

Procedure:
Use one of these responses if you receive this message:

IF... THEN...

You accept or reject the inbound data 
and send functional 
acknowledgements 

or

You accept the inbound data, but do 
not send functional 
acknowledgements

Further action is not required.

Note
Although not required, you should 
contact your trading partner and ask 
them to correct the error if you reject 
the data.

You reject the inbound data and do 
not send functional 
acknowledgements

Notify your trading partner of the error 
and ask them to send a corrected set 
of data.

(Continued on next page)
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(Continued on next page)

Your trading partner accepts your 
outbound data

Further action is not required.

Your trading partner rejects your 
outbound data, 

Follow these steps to correct the data.

1. Modify the implementation guide to 
correct the error 

2. Correct the map and compile the 
new version

3. Translate the data using the new 
version of the map

4. Send the corrected version to your 
trading partner.

 (Contd)
IF... THEN...
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Error types:
This table describes the different compliance errors. The table also provides 
examples and specific correction notes where appropriate.

Error Description

Conditional element 
missing

The data lacks one or more conditional elements. 
Conditional elements are dependent on other 
elements. Conditional elements must be present in the 
data when the elements requiring them are present. 

Example
An element containing a number is present, but the 
element specifying whether the number is a telephone 
number or a fax number is absent.

Specific correction
Add missing conditional element or mark it used. If you 
have no data for this element, map a literal, spaces, or 
zeros.

Element too long The inbound data contains one or more elements that 
are longer than the maximum length allowed by the 
standard, IG, or Gentran:Server. Gentran:Server 
allows a maximum length of 512 characters per 
element. 

Element too short The data contains one or more elements that are 
shorter than the minimum length required by the 
standard, IG, or Gentran:Server.

Specific correction
Check to see if another message indicates that data 
was truncated. If no data was truncated, you can send 
this data. You should correct the IG and map used and 
compile the map before using it again.

If data was truncated, refer to that message in this 
table for the specific correction.

(Continued on next page)
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Exclusion condition 
violated

The data contains one or more exclusion condition 
elements even though the specified elements are 
present. Exclusion condition elements are dependent 
on other elements. Exclusion condition elements must 
not be present in the data when the elements requiring 
their exclusion are present. 

Example: 
Two elements specifying a payment currency exist in 
the data. One element specifies that payment be in 
American dollars. Another specifies that payment be in 
British pounds.

Specific correction
Delete the unnecessary element from the 
implementation guide.

Invalid character in 
element

One or more elements contain characters defined as 
invalid by the standard or IG. Each element in a 
standard or IG has a required data type. Only certain 
characters are valid for each data type.

Example:
Elements with the data types of N and R data types 
can contain only a plus (+), a minus (-), or a decimal 
point (.). Any alphabetic character or other symbol is 
invalid. 

Specific correction
Correct the application data and/or the application 
description, if necessary

Invalid code Gentran:Server found one or more elements with 
invalid element ID codes in the data. There is a list of 
allowable element ID codes for each element of type 
ID Gentran:Server validated the element ID codes 
against this list. 

(Continued on next page)

 (Contd)
Error Description
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Invalid date The data contains one or more elements with data type 
DT that contain invalid dates. 

Example 
The data may include month 14 or day 56 (for non-
Julian dates). 

Note
 If the source date format is different from the 
destination date format, Gentran:Server converts the 
data.

Invalid time The data contains one or more elements with data type 
TM that contain invalid times. 

Example 
The data may include Julian day 555. 

Notes
 If the source time format is different from the 
destination time format, Gentran:Server converts the 
data.

Mandatory element 
missing

The data lacks one or more of the mandatory elements 
required by the standard, or a non-mandatory segment 
was not activated in the map. Mandatory elements 
must be present in the data. These are mandatory 
elements. 

Specific correction
Add missing conditional element or mark it used. If you 
have no data for this element, map a literal, spaces, or 
zeros. If you have data, activate the segment or 
element.

Mandatory loop 
missing

The data lacks the beginning segment for one or more 
mandatory loops required by the standard. Mandatory 
loops must be present in the data. 

Specific correction
Add the missing mandatory loop(s). If you have no 
data for an element, map a literal, spaces, or zeros.

(Continued on next page)

 (Contd)
Error Description
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007 Processing segment: <segment>

Message Type: Informational
Program Module: Iftran

Explanation:
This message indicates which segment the translator is processing. Run lftran 
with the -d parameter to write this message to the xlcntl.err file.

Note:
When you run lftran with the -d parameter, you can read the processing 
messages in the xlcntl.err file to determine on what segment the translation failed. 

(Continued on next page)

Mandatory segment 
missing

The data lacks one or more mandatory segments 
required by the standard. Mandatory segments must 
be present in the data. 

Specific correction
Add the missing mandatory segments. If you have no 
data for an element, map a literal, spaces, or zeros.

Too many elements The data contains one or more segments with too 
many elements, as defined by the standard. The 
standard determines which elements each segment 
can contain. 

Specific correction
For inbound data, compare the map you are using for 
the translation against the standard you are using. 
Make sure that your map contains the same number of 
elements as is required by the standard. If your map is 
missing elements, add them back.

Note
Although not required, you should contact your trading 
partner and ask them to correct the error if you 
determine that they are sending extra data.

 (Contd)
Error Description
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008 Memory allocation error

Message Type: Error
Program Module: Iftran

Explanation:
There is not enough memory free to continue the translation.

Procedure:
Use this procedure in response to this message:

 015 Do you wish to automatically change all mappings associated with source 
<source label> to use this synonym list?

Message Type: Prompt
Program Module: Synonym Editor

Explanation:
Gentran:Server must know whether to use or not use the synonym list for each 
occurrence of this source item. You can assign a synonym to a source item used 
in one or more mapping instructions. 

Procedure:
Use this procedure in response to this message:   

Note
You can assign a synonym to a source item in a particular mapping instruction 
without affecting the source item in other mapping instructions using the generic/
specific synonym of source mapping operation. Use the Mapping Instructions 
window to access this operation.

(Continued on next page)

Step Action

1 Close all other open applications.

2 Run the translation again.

If you want... Then...

Gentran:Server to use the synonym list for this same source 
item in every mapping instruction in which the source item 
appears

Click Yes

Gentran:Server to not use the synonym list for any occurrence 
of this source item

Click No.
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020 Incorrect line item count in CTT: Data = <number>,
Actual = <number>

Message Type: Warning
Program Module: Iftran

Explanation:
Gentran:Server found an error in the line item count in the CTT segment. 

Note
This error does not stop the translator from completing the translation.

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF... THEN...

You accept the data Further action is not required.

You reject the data Notify your trading partner of the error and ask them to 
send a corrected data set.

Your trading partner 
accepts the data 

Further action is not required. 

Your trading partner 
rejects the data.

Translate the data again and check the CTT segments. 
If they are correct, resend the corrected data. If not, 
correct the map, translate the data, and send the new 
data to your trading partner.
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021 Incorrect hash total in CTT: Data = <number>,
Actual = <number>

Message Type: Warning
Program Module: Iftran

Explanation:
Gentran:Server has found an error in the hash total in the CTT segment. 

Note
This error does not stop the translator from completing the translation.

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF... THEN...

You accept the data Further action is not required.

You reject the data Notify your trading partner of the error and ask them to 
send a corrected data set.

Your trading partner 
accepts the data 

Further action is not required. 

Your trading partner 
rejects the data.

Translate the data again and check the CTT segments. 
If they are correct, resend the corrected data. If not, 
correct the map, translate the data, and send the new 
data to your trading partner.
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022 Message # seq error: This message = <control num>,
Last message = <control num>

Message Type: Warning
Program Module: Iftran

Explanation:
Gentran:Server has found an error in the sequence of set control numbers. The 
file may contain duplicate data or be incomplete.

This error stops Gentran:Server from completing the translation only if you use 
lftran with the S parameter. If the translation stops, Gentran:Server writes the 
input data to boxin.err when this error occurs. 

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF... THEN...

You accept the inbound data

Note
You should accept the 
inbound data only if you are 
certain it is complete.

1. Find and remove any duplicate data

2. Correct the control numbers

3. Open the Trading Partner Maintenance 
dialog box.

4. Click the Inbound Translation Information 
Tab and change the set control number to 
match the control number of the last set.

You reject the inbound data Notify your trading partner of the error and ask 
them to send corrected data.

Your trading partner accepts 
your outbound data

Further action is not required.

Your trading partner rejects 
your outbound data

Translate the data again and send the 
corrected data.
Maintenance and Troubleshooting Guide – August 2004



System Messages Messages in Numerical Order 2 - 17
 023 Group # seq error: This group = <control num>, Last group = <control num>

Message Type: Warning
Program Module: Iftran

Explanation:
Gentran:Server has found an error in the sequence of group control numbers. The 
file may contain duplicate data or be incomplete. 

This error stops Gentran:Server from completing the translation only if you use 
lftran with the S parameter. If the translation stops, Gentran:Server writes the 
input data to boxin.err when this error occurs. 

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF... THEN...

You accept the inbound data

Note

You should accept the 
inbound data only if you are 
certain it is complete.

1. Find and remove any duplicate data

2. Correct the control numbers

3. Open the Trading Partner Maintenance 
dialog box.

4. Click the Inbound Translation Information 
Tab and change the group control number to 
match the control number of the last group.

You reject the inbound data Notify your trading partner of the error and ask 
them to send corrected data.

Your trading partner accepts 
your outbound data

Further action is not required.

Your trading partner rejects 
your outbound data

Translate the data again, then send the 
corrected data.
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024 Interchange # seq error: This interchange = <control num>, Last
interchange = <control num>

Message Type: Warning
Program Module: Iftran

Explanation:
Gentran:Server has found an error in the sequence of set control numbers. The 
file may contain duplicate data be incomplete. 

This error stops Gentran:Server from completing the translation only if you use 
lftran with the S parameter. If the translation stops, Gentran:Server writes the 
input data to boxin.err when this error occurs. 

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF... THEN...

You accept the inbound data

Note

You should accept the inbound data 
only if you are certain it is complete.

1. Find and remove any duplicate data

2. Correct the control numbers

3. Open the Trading Partner 
Maintenance dialog box.

4. Click the Inbound Translation 
Information Tab and change the 
interchange control number to match 
the control number of the last 
interchange.

You reject the inbound data Notify your trading partner of the error 
and ask them to send corrected data.

Your trading partner accepts your 
outbound data

Further action is not required.
Maintenance and Troubleshooting Guide – August 2004



System Messages Messages in Numerical Order 2 - 19
 049 Application data error: <error type>
Output record: <record ID>, Output field: <field name>

Message Type: Error
Program Module: Iftran

Explanation:
The translator found an error in your application data. A description of the error 
replaces the <error type> variable shown in the example above. For more 
information about the second line of the message, refer to error 076.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Check the record and field indicated. 

2 Correct the data and/or the data description as necessary.

3 If changes are made, compile the map and translate the data 
again.
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050 Interchange control number mismatch. ISA12 = <interchange control 
number>
IEA02 = <interchange control number>

Message Type: Error
Program Module: Iftran

Explanation:
The ISA Interchange Header segment does not match the control number in the 
IEA Interchange Trailer segment. 

Note
This error may be due to duplicate or missing data.

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF... THEN...

You accept the inbound data

Note

You should accept the inbound data 
only if you are certain it is complete.

1. Find and remove any duplicate 
data.

2. Manually correct the control 
numbers.

You reject the inbound data Notify your trading partner of the error 
and ask them to send corrected data.
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053 Invalid group count: IEA01 = <number of groups counted>
Actual = <number of groups present> Interchange Control # <control 
number>

Message Type: Error
Program Module: Iftran

Explanation:
The inbound translator found an invalid group count. 

Note
The translator wrote an error message to xlcntl.err, the invalid interchange to 
boxin.err, and did not include the invalid interchange in the output file.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Review the invalid interchanges in the boxin.err file to determine 
why the group count is invalid.

2 Notify your trading partner of the error and ask them to send 
corrected data.
Maintenance and Troubleshooting Guide – August 2004



Messages in Numerical Order System Messages2 - 22
060 Invalid segment count: SE01 = <number of segments counted> 
Actual = <number of segments present> Set Control # <set control number>

Message Type: Error
Program Module: Iftran

Explanation:
The translator found an invalid segment count. The translator wrote an error 
message to xlcntl.err, the invalid group to boxin.err or boxout.err, and omitted the 
invalid group from the output file.

Procedure:
Use this procedure in response to this message:

 061 '-A' option with invalid .app file = <file name>

Message Type: Error
Program Module: lftran

Explanation:
The file name entered after the A parameter in the lftran command was invalid. 
You must enter the name of a valid application file before Gentran:Server can take 
the trading partnership code from the application description during multiple 
outbound translations.

Procedure:
To correct the error, run lftran again. Use the A parameter and a valid application 
file name.

(Continued on next page)

Step Action

1 Review the invalid interchanges in the boxin.err or boxout.err file to 
determine why the segment count is invalid.

2 Use this table to determine your next action.

IF you are translating... THEN...

Outbound data Correct your data and run the 
translation again.

Inbound Notify your trading partner of the error 
and ask them to send corrected data.
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 062 '-A' option with no TP description, .app file = <file name>

Message Type: Error
Program Module: lftran

Explanation:
The file name entered after the A parameter in the lftran command selects a file 
that does not contain a field marked as the Trading Partnership Code. This file 
must contain a field marked as the Trading Partnership code. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

IF... THEN...

The application data 
contains the Trading 
Partnership Code

1. Open the map and select the Application Editor 

2. Mark the field containing the Trading Partnership 
Code as the TP Code. 

3. Save the application description

4. Save the map

5. Compile and translate the new map.

The application data 
does not contain the 
Trading Partnership 
Code

1. Separate the data. Create one file for each separate 
trading partner. 

2. Run lftran again, using the T parameter to specify 
the Trading Partnership Code.
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063 Put of environment variable <string> failed
Message Type: Error
Program Module: Iftran

Explanation:
Gentran:Server was unable to map data to this environment variable due to 
insufficient amount of available memory.

Procedure:
Use this procedure in response to this message:

 064 Doc specifier error: <string>
Message Type: Error
Program Module: Iftran

Explanation:
One of the values used to create the document specifier number is not available, 
making it incomplete. Gentran:Server creates a unique specifier number for each 
document by concatenating meaningful values. If, for example, the TP code is not 
attached to the specifier table, the specifier number is invalid.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Close other applications that may be running.

2 Run the translation again.

Step Action

1 Return to the document specifier part of Gentran:Server. 

2 Check the document specifier table for this document.

3 Set up or correct that table if necessary.

4 Reprocess the document if necessary.
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066 Unexpected record: <first 19 characters of record>, 
Record number: <record number> Set Number: <set control number
Possible segment out of order.
This record will be ignored.

Message Type: Warning
Program Module: Iftran

Explanation:
Gentran:Server has found a record that it cannot identify. The record either has a 
record ID that does not match any record in the application description or is a 
defined record but is not expected in the current sequence. This may be the result 
of incorrect or missing loop markers. Gentran:Server does not process incomplete 
records

This error does not stop the translation process.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Correct the application data and/or the application description using 
the record number, the set number information, and the first 19 
characters of the record.

2 Compile and translate the map again, if necessary.
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 067 Truncated data in record: <record name>, field: <field name>

Message Type: Warning
Program Module: Iftran

Explanation:
The source item data exceeded the maximum length of the destination item and 
was truncated to fit. This error does not stop the translation process. 

Procedure:
Use one of these responses if you receive this message

(Continued on next page)

IF... THEN...

You accept or reject the inbound data 
and send functional 
acknowledgements or 

You accept the inbound data, but do 
not send functional 
acknowledgements

Further action is not required.

Note

Although not required, you should 
contact your trading partner and ask 
them to correct the error if you reject 
the data. 

Also, you can use the mapping 
operator Place to map the most 
important part of the source item to the 
destination. 

You reject the inbound data and do 
not send functional 
acknowledgements

Notify your trading partner of the error 
and ask them to send a corrected set 
of data.

Your trading partner accepts your 
outbound data

Further action is not required.

Your trading partner rejects your 
outbound data

Chose one of the following responses:

◗ Ask your Trading Partner to 
modify their application data.

◗ Modify your application data to 
conform to the maximum length 
allowed by the standard for the 
field/element.
Maintenance and Troubleshooting Guide – August 2004



System Messages Messages in Numerical Order 2 - 27
068 Failed to allocate Translate Table memory.

Message Type: Error
Program Module: Compiler

Explanation:
The map was compiled for a different platform and Gentran:Server was unable to 
use it for translation.

Procedure

To correct the error, compile the map again for the platform on which you will be 
running the translation.

071 Translate table <table name> contains no mappings

Message Type: Error
Program Module: Compiler

Explanation:
The open map contains no mapped items. A map must have at least one mapped 
item before the compiler in Gentran:Server can run. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Run AutoMap or manually map the desired items.

2 Click Tools on the menu bar.

3 Click Compile for Windows/PC or Compile for UNIX on the 
Tools menu.
Maintenance and Troubleshooting Guide – August 2004



Messages in Numerical Order System Messages2 - 28
072 isrewrite error = <error number>

Message Type: Error
Program Module: Iftran

Explanation:
Gentran:Server found an error in the index (.idx) part of the Trading Partnership 
file while attempting to write to one of the trading partner records.

Procedure:
To correct the error, run dcheck from the command line or a batch file.

Comment
The command line program dcheck checks program or repairs DISAM indexed 
files. See the chapter Command Reference in the Gentran:Server for UNIX and 
Workstation Technical Reference Guide for information about the parameters to 
use with dcheck.

076 Conditioning data for input record: <record ID>, field: <field name>

Message Type: Error
Program Module: Iftran

Explanation:
The translator encountered an error while evaluating conditional mappings and 
cannot translate the data. This message identifies the location of the application 
error by input record ID and field name of the source item and is displayed with 
error 049, which identifies the error type, the output record ID, and field name. 

Procedure: 
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Review your input data for the record and field specified in the 
second part of this message pair.

2 Correct the data as necessary.
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080 Failed to open file: <file name>
Message Type: Error
Program Module: Iftran

Explanation:
Gentran:Server cannot find or open the specified file. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Determine the existence and current location of the file. If the file no 
longer exists, you must recreate it.

2 Determine whether the file is in the correct location.

3 Use this table to determine your next action.

IF the file... THEN...

Exists, but the correct directory 
does not

Create the directory and move 
the file.

And the directory both exist, but 
the file is not in the correct 
directory

Move the file.

Has the correct name and is in 
the correct directory

Check the access permissions for
the file and directory and change
them as needed.
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100 Removed <number> interchange envelope(s)
Sender Interchange ID:<Interchange ID>
Receiver Interchange ID:<Interchange ID>
New Filename: <file name>
Message Type: Informational
Program Module: envelope

Explanation:
Gentran:Server enveloped copies of the existing interchange envelopes into a 
single file. The program then removed the original interchange envelopes.

Procedure:
No action needed.

100 Possible header <header name> near <offset> rejected because:
<reason for rejection>
<May have been newline terminated; but stripped with -l>

Message Type: Error
Program Module: edifrmat

Explanation:
The edifrmat program could not process the header identified (<header name>) 
for the reason described (<reason for rejection>). The edifrmat program put the 
header into edifrmat.not and omitted it from the output file.

Procedure:
If this message includes the statement, “May have been newline terminated; but 
stripped with -l”, run edifrmat again without using the ‘l’ parameter. 

Note
If the standard version is EDIFACT, the message will read “Defined Terminator 
<terminator> could not be found.” This means your trading partner used an invalid 
terminator. Other possible messages include:

1. “Separator and Teminator are the same character”

2. “Separator, Sub-separator or Terminator is invalid”

Notify your trading partner and ask them to send corrected data.

(Continued on next page)
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101 Records in input file <file name> are not newline terminated

Message Type: Error
Program Module: lftran

Explanation:
Gentran:Server found a record that was not newline terminated during translation 
as required. The translation process stopped at the set containing the error. All 
data successfully translated was written to the output file. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

IF... THEN...

You are translating inbound data 1. Delete the sets that were translated 
from the input file

2. Run edifrmat on the data

3. Run the translation again.

You are translating outbound data 1. Delete the output file

2. Edit the input file (flat file or 
application description file) and put 
new line characters at the end of each 
record 

3. Run the translation again.
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102 Max Occurrence for segment <segment name> exceeded
at file line # <line number>
Set Control # <set control number>

Message Type: Warning or Error
Program Module: Iftran

Explanation:
The EDI data includes more of the identified segments (<segment name>) than 
are permitted by the standard used. The program identifies the number of the line 
in the file that contains the first occurrence of the segment that exceeds the 
maximum number of occurrences allowed.

Set up notes
If you select the Accept Sets with Errors option on either the Inbound or Outbound 
Translation Information part of the Trading Partnership Record, the translation 
continues and disregards the warning.

Also, the Accept Messages /Sets with error(s) option on the Inbound or Out-
bound EDI Information tab of the Trading Partnership Editor must be inactive 
to prevent Gentran:Server from accepting or sending sets that contain errors. 

Procedure:
Use one of these responses if you receive this message:

IF... THEN...

You accept or reject the inbound data 
and send functional 
acknowledgements 

or

You accept the inbound data, but do 
not send functional 
acknowledgements

Further action is not required.

Note
Although not required, you should 
contact your trading partner and ask 
them to correct the error if you reject 
the data.

You reject the inbound data and do 
not send functional 
acknowledgements

Notify your trading partner of the error 
and ask them to send a corrected set 
of data.

(Continued on next page)
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(Continued on next page)

Your trading partner accepts your 
outbound data

Further action is not required.

Your trading partner rejects your 
outbound data, 

Follow these steps to correct the data.

1. Modify the implementation guide to 
correct the error 

2. Correct the map and compile the 
new version

3. Translate the data using the new 
version of the map

4. Send the corrected version to your 
trading partner.

 (Contd)
IF... THEN...
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103 Segment failed conditional element compliance check:
<segment name> <segment number>
Rule: <conditional element rule>

Message Type: Warning or Error
Program Module: Iftran

Explanation:
The data contains one or more elements that violate a conditional element rule 
included in the standard used. 

Set up notes
If you select the Accept Sets with Errors option on either the Inbound or Outbound 
Translation Information part of the Trading Partnership Record, the translation 
continues and disregards the warning.

Also, the Accept Messages /Sets with error(s) option on the Inbound or 
Outbound EDI Information tab of the Trading Partnership Editor must be 
inactive to prevent Gentran:Server from accepting or sending sets that contain 
errors. 

Procedure:
Use one of these responses if you receive this message:

IF... THEN...

You accept or reject the inbound data 
and send functional 
acknowledgements or

You accept the inbound data, but do 
not send functional 
acknowledgements

Further action is not required.

Note
Although not required, you should 
contact your trading partner and ask 
them to correct the error if you reject 
the data.

You reject the inbound data and do 
not send functional 
acknowledgements

Notify your trading partner of the error 
and ask them to send corrected data.

(Continued on next page)
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107 Error: <message version> is not a valid message version for 
standard version
<standard version>
Message Type: Error
Program Module: Iftran

Explanation:
The message version for the TRADACOMS trailer documents is not valid for this 
interchange.

Procedure:
Notify your trading partner of the problem and ask them to send corrected data.

(Continued on next page)

Your trading partner accepts your 
outbound data

Further action is not required.

Your trading partner rejects your 
outbound data, 

Follow these steps to correct the data.

1. Modify the implementation guide to 
correct the error 

2. Correct the map and compile the 
new version

3. Translate the data using the new 
version of the map

4. Send the corrected version to your 
trading partner.

 (Contd)
IF... THEN...
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126 EDI data not found.
Any data found in input file is in temporary file <path>\edifrmat.not
Message Type: Error
Program Module: edifrmat

Explanation:
The edifrmat program could not find any EDI data in the input file. The edifrmat 
processes only EDI data and writes all other data into edifrmat.not. The message 
provides the location of this file <path>.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Read the edifrmat.not file to see what data the input file contains.

2 Use this table to determine your next action.

IF you specified... THEN...

An incorrect name and/or path 
for the input file

Run edifrmat again, specifying 
the correct file name and path.

The correct name of the file 
sent by your trading partner

Contact your trading partner and 
ask them to send you a file 
containing the valid EDI data.
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180 Failed to open file: <EDI file name>
Tpcode: <TP Code>   Interchange Ctl No: <control num>
Group Ctl No: <control num>   Set Ctl No: <control num>
This set will NOT be archived

Message Type: Error
Program Module: ediarc

Explanation:
Gentran:Server was unable to open the specified file <EDI file name>. This error 
prevents Gentran:Server from archiving the specified set.

Procedure:
Use one of these responses if you receive this message

(Continued on next page)

IF... THEN...

You used a batch file or script to 
translate data

Follow these steps:

a. Correct the file name and directory 
path

b. Delete the temporary Audit File

c. Run the translation and archive 
process again.

You specified an incorrect file name 
and/or directory path 

Follow these steps:

a. Verify that the file exists and is 
correctly named.

b. Verify that the file is stored in the 
directory specified. 

c. Change the name and/or location 
of the file and directory if 
necessary.

The file has the correct name and is in 
the correct directory 

Check the permissions for the file and 
directory, changing those as 
necessary.
Maintenance and Troubleshooting Guide – August 2004



Messages in Numerical Order System Messages2 - 38
 180 Failed to open file: <.cnd file name>
No conditional element compliance will be performed

Message Type: Error
Program Module: Iftran

Explanation:
Gentran:Server was unable open the specified file <.cnd file name>, containing 
the standard’s rules for conditional elements. This prevents Gentran:Server from 
checking conditional element compliance.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 View the Setup Directories dialog box to determine the name of 
the directory in which the standards files are stored. 

2 Locate the .cnd file for the standard you are using.

3 Use this table to determine your next action.

IF the .cnd file... THEN...

Exists, but is in 
the wrong 
directory

Relocate the .cnd file. 

Exists and is in 
the correct 
directory

Check the permissions for the directory and 
change them if necessary.

Note
Gentran:Server must have read permissions 
for the file.

Does not exist Copy the files for the standard into the 
directory which your standards files are 
located. 

Note
You may need to reload the required files from 
the original installation disk or tape.
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180 Failed to open file: msgrecs.vda
Message Type: Error
Program Module: edifrmat

Explanation:
Gentran:Server cannot find or open the specified file. This file is necessary for the 
VDA standard.

Procedure:
Use this procedure in response to this message:

182 Failed to write: <audit file name>
Disam error message
Tpcode: <TP Code>   Interchange Ctl No: <control num>
Group Ctl No: <control num>   Set Ctl No: <control num>

Message Type: Error
Program Module: ediarc

Explanation:
Gentran:Server was unable to write the Audit File specified. 

(Continued on next page)

Step Action

1 Determine the existence and current location of the file. If the file no 
longer exists, you must recreate it.

2 Determine whether the file is in the correct location.

3 Use this table to determine your next action.

IF the file... THEN...

Exists, but the correct directory 
does not

Create the directory and move 
the file.

And the directory both exist, but 
the file is not in the correct 
directory

Move the file.

Has the correct name and is in 
the correct directory

Check the access permissions for
the file and directory and change
them as needed.
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Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Check the Audit File to see if it contains duplicate data or a 
duplicate set control number.

2 Use this table to determine your next action.

IF this is... THEN...

Duplicate data  Determine whether you want to process 
the duplicate data. Then, continue or stop 
the process based on that determination.

A duplicate set control 
number

Ask your trading partner to resend the data 
using a unique set control number.

Not duplicate data 
and has a unique set 
control number

1. Check the available free space on the 
disk containing the directories in which you 
hold local central audit files. 

It may be necessary to delete files to make 
more disk space available.

2. Check the permissions of your audit 
directory and files. 

It may be necessary to change the existing 
permissions.
Maintenance and Troubleshooting Guide – August 2004



System Messages Messages in Numerical Order 2 - 41
190 Control Codes do not match in file: <EDI file name>
Tpcode: <TP Code>   Interchange Ctl No: <control num>
Group Ctl No: <control num>  Set Ctl No: <control num>
This set will NOT be archived
Extracted IC Control #: <control num>
Extracted Group Control #: <control num>
Extracted Set Control #: <control num>
Message Type: Error
Program Module: ediarc

Explanation:
Gentran:Server attempted to locate a specific set but found one with a different 
group of control numbers. The program could not archive the set referred to in the 
audit record and wrote a message in the xlcntl.err file.

The output file may have been overwritten with new data before it was archived or 
the archive process may have been unsuccessful. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Remove the temporary Audit files and the output file.

2 Translate the data again and archive it immediately. You should 
archive immediately after each successful translation.
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200 Missing set header: File: <file name> Offset: <number>
Tpcode: <TP Code>  Interchange Ctl No: <control num>
Group Ctl No: <control num>  Set Ctl No: <control num>
This set will NOT be archived
Message Type: Error
Program Module: ediarc

Explanation:
Gentran:Server found a set in the data that does not have a set header. This EDI 
data is invalid.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Locate the set with the missing header using the Trading 
Partnership Code and control numbers provided.

2 Use this table to determine your next action.

IF you are 
archiving... THEN...

Outbound data 1. Check to see if the set header is 
mapped and the mapping instructions are 
correct

2. Translate the new data.

Inbound data Ask your trading partner for corrected 
data, then translate the new data.
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 200 Error occurred reading Interchange Org record for <TP Code>
disam error message
Control number not updated at this level
Message Type: Error
Program Module: envelope

Explanation:
Gentran:Server was unable to read the Interchange Organization record for this 
Trading Partnership Code and did not update the interchange control number. 
This error can occur for several reasons:

◗ The Organization file does not include an Organization record for the Trading 
Partnership Code identified in the message.

◗ The Organization file does not exist. 
◗ The Organization file is empty.
◗ The Organization file is in use by another user.
◗ The Organization file is not located in the correct directory.
◗ Gentran:Server does note have read permissions for the directory and file.

Procedure
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Determine the reason for the error.

2 Correct, translate, and send the data again.
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200 Error occurred rewriting Interchange Organization record
disam error message
Control number not updated at this level
Message Type: Error
Program Module: envelope

Explanation:
Gentran:Server was unable to rewrite the Interchange Organization record for this 
Trading Partnership Code and did not update the interchange control number. 
This error can occur for several reasons:

◗ The Organization file is in use by another user.
◗ The Organization file is not located in the correct directory.
◗ Gentran:Server does not have read permissions for the directory and file?

Procedure:
Use one of these responses if you receive this message.

(Continued on next page)

IF you are in a... THEN...

UNIX multi-user environment Wait, then run the process again.

Single-user environment or 
are sure that the file is 
unlocked

1. Check the amount of disk space available 
on the disk holding Trading Partnership files.

2. Check the permissions of the Organization 
File and the directory holding Trading 
Partnership files. 
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200 Error updating interchange control number In trading partner record for: 
<TP Code>
disam error message
Message Type: Error
Program Module: envelope

Explanation:
Gentran:Server was unable to update the interchange control number in a record 
for this Trading Partnership code. This error can occur for several reasons:

◗ The Organization file is in use by another user.
◗ The Organization file is not located in the correct directory.
◗ Gentran:Server does not have read permissions for the directory and file.

Procedure:
Use one of these responses if you receive this message

200 File containing data is already an enveloped file <file name>
This data will not be processed
Message Type: Warning
Program Module: envelope

Explanation:
Gentran:Server will not process previously enveloped data.

Procedure:
No action necessary.

(Continued on next page)

IF you are in a... THEN...

UNIX multi-user environment Wait, then run the process again.

Single-user environment or 
are sure that the file is 
unlocked

1. Check the amount of disk space left on the 
disk holding Trading Partnership files. 

2. Check the permissions of the Organization 
File and the directory holding Trading 
Partnership files. 
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200 Encountered segment too long to process near offset <offset number>.
Possibly segment terminator different than interchange header
Data written to edifrmat.not
Output file may contain incomplete interchange
Message Type: Error
Program Module: edifrmat

Explanation:
The segment is more than 1024 characters in length. Gentran:Server wrote the 
partial interchange to edifrmat.not and omitted the partial interchange from the 
output file.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Check the edifrmat.not file to see if an interchange trailer is missing 
or if a segment terminator differs from the previous terminator.

2 Use this table to determine your next action.

IF...
THEN ask you trading partner 
to...

An interchange trailer is missing Resend the data, including the 
missing interchange trailer. 

Different segment terminators 
were used in a single 
interchange

Use the same delimiter for all 
segment terminators within an 
interchange.
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 243 Audit record not found.
I_Send: <number> I_Recv: <number>
G_Send: <number> G_Recv: <number>
Interchange Ctl No: <control num>  Group Ctl No: <control num>
Set Ctl No: <control num>  Setid: <Set ID>
FA status not updated
Message Type: Warning
Program Module: ediarc

Explanation:
Gentran:Server was unable to find the Audit record identified by the message. 
Gentran:Server was unable to reconcile this acknowledgment to the original 
document because the original document was not archived or the archive file was 
purged. 

Procedure:
Use one of these responses if you receive this message

◗ Translate both the original document and the functional acknowledgment 
again. You must archive the original document and reconcile the functional 
acknowledgment before you purge the archive file.

◗ Enter Verbal OK for it in the FA Reconciliation dialog box to manually 
reconcile the functional acknowledgment. 

(Continued on next page)
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247 Audit record update failed for trading partner: <TP Code>
<DISAM error message>
Group Ctl No: <control num>  Setid: <Set ID>   Set Ctl No: <control num>
Message Type: Error
Program Module: ediarc

Explanation:
Gentran:Server was unable to update the Audit record for the Trading Partnership 
and set identified in the message. The DISAM error message included in this 
message indicates the nature of the error.

Procedure:
Use one of these responses if you receive this message.

(Continued on next page)

IF... THEN...

You are in a UNIX multi-user 
environment

Wait, then run the process again.

You are in a single-user environment 
or know that no other user has the file 
open for reading or writing

Check the amount of disk space left on 
the disk holding Trading Partnership 
files. 

There is sufficient disk space Check the permissions for the file and 
directory. 

There is missing data in the set and 
group level control numbers

Correct the data and run the 
translation again, then update the 
audit record.
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285 Unexpected end of file: <segment>
<file name>

Message Type: Error
Program Module: ediarc

Explanation:
Gentran:Server found that the file ended immediately after or in the middle of the 
segment identified in the message. The EDI data lacks set, group, and 
interchange trailers and is invalid.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 View the file using a text editor and determine whether the segment 
identified had a segment terminator. 

2 Use the Trading Partnership Code to identify the trading partner 
with whom you are exchanging this data.

3 Use this table to determine your next action.

IF you are translating... THEN...

Outbound data Correct the problem and translate the 
data again.

Inbound data Ask your trading partner to check the 
EDI file and, if complete, send it again. 
Your trading partner may need to 
retranslate the data first.
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 300 Could not find set in indicated file
Failed to seek to position <file offset> in file <input file name>
The indicated file offset was invalid

Message Type: Warning
Program Module: envelope

Explanation:
Gentran:Server was unable find the set at the offset indicated because the file is 
too small. This error can occur if the file was moved or overwritten after 
translation.

Procedure:
No action possible. You must envelope your sets immediately after translation to 
avoid this error.

300 Error <error number> reading edistat.o during update process
Archived set will not reflect new envelope
Message Type: Warning
Program Module: envelope

Explanation:
Gentran:Server is unable read the edistat.o file or update the original file. The 
records in the edistat.o file still point to the original file, preventing Gentran:Server 
from placing the new envelope into the archive.

Procedure:
To find the meaning of the error number referenced in this message, see the 
Command Reference chapter in the Gentran:Server for UNIX and Workstation 
Technical Reference Guide.

300 Error <error number> returned from encreate.
Unable to create files env.dat, env.idx
Message Type: Error
Program Module: envelope

Explanation:
Gentran:Server is unable to create the envelope files (env.dat and env.idx).

Procedure:
To find the meaning of the error number referenced in this message, see the 
Command Reference chapter in the Gentran:Server for UNIX and Workstation 
Technical Reference Guide.

(Continued on next page)
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300 Error <error number> writing edistat.o during update process
Archived set will not reflect new envelope
Message Type: Warning
Program Module: envelope

Explanation:
Gentran:Server is unable read the edistat.o file or update the original file. The 
records in the edistat.o file still point to the original file, preventing Gentran:Server 
from placing the new envelope into the archive.

Procedure:
Find the meaning of the error number referenced in this message in the 
Command Reference chapter in the Gentran:Server for UNIX and Workstation 
Technical Reference Guide.

300 Error occurred rewriting envelope record
disam error message
Tpid = <TP Code>,   Fname = <file name>
Offset in edistat.o will be incorrect
Message Type: Error
Program Module: envelope

Explanation:
Gentran:Server is unable rewrite the envelope record. The set offset in edistat.o is 
now incorrect and, possibly, the set was not properly archived.

Procedure:
Use one of these responses if you receive this message.

(Continued on next page)

IF you are in a... THEN...

UNIX multi-user environment Wait, then run the process again.

Single-user environment or 
are sure that no other user 
has the file locked

1. Check the amount of available disk space.

2. Check the permissions of the edistat.o file 
and directory. 
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300 Error writing data to env.dat
disam error message
Message Type: Error
Program Module: envelope

Explanation:
Gentran:Server cannot write the env.dat file. 

Procedure:
Use one of these responses if you receive this message

(Continued on next page)

IF you are in a... THEN...

UNIX multi-user environment Wait, then run the process again.

Single-user environment or are sure 
that no other user has the file locked

1. Check the amount of disk space left 
on the disk containing the output file. 

2. Check the permissions of the output 
file and the directory holding it. 
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300 No data in / or unable to read edistat.o
errno = <error number>

Message Type: Warning
Program Module: envelope

Explanation:
Gentran:Server is unable to read any data from the edistat.o file. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Find the meaning of the error number referenced in this message in 
the Command Reference chapter in the Gentran:Server for UNIX 
and Workstation Technical Reference Guide.

2 Use this table to determine your next step.

IF... THEN...

There is no data to be 
enveloped or the file is empty

No further action is possible.

Gentran:Server is unable to 
open the file

Verify that the file exists and is in 
the correct directory.

Gentran:Server cannot read or 
write to the file

Check the permissions on the 
file and the directory containing 
it. 
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343 Audit record not found. Edistat.o not created for resend data.
Audit record for original data was not found.
Message Type: Warning
Program Module: edirsnd

Explanation:
Gentran:Server was unable to find the original Archive record and did not archive 
the resend data as a result. The original record may have been deleted, moved, or 
purged before archiving. Alternatively, the file may not exist in the specified 
directory or Gentran:Server may not have the correct permissions for the file or 
the directory.

Procedure:
Use one of these responses if you receive this message

◗ Translate both the original document and the functional acknowledgment 
again. You must archive the original document and reconcile the functional 
acknowledgment before you purge the archive file.

◗ Enter Verbal OK for it in the FA Reconciliation dialog box to manually 
reconcile the functional acknowledgment. 

(Continued on next page)
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346 Trading partner record not found. <TP Code>
Unable to update control number <control num>
Message Type: Warning
Program Module: envelope

Explanation:
Gentran:Server was unable to locate the Trading Partnership record identified in 
the message and did not update the control number. Either the record does not 
exist or it is not in the correct directory.

Procedure:
Use this procedure in response to this message:

361 Invalid set count: Data = <number of sets counted>
Actual = <number of sets present>
Invalid set's control number: <control number>
Message Type: Error
Program Module: edifrmat

Explanation:
This interchange contains a number of sets unequal to the set count segment. 
You used the edifrmat program with the ‘v’ parameter, causing the program to 
write an error message to xlcntl.err, write the erroneous group to edifrmat.not, and 
omit the erroneous group from the output file.

Procedure:
Use one of these responses if you receive this message

◗ Ask your trading partner to correct the data and resend it.
◗ Manually correct the data yourself.

(Continued on next page)

Step Action

1 Use the File Manager to see if the record exists and whether or not 
it is in the directory you specified for trading partner files.

2 Use this table to determine your next action.

IF the file... THEN...

Is in the wrong 
directory

1. Move it to the correct directory.

2. Manually update the interchange control 
number in the Trading Partnership Maintenance 
and/or Organization File(s).

Does not exist Recreate the record.
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362 Invalid group count: Data = <number of groups counted>
Actual = <number of groups present>
Invalid group's control number: <control number>
Message Type: Error
Program Module: edifrmat

Explanation:
This interchange contains a number of groups unequal to the number specified by 
the interchange trailer. Using the edifrmat program with the ‘v’ parameter, caused 
the program to write an error message to xlcntl.err, write the erroneous inter-
change to edifrmat.not, and omit the erroneous interchange from the output file.

Procedure:
Use one of these responses if you receive this message

(Continued on next page)

IF translation is... THEN...

Outbound Correct the application data and retranslate

Inbound Ask your trading partner to correct the application 
data, translate the new data, and send the new 
data to you.
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364 Interchange Organization record not found.
Your Interchange ID: <your Interchange ID>
Partner's Interchange ID: <partner's Interchange ID>

Message Type: Error
Program Module: edirsnd

Explanation:
Gentran:Server found a mismatch between the Interchange IDs in the 
Interchange Organization record and the Interchange IDs used in the resend. 
Gentran:Server is unable to resend the corrected data.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Check the Interchange Organization record. 

2 Send the data again, using the Interchange IDs found in the 
Interchange Organization record.
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365 Group Organization Record not found.
Your Interchange ID: <your Interchange ID>
Partner's Interchange ID: <partner's Interchange ID>
Your Application ID: <your Group ID>
Partner's Application ID: <partner's Group ID>

Message Type: Error
Program Module: edirsnd

Explanation:
Gentran:Server found a mismatch between the Group IDs in the Group 
Organization record and the Group IDs used in the resend. Gentran:Server is 
unable to resend the corrected data.

Procedure:
Use this procedure in response to this message:

370 Organization record locked:
<Organization record data>

Message Type: Error
Program Module: Iftran

Explanation:
One or more of the documents in the input file references an organization record 
that is locked. The message identifies the locked record by displaying your 
Interchange ID, your partner's Interchange ID, your application ID, and your 
partner's application ID in place of the variable <Organization record data>.

Procedure:
To correct this error, wait until the record is unlocked and run the translation again. 

Note
Gentran:Server writes inbound data requiring the locked record to boxin.lok and 
the outbound data to boxout.lok.

(Continued on next page)

Step Action

1 Check the Group Organization record.

2 Resend the data, using the Group IDs found in the Group Organiza-
tion record.
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 370 Trading Partnership locked: 
<Trading Partnership data>

Message Type: Error
Program Module: Iftran

Explanation:
One or more of the documents in the input file references a Trading Partnership 
record that is locked. 

Note
Gentran:Server uses your Interchange ID, your partner's Interchange ID, your 
Group ID, your partner's Group ID, the standard version and release, and the 
Message ID to identify a Trading Partnership record in inbound data.

Gentran:Server uses the Trading Partnership Code to identify the Trading 
Partnership record in outbound data.

Procedure:
To correct this error, wait until the record is unlocked and run the translation again. 

Note
Gentran:Server writes inbound data requiring the locked record to boxin.lok and 
the outbound data to boxout.lok.

(Continued on next page)
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370 Trading partnership not defined for:
 <Trading Partnership data>

Message Type: Error
Program Module: Iftran

Explanation:
One or more of the documents in the input file does not reference a Trading 
Partnership record. Gentran:Server is unable to continue the translation.

Note
Gentran:Server uses key fields (your Interchange ID, your partner's Interchange 
ID, your Group ID, your partner's Group ID, the standard version and release, and 
the Message ID) to identify a Trading Partnership record in inbound data.

Gentran:Server uses the Trading Partnership Code to identify the Trading 
Partnership record in outbound data.

Procedure:
Use one of these responses if you receive this message.

(Continued on next page)

IF translation is... THEN...

Inbound Verify that the Trading Partnership Record you have 
set up contains the same six key fields as specified in 
the error message. 

If not, change the data in the six key fields of the 
Trading Partnership record or ask your trading partner 
to correct and resend data. 

Outbound Revise the application data and/or the map so that the 
correct Trading Partnership Code appears in the first 
record of the file. Translate and send the data again. 
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377 Interchange contains count errors
Interchange written to edifrmat.not

Message Type: Error
Program Module: edifrmat

Explanation:
The input file contains a number of sets unequal to the set count segment, or it 
contains a number of groups unequal to the number specified by the interchange 
trailer. See error message 361 or error message 362 for more information.

Procedure:
Use this procedure in response to this message:

377 Interchange contains segment with id too long
Segment Number: <segment number>
Interchange written to edifrmat.not

Message Type: Error
Program Module: edifrmat

Explanation:
The input file includes a segment ID that is greater than three characters in length. 
The edifrmat program expects all segment IDs to be either two or three 
characters long.

Procedure:
Use this procedure in response to this message:

Step Action

1 Check the input file for erroneous group or set counts.

2 Ask your trading partner to correct the data and resend it.

3 Run edifrmat again when you receive the corrected data.

Step Action

1 Check the input file for a segment ID that is not within the allowed 
character length. 
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2 Ask your trading partner to correct the length of all segment IDs 
that are less than two or greater than three characters in length and 
resend the data. 

3 Run edifrmat again when you receive the corrected data.

 (Contd)
Step Action
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378 Interchange contains invalid characters
Interchange written to edifrmat.not

Message Type: Error
Program Module: edifrmat

Explanation:
The input file contains characters that are not valid for the standard being used.

Procedure:
Use this procedure in response to this message:

379 Interchange has no trailer!!!
Interchange written to edifrmat.not

Message Type: Error
Program Module: edifrmat

Explanation:
The interchange trailer is missing. The edifrmat program was unable to process 
the interchange. The program wrote the partial interchange to edifrmat.not and 
omitted the partial interchange from the output file.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Check the input file for invalid characters for the standard.

2 Contact your trading partner and ask them to correct the data and 
resend it.

3 Run edifrmat again when you receive the corrected data.

Step Action

1 Check the edifrmat.not file to determine how much data is missing.

2 Contact your trading partner and ask them to send the corrected 
data.
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380 Failed to open file: <file name>

Message Type: Warning
Program Module: ediarc

Explanation:
Gentran:Server cannot open the identified file (<file name>). The file may be 
locked by another user; Gentran:Server may not have write permissions for the 
file and/or directory; or the disk containing the directory may be full.

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF you are in a... THEN...

UNIX multi-user environment Wait, then run the process again.

Single-user environment or are sure 
that no other user has the file locked

1. Open your Setup Directories 
dialog box and identify the directories 
that hold the local and central audit 
files. 

2. Check those directories to see if the 
identified file exists. 

◗ If the file exists, check the read 
permissions on the file and 
directory

◗ If the file does not exist, translate 
your data again.
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380 Failed to open file: <file name>

Message Type: Error
Program Module: edifrmat

Explanation:
The edifrmat program was unable to open the file. The file may be locked by 
another user; Gentran:Server may not have write permissions for the file and/or 
directory; or the disk containing the directory may be full.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Check the directory path and name of the file you specified. 

2 Use this table to determine your next action.

IF... THEN...

You specified the correct file 
name and directory path

1. Use File Manager to 
determine whether the file exists 
and is in the specified directory. 

2. Rename or move the file as 
needed.

The file has the correct name 
and is in the correct directory

Check the permissions and 
change them if necessary.
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380 Failed to open translate table file: <file name>
TP Code: <TP Code>

Message Type: Error
Program Module: Iftran

Explanation:
Gentran:Server was unable to open the map table for a map referenced by one or 
more of the sets in the input file.The file may be locked by another user; 
Gentran:Server may not have write permissions for the file and/or directory; or the 
disk containing the directory may be full.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Identify the name of the directory in which you store your Map files 
using the Setup Directories dialog box found under Settings on 
the Gentran:Server window.

2 Use File Manager to determine whether the directory exists and 
whether the file (<mapname>.TPL/TBL) is in the correct directory.

3 Use this table to determine your next step.

IF the... THEN...

Map directory does not exist Create the map directory and 
move the file into it. 

Table file does not exist Compile the Map file (.map) again 
to create a new Map table (.TPL/
.tbl).

File exists and is in the correct 
directory

Check the read permissions on 
the file and directory. Change 
them as necessary.
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380 Unable to open TP File

Message Type: Error
Program Module: lftran

Explanation:
Gentran:Server was unable to open the Trading Partnership File. This may be 
because there is no Trading Partnership File at all, because the Trading 
Partnership File is not in the directory specified for Trading Partnership files, or 
because Gentran:Server does not have the correct permissions for the file or the 
directory.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Identify the name of the directory in which you store your Map files 
using the Setup Directories dialog box found under Settings on 
the Gentran:Server window.

2 Use this table to determine your next action.

IF the... THEN...

Directory is correct Use File Manager to check the directory 
for the Trading Partnership file (tp.dat/
tp.idx).

File exists 1. Check the permissions of both the file 
and the directory. 

2. Change the permissions, if necessary.
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 382 Failed to write: <archive file name>
Message Type: Warning
Program Module: ediarc

Explanation:
Gentran:Server did not write the Archive file. The file may be locked by another 
user; Gentran:Server may not have write permissions for the file and/or directory; 
or the disk containing the directory may be full.

Procedure:
Use one of these responses if you receive this message

382 Failed to write: <file name>
Message Type: Warning
Program Module: edifrmat

Explanation:
Gentran:Server did not write the specified file. The file may be locked by another 
user; Gentran:Server may not have write permissions for the file and/or directory; 
or the disk containing the directory may be full.

Procedure:
Use one of these responses if you receive this message

IF you are in a... THEN...

UNIX multi-user environment Wait, then run the process again.

Single-user environment or are sure 
that no other user has the file locked

Check the amount of available disk 
space on the disk holding temporary 
files. Free more as needed

You are sure the file is not locked and 
there is sufficient disk space

Check the permissions of the Archive 
file and the directory holding 
temporary files. Change permissions 
as needed. 

IF you are in a... THEN...

UNIX multi-user environment Wait, then run the process again.
(Continued on next page)
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(Continued on next page)

Single-user environment or are sure 
that no other user has the file locked

Check the amount of available disk 
space on the disk holding temporary 
files. Free more as needed

You are sure the file is not locked and 
there is sufficient disk space

Check the permissions of the Archive 
file and the directory holding 
temporary files. Change permissions 
as needed. 

 (Contd)
IF you are in a... THEN...
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387 Invalid segment id encountered: <segment ID>
Segment Number: <segment number>
Interchange written to edifrmat.not

Message Type: Error
Program Module: edifrmat

Explanation:
The input file includes a segment ID that is less than two or greater than three 
characters in length. The edifrmat program expects all segment IDs to be either 
two or three characters long.

Procedure:
Use this procedure in response to this message:

387 Error <operating system error number> updating Interchange Organization 
record
DISAM error number: <DISAM error number>

Message Type: Error
Program Module: Iftran

Explanation
One or more of the documents in the file references a Trading Partnership record 
associated with a locked Interchange Organization record. Control Numbers 
Globally Maintained is selected.

Procedure:
To correct this error, wait until the record is unlocked and run the translation again. 

Note
Gentran:Server writes inbound data requiring the locked record to boxin.lok and 
the outbound data to boxout.lok.

(Continued on next page)

Step Action

1 Check the input file for a segment ID that is not within the allowed 
character length. 

2 Ask your trading partner to correct the length of all segment IDs 
that are less than two or greater than three characters in length and 
resend the data. 

3 Run edifrmat again when you receive the corrected data.
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388 Error <operating system error number> updating Group Organization record 
DISAM error number: <DISAM error number>

Message Type: Error
Program Module: Iftran

Explanation:
One or more of the documents in the file references a Trading Partnership record 
associated with a locked Group Organization record. Control Numbers Globally 
Maintained is selected.

Procedure:
To correct this error, wait until the record is unlocked and run the translation again. 

Note
Gentran:Server writes inbound data requiring the locked record to boxin.lok and 
the outbound data to boxout.lok.

500 Unexpected version of audit file, running wrong lftran. Exiting without ar-
chiving.

Message Type: Error
Program Module: ediarc

Explanation:
The version 5.4 ediarc command is unable to archive an audit file created by a 
prior version of Gentran:Server or Gentran:Mentor. ediarc exits without affecting 
the audit files.

Procedure:
Run the translator again using version 5.4 of Gentran:Server.
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Messages in Alphabetical Order (Starting with 
Variables)

Overview This section lists messages that begin with variables. The messages are listed in 
alphabetical order by variable description. Descriptions of variables are 
surrounded by < >. 

References
◗ To find a message that begins with a number, see the topic Messages in 

Numerical Order in this chapter.
◗ If you want to find a message that begins with an alphabetic character (neither 

a number, nor a variable), see the topic Messages in Alphabetical Order (Not 
Starting with Variables) in this chapter.

<application file
name>

<application file name> has changed. Save before <opening/creating> new ap-
plication?

Message Type: Warning
Program Module: Application Editor

Explanation:
You have not saved recent changes to the open application file. This prompt 
affords you the opportunity to save those changes before opening another 
application file. If you choose not to save these changes, you will lose them as 
when the program opens the new application. If the open application file is new, 
the message displays the word “Application” in place of the variable (<application 
file name>).

Procedure:
Use this procedure in response to this message:

(Continued on next page)

IF you want to... THEN Select...

Save the changes to this file Yes. 

Lose the changes made since you last saved No.
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<argument> <argument> is not a valid argument for the operation <operation>.

Message Type: Error
Program Module: Compiler

Explanation:
The compiler is unable to accept the argument entered for this operation.

Procedure:
Change the mapping instruction so that it contains a valid arguments. 

Reference
See the Gentran:Server for UNIX and Workstation Mapping and Translation 
Guide for information about appropriate arguments for the identified operation 
(<operation>).

<expression> <expression> is not a valid GROUP ID

Message Type: Error
Program Module: Visual Mapper

Explanation:
The selected text that is not the name of any GROUP. You must specify a 
mapping GROUP ID to complete the action you are performing.

Procedure:
Select the name of the desired mapping GROUP and then click OK

<expression> <expression> is not a valid operator. Compiler will ignore it.

Message Type: Warning
Program Module: Compiler

Explanation:
This mapping instruction contains an invalid expression. The compiler excludes 
this expression from the compiled version of the map. This may cause 
unexpected results.

Procedure:
Rewrite the mapping instruction so that it contains all required arguments and 
data items. 

Reference
See the chapter Mapping in the Mapping and Translation Guide for information 
about the arguments and data items that are required for this operation.

(Continued on next page)
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<expression> <expression> is not a valid symbol in a <condition/mapping/macro> part of a 
mapping instruction.

Message Type: Error
Program Module: Compiler

Explanation:
The mapping instruction contains an invalid symbol (<expression>).

Procedure:
Rewrite the mapping instruction using only valid symbols/characters/numbers. 

Reference
See Mapping Rules in the online help or see the chapter Mapping in the 
Gentran:Server for UNIX and Workstation Mapping and Translation Guide for 
information about the symbols for mapping instructions.

<expression> <expression> is not a valid symbol in this context.

Message Type: Error
Program Module: Compiler

Explanation:
The mapping instruction contains an invalid symbol (<expression>).

Procedure:
Rewrite the mapping instruction using only valid symbols/characters/numbers. 

Reference
See Mapping Rules in the on-line help or see the chapter Mapping in the 
Gentran:Server for UNIX and Workstation Mapping and Translation Guide for 
information about the symbols that are invalid for mapping instructions.

(Continued on next page)
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<expression> <expression> is not recognized as a valid source or destination element.

Message Type: Warning
Program Module: Compiler

Explanation:
A specified source or destination item is not part of this mapping GROUP. 

Procedure:
Use this procedure in response to this message:

 <file name>  <file name> is corrupted

Message Type: Error
Program Module: Main Window (Settings)

Explanation:
The file containing your default data type preferences is corrupt. This error can 
occur when there is a hardware or software failure while the file is open. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Change this mapping instruction so that it uses as a source only 
items in the Source box at the top of this window and uses as a 
destination only items in the Destination box.

2 Enter the labels, not the names, of the items.

3 Close the Mapping Instructions window and add the item to this 
GROUP.

Step Action

1 Click User Setup from the Settings menu of the Gentran:Server 
window.

2 Set preferences to the default data type values and click OK.
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 <file name> <file name> is locked and cannot be updated; file saved as <file name>

Message Type: Error
Program Module: Installation (Windows only)

Explanation:
The identified DLL file is locked by another process.

Procedure:
Close all other programs to ensure that the DLL file is unlocked. 

<file name> <file name> is read only and cannot be overwritten

Message Type: Error
Program Module: Installation

Explanation:
The file protection on the identified file is set to read-only.

Procedure:
Use the attrib command to remove read-only file protection for this file. 

Example
attrib -r <file name> 

(Continued on next page)
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<implementation
guide name>

<implementation guide name> has changed. Save before <creating/opening> 
new standard IG?

Message Type: Warning
Program Module: Standard/IG Editor
Explanation:
You have not saved recent changes to the open implementation guide. This 
prompt affords you the opportunity to save those changes before opening another 
implementation guide. If you choose not to save these changes, you will lose 
them as when the program opens the new implementation guide. If the open 
implementation guide is new, the message displays the words “implementation 
guide” in place of the variable (<implementation guide name>).

Procedure:
Use one of these responses if you receive this message

<label> <label> is not a valid LABEL

Message Type: Error
Program Module: Visual Mapper
Explanation:
The label entered does not exist in this map.

Procedure:
Type the label of an existing item in the Add Item to GROUP dialog box. 

<source item> <source item> is not a valid destination for this group.

Message Type: Error
Program Module: Compiler
Explanation:
The mapping instruction contains a string that is not a label of any of the 
destination items in this GROUP. 

Procedure:
Enter the label of one of the destination items after the ‘TO’ in this mapping 
expression. 

(Continued on next page)

IF you want to... THEN Select...

Save the changes to this file Yes.

Lose the changes made since you last saved No.
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<string> <string> is not a valid document in the current set

Message Type: Error
Program Module: Standard/IG Editor and Visual Mapper

Explanation:
The specified standard does not contain the document named in the Document 
Display/Text text box.

Procedure:
Enter the name of a document that the specified standard contains.

<string> <string> is not a valid GROUP item

Message Type: Error
Program Module: Visual Mapper

Explanation:
The selected text string is not a GROUP item and cannot be deleted.

Procedure:
Use this procedure in response to this message:

Step Action

1 In the Mapping Mini-report, highlight the field/element you want to 
delete from the GROUP

Note
If the item is in two or more GROUPs, make sure the item name is 
under the desired GROUP name. Fields are identified by their 
LABEL and field name. Elements are identified by their LABEL and 
element ID. 

2 Select Delete Item from GROUP from the Map Items menu.
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Messages in Alphabetical Order (Not Starting with 
Variables)

Overview This section lists messages in alphabetical order.

References
◗ If you want to find a message that begins with a number, see the topic 

Messages in Numerical Order in this chapter.
◗ If you want to find a message that begins with a variable (the first word is 

surrounded by < >), see the topic Messages in Alphabetical Order (Starting 
with Variables) in this chapter.

0-to-1 0-to-1 GROUP must contain one and only one destination item

Message Type: Error
Program Module: Visual Mapper

Explanation:
There are more than one destination items selected. To create a 0-1 GROUP, 
select one and only one destination field, element, or sub-element.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Click once on the destination side to make it active.

2 Click Clear All Marks on the Mark menu.

3 Mark the destination field, element, or subelement you want to 
make a 0-to-1 GROUP. 

4 Click Create 0-to-1 Single GROUP on the Map Items menu.
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A A block of data that begins with a field must end with a field from the same 
record.
Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
Fields/elements from two or more records are marked, but this edit operation 
works only on a block of data from a single record/segment, composite element, 
field/element, or string of contiguous fields/elements.

Procedure:
Use this procedure in response to this message:

 A A field cannot start a loop. Only records can start a loop
Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
A loop can start only with an entire record or segment. Currently, you have only a 
field/element marked – not the entire record/segment. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Select Clear All Marks from the Mark menu to unmark all items.

2 Mark one block of data.

3 Select the desired edit operation.

Step Action

1 Click Clear All Marks on the Mark menu to unmark all items. 

2 Click Collapse All on the View menu to view only the records/
segments. Move the focus to the first item you want to mark and 
press F5. Repeat this for each item you wan to include in the loop. 

3 Click Make Loop on the Edit menu (CTRL+L).
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A These three messages are similar in content, explanation, and procedure.

A valid destination must be selected
A valid source and destination must be selected
A valid source must be selected
Message Type: Error
Program Module: Visual Mapper

Explanation:
This map does not a valid source and/or destination. Every map must have a valid 
source and a valid destination.

Procedure:
Select a source and/or destination type and file for this map.

All All items discarded nothing to view.
or

All items have been discarded, switching to view all mode.
Message Type: Warning
Program Module: Standard/IG Editor

Explanation:
All used items were discarded from this implementation guide, leaving nothing for 
the Standard/IG Editor to display.

If all used items were discarded while in View Only Used mode, the editor 
automatically reverts to View All Items mode

Procedure:
Mark one or more of the items in the implementation guide as used before 
attempting to view them.

 An An operator was expected, instead a data item <expression> was found.
Message Type: Error
Program Module: Compiler

Explanation:
The mapping instruction contains the specific data item instead of the required 
operator. This error stops the compiler.

Procedure:
Correct the mapping instruction by replacing the identified data item with a valid 
operator or by adding the omitted operator. Then, run the compiler again.

(Continued on next page)
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An An unimplemented error occurred in <error location>. Please report this to 
product support.

Message Type: Error
Program Module: Compiler

Explanation:
The compiler encountered an unidentified error and is unable to compile this map.

Procedure:
Call Gentran:Server Customer Support and give them the exact wording of the 
message and the version of Gentran:Server you are using.

Are There are two deletion prompts to which you must respond.

Explanation:
These messages prompt you to confirm a deletion request to avoid unintended 
actions.

Procedure:
Use this procedure to respond to these prompts.

(Continued on next page)

Module Message

Compiler Are you sure you want to delete the selected 
list(s).

Step Action

1 Look carefully at the names of the list(s) selected.

2 Use this table to determine your next action.

IF you... THEN Select...

Want to delete the selected item Yes.

Do not want to delete the selected item No.
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Attempt Attempt to paste a composite element into another composite element not al-
lowed.
Message Type: Error
Program Module: Standard/IG Editor
Explanation:
You cannot paste a composite element from the Clipboard into a subelement 
(component) of another composite element. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Use the table below to determine your first action

IF you want to paste the 
Clipboard item... THEN...

Above the composite element 
containing the selected 
component

Select the next element upward 
that is not a component of a 
composite element.

Below the composite element 
containing the selected 
component 

Select the next element 
downward that is not a 
component of a composite 
element.

2 Select Paste from the Edit menu (SHIFT+INSERT).
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Batch Batch filenames are missing for <number> task(s). Server's timer will skip 
over such tasks! Do you wish to commit the schedule?

Message Type: Warning
Program Module: Main Window (Tools)

Explanation:
Gentran:Server found a number of tasks without batch files specified. You must 
specify a batch file and directory path for each task in the Task Scheduler. There is 
a separate line for each task. 

Procedure:
Use one of these responses if you receive this message.

(Continued on next page)

IF you want to perform... THEN...

Only those tasks for which you have 
specified batch files

Click Yes.

All tasks in the schedule 1. Click No

2. Correct the schedule using the 
steps    
    below.

a. Click Tools on the Main menu.

b. Click Task Scheduler from the 
Tools menu.

c. Enter batch file names and directory 
paths for every task in the Task 
Scheduler dialog box.
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Cannot Cannot open file <file name> for <file operation>. <additional information>

Message Type: Error
Program Module: Visual Mapper (AutoMapper)

Explanation:
The Visual Mapper is unable open the specified file (<file name>) or perform the 
requested operation. The message may include additional information explaining 
the error. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Use the File Manager to locate the file and verify its existence.

2 Determine the directory in which the file should reside. Then, 
choose one of the responses below.

◗ If the file exists but is located in a different directory, move it to 
the appropriate directory. 

◗ If the file exists and is in the correct directory, check the 
permissions for the file and directory and make the necessary 
changes. 
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Cannot Cannot open file; name not specified

Message Type: Error
Program Module: Synonym and Thesaurus Editors

Explanation:
The editor cannot open the related ISAM file (.idx or .dat). No file with the 
appropriate name is available.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 View the Setup Directories dialog box to determine the directory 
that should contain maps and related files.

2 Use this table to determine your next action.

3 IF... THEN...

You are in the Thesaurus Editor The file name must be 
thesaur.idx or thesaur.dat. 

You are in the generic Synonym 
Editor

The file name must be 
generic.idx or generic.dat.

You are in the specific Synonym 
Editor

The file name must be 
<map_name>.idx or 
<map_name>.dat.

The file exists, but is in the 
wrong directory

You must move it to the correct 
directory.

The file exists and is in the 
correct directory

Check the permissions for the 
directory and change them if 
necessary.
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Cannot Cannot quit application during Auto Mapping. Use the cancel button on the 
percent bar to cancel Auto Mapping.

Message Type: Error
Program Module: Visual Mapper (AutoMapper)

Explanation:
You are unable to close the Visual Mapper while AutoMapping is in progress. You 
must first stop the AutoMapper and then close the Visual Mapper. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Click on Cancel below the percent bar in the AutoMapping Status 
window.

2 Close the Visual Mapper.
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Can't There are two messages related to saving items or files.

Can't open file <file name> to retrieve mapping instructions.
or

Can't open file <file name> to save mapping instructions.

Message Type: Error
Program Module: Compiler

Explanation:
Gentran:Server is unable to open the identified file and retrieve or save mapping 
instructions.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Use the File Manager to locate the file and verify its existence. 

2 Determine the directory in which you should store the file.

3 Use this table to determine your next action.

IF the file... THEN...

Exists, but the correct directory 
does not

Create the directory and move 
the file into that directory.

And the directory both exist, but 
the file is not in the correct 
directory

Move the file.

Has the correct name and is in 
the correct directory 

Check the permissions and 
change them, if necessary.
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Character There are two character string errors you may encounter while compiling.

Message Type: Error
Program Module: Compiler

Procedure:
To correct these errors, change the mapping instruction to use only appropriate 
characters or data.

Reference
See the Mapping chapter in the Gentran:Server for UNIX and Workstation 
Mapping and Translation Guide for more information about mapping instructions.

Compilation ***  COMPILATION COMPLETE  *** 

Message Type: Informational
Program Module: Compiler

Explanation:
Gentran:Server displays this message at the end of the Compiler Error Log to 
indicate that compilation was complete and successful. If you do not see this 
message, the compilation was unsuccessful.

Procedure:
No further action is necessary.

(Continued on next page)

Error Explanation

Character <string> is not valid in this 
context.

Gentran:Server is unable to accept the 
identified character string. Certain 
operations or types of data are 
meaningful only at given points in 
mapping instructions.

Character(s) <list of characters> 
cannot be used in the mapping 
expression <mapping instruction> 
(see documentation).

The identified character(s) are used 
incorrectly in this mapping instruction.
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Compilation ***  COMPILATION COMPLETE, compiled map was written to: <file name>.
Message Type: Informational
Program Module: Compiler

Explanation:
The compiler has finished compiling the map and has written the Map Table (.tbl) 
to the file identified in the message.

Procedure:
No further action is necessary.

Could Could not bind to a valid printing device

Message Type: Error
Program Module: Application and Standard/IG Editors and Visual Mapper

Explanation:
Gentran:Server was unable fulfill the print request. The printer specified in Print 
Setup is unavailable.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Select Print Setup from the File menu and select a new default 
printer that your machine can access directly or over a network that 
you are logged onto. 

2 Select Print from the File menu (CTRL+P).
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Could Could not find a parent GROUP ID

Message Type: Error
Program Module: Visual Mapper

Explanation:
Gentran:Server requires that you select the name of a mapping GROUP before 
entering an item label. This rule applies even if the Mapping Mini-report contains 
only one GROUP. 

Procedure:
Use this procedure in response to this message:

Could Could not find existing LABEL

Message Type: Error
Program Module: Visual Mapper (Fast Entry Mode)

Explanation:
The label entered may not exist on this side of the map. Gentran:Server displays 
this message when both sides of the map are in fast entry mode, even when the 
label exists.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Select the name of the mapping GROUP (in the Mapping Mini-
report) to which you want to apply the command. 

2 Select the command from the Map Items menu and enter a valid 
item label into the text box of the dialog box displayed.

Step Action

1 Set one side of the map to tree mode and one side in fast entry 
mode.

2 Move the focus on the side in tree mode onto a field/element/sub-
element

3 Enter the name or label of a field/element/subelement into the text 
box on the dialog box displayed.
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Could Could not find existing record field pair

Message Type: Error
Program Module: Visual Mapper (Fast Entry Mode)

Explanation:
The record/segment and field/element combination entered does not exist on the 
side of the map in Fast Entry mode or was mapped previously. 

Procedure:
Enter a combination that exists on the side of the map in Fast Entry mode and that 
was not mapped previously.

Could Could not find text file <file name> to display.

Message Type: Error
Program Module: Application and Standard/IG Editors and Visual Mapper

Explanation:
Gentran:Server is unable to find the file containing the To Do List.

Procedure:
To correct the error, use the File Manager to determine whether the file exists and 
its location. 

◗ If it does exist, but is in the wrong directory, you must move it to the correct 
directory and run the process again.

◗ If the file does not exist, call Gentran:Server Customer Support. You must 
provide Customer Support with the complete text of this message and the 
version of Gentran:Server you are running.

 (Continued on next page)
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Could Gentran:Server displays a message whenever it is unable to find a file.

Message Type: Error
Program Module: Navigator/Visual Mapper

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Error Explanation

Could not load application 
data

The Navigator is unable to load the file containing 
application data.The directory in which application 
files are stored is identified on the Setup 
Directories dialog box.

Could not load destination 
data

The Visual Mapper is unable to load the file 
containing destination data.

Could not load mapping 
instructions

The Visual Mapper is unable to load the file 
containing the specified map.

Could not load source 
data

The Visual Mapper is unable to load the file 
containing source data. 

Could not open file <file 
name>

Gentran:Server is unable to open the identified file.

Step Action

1 Use File Manager to determine whether the file:

◗ and directory exist
◗ is in the specified directory
◗ is empty.

2 Use this table to determine your next action.

IF the... THEN...

Directory does not exist Create it. 

Directory exists but the 
file does not

Create the file and move it to the 
correct directory. 

File exists and is in the 
proper directory

Check the read permissions on the file 
and directory. Change them if needed.
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Could Could not open file.
Message Type: Error
Program Module: Application Editor

Explanation:
Gentran:Server is unable to open a new file through the Application Editor. The 
permissions for the directory containing application files are not correct.

Procedure:
Use this procedure to correct the error.

 Could Could not open 'xlcntl.err'
Message Type: Error
Program Module: Various

Explanation:
Gentran:Server was unable to find, open, or create the file xlcntl.err.

Procedure:
Use one of these responses if you receive this message

(Continued on next page)

Step Action

1 View the Setup Directories dialog box to determine the directory in 
which you are storing application files. 

2 Change the permissions of the application files directory to allow 
Gentran:Server read and write permissions.

IF you are in a... THEN...

UNIX multi-user 
environment

Wait, then run the process again.

Single-user environment or 
know that no other user has 
the file locked

1. View the Setup Directories dialog box to 
identify the directory containing temporary files. 

2. Use File Manager to determine whether the 
directory exists and whether it contains the file.

If the file does not exist, check write permissions 
on the directory. If the file exists, check the read 
permissions on the file and directory.
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Could Could not save file <file name>

Message Type: Error
Program Module: Application and Standard/IG Editors and Visual Mapper

Explanation:
Gentran:Server was unable to save the indicated file. 

Procedure:
Use this procedure in response to this message:

Current Current field is not a Record ID

Message Type: Error
Program Module: Application Editor

Explanation:
The Unmark Record ID option is available only when the focus is on a field 
marked as the Record ID.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Determine the amount of disk space available on the disk to which 
Gentran:Server was trying to write the file. Provide additional space 
if necessary.

2 Check the permissions of the file and the directory. Change the 
permissions if necessary.

Step Action

1 Move the focus to a field that is marked as a Record ID. 

2 Click Unmark Record ID on the Mark menu.
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Current Current item must be a Field in order to make it a Record ID Field
Current item must be a Field in order to remove a Record ID Field
Message Type: Error
Program Module: Application Editor

Explanation:
The Mark/Unmark Record ID options are available only when a field is selected. 
Currently, the focus covers an entire record.

Procedure:
Use this procedure in response to this message:

Current Current field is not a TP Code
Current item must be a field in the first record in order to make it a TP Code 
field
Message Type: Error
Program Module: Application Editor

Explanation:
The Mark TP Code option is active only for marking a field in the first record as 
the TP Code. This option is unavailable when a TP Code is marked. 

The Unmark TP Code option is available only when the focus is on a field marked 
as the TP Code. 

Procedure:
Use one of these responses if you receive this message

Note
In certain situations, the TP Code field may not exist.

(Continued on next page)

Step Action

1 Move the focus to a field in a record that has no Record ID field.

2 Click Mark/Unmark Record ID on the Mark menu.

IF you want to... THEN...

Mark a field the TP Code 1.Move the focus to a field in the first record.

2.Click Mark TP Code on the Mark menu.

Remove the mark 
(unmark) from a TP Code 
field

1.Move the focus to the field

2.Click Unmark TP Code on the Mark menu.
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Delete Delete File: <file name>
Are You Sure?

Message Type: Prompt
Program Module: Main Window
Explanation:
Gentran:Server prompts you to confirm this deletion request. You will be unable to 
access or restore the file once you confirm the deletion. 

Procedure:
Use one of these responses if you receive this message

Deleting Deleting record <label> would result in a single record loop ending multiple 
loop levels. This is not allowed. To delete <label>, delete or restructure the 
loop.

Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
Gentran:Server does not allow you to delete a record if, in doing so, you will 
create a single record loop within a nested loop. 

Procedure:
Use one of these responses if you receive this message.

(Continued on next page)

IF you... THEN Click...

Are certain you want to permanently delete this file Yes.

Are uncertain that you want to permanently delete this file No.

IF you want to... THEN...

Retain the current loop structure No action is necessary.

Cut or delete what is currently the 
last record in the loop

You must first change the loop structure to 
eliminate the nested loop or ends on a 
different record.

Example 
If you remove the nested loop, you can 
then cut or delete the last record of the 
outer loop.
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Do Do you want to save changes to <string>?

Message Type: Prompt
Program Module: Synonym and Thesaurus Editors
Explanation:
Gentran:Server is prompting you to save recent changes made to the displayed 
list before closing the editor or opening a new list. 

Procedure:
Use one of these responses if you receive this message.

Element Element <element> is in at least one group. Are you sure you want to pro-
ceed. (Program Module: Application and Standard/IG Editors)

Element <element> is used in at least one mapping instruction. Are you sure 
you want to proceed. (Program Module: Compiler)

Message Type: Warning
Explanation:
Gentran:Server is prompting you to verify a deletion request. The element or field 
you selected for deletion is currently mapped. Deleting it will create an incomplete 
mapping instruction. The map compiler is unable to process incomplete mapping 
instructions. 

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF you... THEN Select...

Want to save the changes Yes.

Do not want to save changes No.

Step Action

1 Click No and return to the map. This is the recommended action.

2 Delete related mapping instructions and GROUPS prior to deleting 
the item.

Important
If you click Yes, you must immediately return to the map and delete 
or correct the incomplete mapping instructions. You must then 
recompile the map before using it.
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Enter Enter a valid name.

Message Type: Error
Program Module: Synonym and Thesaurus Editors

Explanation:
A valid name was not entered for the new synonym or thesaurus list you are 
creating or saving. You must enter a unique name for the list. The name can 
contain a maximum of nineteen alphanumeric characters. List names are case-
sensitive.

If you enter a name that is currently in use, the system prompts you to overwrite 
the file or change the name under which you are saving the list. 

Note
The name ‘New List’ is reserved and is not available for use. 

Procedure:
Enter a valid name in the Synonym/Thesaurus List -- Save As dialog box.

envelope envelope: Error opening process log file xlcntl.err 
Message Type: Error
Program Module: envelope

Explanation:
Gentran:Server could not find, open, or create the file xlcntl.err. The file may be 
stored in a directory for which envelope does not have read permission.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 View the Setup Directories dialog box to identify the directory that 
contains your temporary files. 

2 Use File Manager to determine whether the directory exists and 
whether it contains the file.

3 Use this table to determine your next action.

IF the file... THEN check the...

Does not exist Write permissions on the directory. 

Does exist Read permissions on the file and directory.
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envelope envelope: Error reading 'envprim.cfg'

Message Type: Error
Program Module: envelope
Explanation:
Gentran:Server cannot read the envprim.cfg file. 

Procedure:
Use one of these responses if you receive this message

Error There are three similar Error messages displayed from the Visual Mapper.
Error attempting to add <label> to <GROUP name>
Error attempting to delete <GROUP name>
Error attempting to delete <label> from <GROUP name>
Explanation:
An internal error occurred in Gentran:Server.

Procedure:
Call Gentran:Server Customer Support. Provide the complete text of this 
message and the version of Gentran:Server you are running.

Error Error building primary key index.

Message Type: Error
Program Module: Application Editor
Explanation:
An internal error occurred in Gentran:Server.

Procedure:
Call Gentran:Server Customer Support. Provide the complete text of this 
message and the version of Gentran:Server you are running.

(Continued on next page)

IF... THEN...

envelope was executed from 
a directory that did not contain 
envprim.cfg

Run envelope again, from the directory 
containing envprim.cfg.

There is no data in the file Call Gentran:Server Customer Support. You
must provide the exact wording of the message
and the version of Gentran:Server you are using.
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Error Error Creating <directory name>

Message Type: Error
Program Module: Main Window (Settings)

Explanation:
Gentran:Server is unable to create the directory named in the Setup Directory 
dialog box.

Procedure:
Use this procedure in response to this message:

Errors Errors occurred in <location of error>:

Message Type: Error
Program Module: Compiler

Explanation:
The compiler found one or more unspecified errors while compiling a map.

Procedure:
Use this procedure in response to this message: 

(Continued on next page)

Step Action

1 Determine whether a slash or backslash follows the directory 
name. If so, delete the extra mark and continue.

2 Check the read and write permissions for the upper-level directory. 
If necessary, change them to allow Gentran:Server access.

3 Determine whether enough disk space is available for the directory 
Gentran:Server is attempting to create. You may need additional 
space.

Step Action

1 Check the part of the map indicated in the message.

2 Make any corrections necessary and recompile the map.
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Error Error occurred while reading file <file name>.

Message Type: Error
Program Module: Application Editor and Visual Mapper

Explanation:
Gentran:Server is unable to read the identified file (<file name>). 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 View the Setup Directories dialog box to identify the directory that 
contains your temporary files. 

2 Use File Manager to determine whether the directory exists and 
whether it contains the file.

3 Use this table to determine your next action.

IF the file... THEN check the...

Does not exist Write permissions on the directory. 

Does exist Read permissions on the file and directory.

4 View the contents of the file to determine whether it is empty. If it is, 
contact Gentran:Server Customer Support.
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Error Error Opening File: <Map File name>

Message Type: Error
Program Module: Visual Mapper

Explanation:
The Visual Mapper is unable to open the file identified in the message. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 View the Setup Directories dialog box to identify the directory that 
contains your temporary files. 

2 Use File Manager to determine whether the directory exists and 
whether it contains the file.

3 Use this table to determine your next action.

IF the file... THEN check the...

Does not exist Write permissions on the 
directory. 

Does exist Read permissions on the file 
and directory.

4 View the contents of the file to determine whether it is empty. If it is, 
contact Gentran:Server Customer Support.
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Error Error saving translation settings

Message Type: Error
Program Module: Main Window (Translate)

Explanation:
Gentran:Server was unable to save the translation settings. 

Procedure:
Use this procedure in response to this message:

failed Failed to allocate translate table memory 

Message Type: Error
Program Module: lftran

Explanation:
The lftran program encountered the error indicated and was unable to complete 
the current process. 

Procedure:
Compile the map on the platform on which you are running lftran, then run the 
translation again. The map must be compiled on the same platform on which you 
are running lftran and must be in binary format.

(Continued on next page)

Step Action

1 Check the amount of disk space available for Gentran:Server to 
complete this task. If necessary, provide more disk space.

2 Check the permissions of the transin.dat or transout.dat file and the 
directory containing them. If necessary, change the permissions.

3 Run the translation again.
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failed failed - error code <error number> 

Message Type: Error
Program Module: edifrmat

Explanation:
The edifrmat program encountered the error indicated and was unable to 
complete the current process.

Procedure:
See the “References” topic in the Online Help or the chapter Command Reference 
in the Gentran:Server for UNIX and Workstation Technical Reference Guide to 
find the meaning of the error number referred to in this message.

(Continued on next page)
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Failed Failed to open standard data file - <file name>

Message Type: Error
Program Module: Standard/IG Editor (AutoTrim)

Explanation:
The Standard/IG Editor was unable to open the identified file (<file name>) or 
perform AutoTrim.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 View the Setup Directories dialog box to identify the directory that 
contains your temporary files. 

2 Use File Manager to determine whether the directory exists and 
whether it contains the file.

3 Use this table to determine your next step.

IF the file... THEN...

Does not exist Reload it from the Gentran:Server 
installation disks or tape.

Exists, but the correct 
directory does not

Create the directory and move the 
file into that directory.

And the directory both exist, 
but the file is not in the 
correct directory

Move the file.

Has the correct name and is 
in the correct directory

Check the permissions and change 
them if necessary.
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Failed Failed to save file location paths

Message Type: Error
Program Module: Main Window (Settings)

Explanation:
Gentran:Server was unable to saved the file locations specified in the Setup 
Directories dialog box.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Open the Setup Directories dialog box and specify the correct file 
locations again. 

2 Click OK.

Note 
If a directory does not exist, Gentran:Server will prompt you to 
create it.

3 Use this table to determine your next action.

If you... THEN...

Want to create the 
directories

1. Click Yes.

2. Use File Manager to verify that the 
directories exist. 

Note 
If they do not exist, Gentran:Server may 
not have the correct permissions to create 
directories. 

Check the permissions, change them if 
necessary, and then enter the directory 
locations again.

Do not want to create 
the directories

Click No.
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Failed Failed writing envprim.cfg
Message Type: Error
Program Module: Main Window (Settings)

Explanation:
Gentran:Server was unable to write the configuration. 

Procedure:
Use this procedure in response to this message:

Field Field <Field Name> is the last field in the record, cut/delete the record in-
stead.

Message Type: Error
Program Module: Standard/IG Editor

Explanation:
Gentran:Server is unable to delete or cut the last or only field in a record. The 
Edit/Delete Marked function is unavailable when the record has only one field. 

Procedure:
Use one of these responses if you receive this message.

(Continued on next page)

Step Action

1 Check the amount of disk space available for Gentran:Server to 
complete this task. If necessary, provide more disk space.

2 Check the permissions of envprim.cfg and $EDI_ROOT and the 
directory containing them. If necessary, change the permissions.

3 Run the process again.

IF you want to... THEN you must...

Delete the field Cut or delete the record.

Delete the field and retain the record Add a new field to the record before 
deleting the currently selected field.
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File File <file name> does not contain the required information.

Message Type: Error
Program Module: Application Editor and Visual Mapper (AutoMapper)

Explanation:
The file indicated <file name> is empty. 

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF you are... THEN specify...

Using the Application 
Editor

The name of a flat file that contains the needed 
application data format information.

Using AutoMapping A complete standard or install this standard again 
to be sure that all files contain the necessary 
information.
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File File: <file name> does not exist

Message Type: Error
Program Module: Visual Mapper

Explanation:
The Visual Mapper is unable to locate the identified file.

Procedure:
Use this procedure in response to this message:

 File File <file name> is already open.

Message Type: Informational
Program Module: Application and Standard/IG Editors and Visual Mapper

Explanation:
Gentran:Server is unable to open two copies of the same file simultaneously. The 
selected file is currently open and/or in use by another user.

Procedure:
No action necessary. You can use the open windows list at the bottom of the 
Window menu to select and switch to the desired open file if you are using the 
Workstation product level. If you are using the Gentran:Server product level or 
higher, you must wait until the file is closed.

(Continued on next page)

Step Action

1 View the Setup Directories dialog box to identify the directory that 
contains your temporary files.

2 Use File Manager to determine whether the directory exists and 
whether it contains the file.

3 Use this table to determine your next action.

IF the file... THEN...

Is in the wrong directory Move it.

Does not exist Create the file or specify another file.
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File File:<file name> is currently in use - Delete File?

Message Type: Warning
Program Module: Main Window

Explanation:
Gentran:Server is prompting you to confirm the deletion of the file that is currently 
open. 

Procedure:
Use this procedure in response to this message:

File File: <file name> exists. Overwrite File?

Message Type: Warning
Program Module: Application and Standard/IG Editors and Visual Mapper

Explanation:
The name specified is currently in use by another file. Gentran:Server is 
prompting you to overwrite the original file or use a different name.

Procedure:
Use one of these responses to correct the error.

(Continued on next page)

IF you... THEN click...

Want to delete this file after closing it Yes.

Want to save this file after closing it No.

IF you want to... THEN click...

Overwrite the existing file Yes.

Retain the existing file and assign this file a different name No.
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 File File: <file name> is not a valid Application/IG

Message Type: Error
Program Module: Application and Standard/IG Editors and Visual Mapper

Explanation:
The file identified is neither an application description or an implementation guide. 
Gentran:Server is unable to open the file using the Application or Standard/IG 
Editors or Visual Mapper.

Procedure:
Use this procedure in response to this message:

File File: <file name> is not a valid Map File

Message Type: Error
Program Module: Visual Mapper

Explanation:
The file identified is not a map. Gentran:Server is unable to open the file using the 
Visual Mapper.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Specify an application description or implementation guide. 

2 Move, delete, or rename the file first selected.

Step Action

1 Specify a map file (.map).

2 Move, delete, or rename the file first selected.
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File File: <file name> is not a valid Standard/IG

Message Type: Error
Program Module: Standard/IG Editor and Visual Mapper

Explanation:
The file identified is not an implementation guide. Gentran:Server is unable to 
open the file using the Standard/IG Editor or Visual Mapper.

Procedure:
Use this procedure in response to this message:

FIXED FIXED LENGTH must be a numeric

FIXED LENGTH too large; must not exceed 6144

Message Type: Error
Program Module: Application Editor

Explanation:
Gentran:Server accepts only a positive, numeric value from 1 to 6144 (inclusive) 
for the FIELD LENGTH parameter.

Internal Internal error # <error number>. Please report this to product support.

Message Type: Error
Program Module: Compiler

Explanation:
The compiler encountered an error (<error number>) and is unable to compile this 
map.

Procedure:
Call Gentran:Server Customer Support. Provide them with the exact wording of 
the message and the version of Gentran:Server you are using.

(Continued on next page)

Step Action

1 Specify an implementation guide.

2 Move, delete, or rename the file first selected.
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INTERNAL INTERNAL ERROR: Cannot find the destination element <destination ele-
ment>, therefore cannot record the mapping instruction <mapping instruc-
tion>. Please report this to product support.

INTERNAL ERROR: Cannot find the source element <source element>, there-
fore cannot proceed with compiling the mapping instruction <mapping in-
struction>. Please report this to product support.

Message Type: Error
Program Module: Compiler

Explanation:
The compiler is unable to find the destination or source field/element used in the 
identified mapping instruction.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Open the map, then find the identified destination or source item 
and mapping instruction.

2 Call Gentran:Server Customer Support. Provide them with the 
exact wording of the message and the mapping instruction. You 
must also provide the version of Gentran:Server you are using.
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Invalid Invalid file name

Message Type: Error
Program Module: Application Editor

Explanation:
The Application Editor is unable to open the file identified in the message. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 View the Setup Directories dialog box to identify the directory that 
contains your temporary files.

2 Use File Manager to determine whether the directory exists and 
whether it contains the file.

3 Use this table to determine your next action.

IF the file... THEN...

Exists, but the correct directory 
does not

Create the directory and move 
the file into that directory.

And the directory both exist, but 
the file is not in the correct 
directory

Move the file.

Has the correct name and is in 
the correct directory

Check the permissions and 
change them, if necessary.
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Invalid Invalid loop boundaries

Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
A noncontiguous records/segments are marked and/or certain fields/elements are 
marked but the record/segment containing them is not. These are invalid loop 
boundaries.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Click Clear All Marks from the Mark menu. 

2 Click Collapse All from the View menu to view only the records/
segments you want in the loop.

To mark each desired record/segment, move the focus to the item 
and press F5. Do this for each item in turn. 

3 Select Make Loop from the Edit menu (CTRL+L).
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Invalid Invalid Original Value data

Invalid Substitute Value data

Message Type: Error
Program Module: Synonym and Thesaurus Editors

Explanation:
The current version of the list is missing one or more Original or Substitute values. 
Each value entered in the Original column must have a partner value in the 
Substitute column. 

Procedure:
Use this procedure in response to this message:

Loop Loop count must be a numeric or >1

Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
The value entered for the loop count is invalid. The loop count of a record/
segment must be either a positive numeric value from 1 to 32760 or “>1”. 

Procedure:
Enter a loop count that is a positive numeric value from 1 to 32760 or “>1”.

(Continued on next page)

Step Action

1 Enter a value in the Original Value column for every entry in the 
Substitute Value column. 

Enter a value in the Substitute Value column for every entry in the 
Original Value column.

2 Click Save List or Save List As from the File menu.
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Map Map: <Map File name> is currently open. All maps must be closed before 
starting the <string>, do you wish to close it?

Message Type: Warning
Program Module: Various

Explanation:
All maps must be closed before Gentran:Server can perform the requested 
operations. The identified map is currently open. 

Procedure:
Use one of these responses if you receive this message

(Continued on next page)

IF you want to... THEN Select...

Continue Yes.

Note
If you select Yes and the open map contains 
unsaved changes, Gentran:Server prompts you to 
save the changes before it closes the map. 

◗ Click Yes to save the changes before closing 
the file. 

◗ Click No to close the file without saving 
changes.

Cancel the new operation 
and keep the map open

No.
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Map Map: <Map File name> is currently open. Do you wish to close it?
Message Type: Prompt
Program Module: Visual Mapper

Explanation:
The selected map is currently open. The Visual Mapper is prompting you to close 
the open file or leave it open.

Procedure:
Use one of these responses if you receive this message

MAX MAX length must be a numeric
MAX length too large; must not exceed 6144
Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
The maximum length of a variable length field must be a positive numeric value 
from 1 to 6144. The value entered is invalid

Procedure:
Specify a maximum length that is a positive number from 1 to 6144.

MAX MAX occurrence must be a numeric or >1

Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
The maximum occurrence of a record/segment must be either a positive numeric 
value from 1 to 32760 or the value “>1.” The value entered is invalid.

Procedure:
Either specify a maximum occurrence that is a positive number from 1 to 32760 or 
enter “>1.”

(Continued on next page)

IF you want to... THEN Select...

Close the file Yes. 

Leave the file open. No.
Maintenance and Troubleshooting Guide – August 2004



Messages in Alphabetical Order (Not Starting with Variables) System Messages2 - 120
Maximum Maximum string length reached.

Message Type: Warning
Program Module: Synonym and Thesaurus Editors

Explanation:
A maximum of 80 characters are allowed for each original or substitute value 
entered into a synonym or thesaurus list. You have entered 80 characters. No 
additional characters will be accepted for the value you are entering.

Procedure:
Go to the next item you will enter on the list. 

Note 
After 43 characters, a string of pound signs (#) appears in the column in place of 
the text. This is for display purposes only to indicate that the field contains a value 
larger than the screen display field. The text string remains in memory, and the 
actual value displays in the text entry box.

MIN MIN length must be a numeric

Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
The minimum length of a variable length field must be a positive numeric value 
from 1 to 99. The value entered is invalid.

Procedure:
Specify a minimum length that is a positive number from 1 to 99.

(Continued on next page)
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MIN MIN length must be less than or equal to MAX length. Make MAX length equal 
<MIN length>?

Message Type: Warning
Program Module: Application and Standard/IG Editors

Explanation:
By definition, the minimum length of a field must be less than or equal to the 
maximum length for the same. The value entered is longer than the maximum 
length for the field specified.

Procedure:
Use one of these responses if you receive this message

◗ Change the value entered to be less than or equal to the maximum length 
allowed for this field.

◗ Have Gentran:Server change the maximum length for this field to equal the 
value you entered for the minimum length.

Missing Missing a required <argument> in the expression.

Message Type: Error
Program Module: Compiler

Explanation:
The currently displayed mapping instruction is invalid. It lacks a required 
argument.

Procedure:
Change the mapping instruction to include all required arguments. 

Reference
See the chapter Mapping in the Gentran:Server for UNIX and Workstation 
Mapping and Translation Guide for more information about the arguments 
required for available operations.

(Continued on next page)
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Missing Missing valid destination; cannot create mapping

Message Type: Error
Program Module: Visual Mapper

Explanation:
No destination item is marked for the current mapping. You must mark one or 
more destination(s) to create a mapping GROUP.

Procedure:
Use this procedure in response to this message:

MTIMER MTIMER was suspended during its last execution, resume MTIMER where it 
left off?

Message Type: Prompt
Program Module: Main Window (Tools)

Explanation:
The Task Scheduler was closed prior to completing the last series of scheduled 
tasks. You must choose between running all of the tasks again or running only 
those that were not executed during the previous session.

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

Step Action

1 Mark one or more destination item(s). 

2 Click the right mouse button to create the mapping GROUP.

IF you want to run... THEN Click...

Only those scheduled tasks that were not executed 
during the previous session

Yes. 

Run all scheduled tasks, including those executed 
during the previous session

No.
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Must Must be on a mapped item in the destination to delete a GROUP.

Must be on a mapped item in the source to delete a GROUP.

Message Type: Error
Program Module: Visual Mapper

Explanation:
The selected item is on the destination side of the map and/or is not mapped. The 
Delete Group option is available only when the focus highlights a mapped item 
on the Source side of the map. 

Procedure:
Use this procedure in response to this message:

Must Must be on a mapped item in the destination to delete it from a GROUP.

Must be on a mapped item in the source to delete it from a GROUP.

Message Type: Error
Program Module: Visual Mapper

Explanation:
The selected item is not mapped. To delete an item from a GROUP, you must first 
select it with the focus. 

Procedure:
Click the source or destination item you want to delete and press DELETE. 

(Continued on next page)

Step Action

1 Click the mapped item you want to delete from the source side of 
the map.

2 Click Delete GROUP from the Map Item menu.
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Must Must be on a mapped item in the destination to edit mapping instructions.
Must be on a mapped item in the source to edit mapping instructions.

Message Type: Error
Program Module: Visual Mapper

Explanation:
The selected item is not mapped. To edit mapping instructions, you must move 
the focus onto a mapped item on the active side of the map.

Procedure:
Use this procedure in response to this message:

Must Must be on the beginning record of a loop to remove loop structure.

Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
To remove a loop structure, you must have the focus on the first record/segment 
of the loop Currently, the focus is on another record/segment in the loop or on a 
field/element

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Click the mapped item you want to edit from the either side of the 
map.

2 Click the Mapping Instructions ToolBar button.

Step Action

1 Move the focus to the first record/segment in the loop. 

2 Select Remove Loop from the Edit menu (CTRL+R).
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Must Must remove existing record id field
Message Type: Error
Program Module: Application Editor

Explanation:
A field other than the one currently selected is marked as the Record ID for this 
record. The Mark Record ID option is unavailable when a record contains a 
marked Record ID field. 

Procedure:
Use this procedure in response to this message:

Must Must unmark existing TP Code field
Message Type: Error
Program Module: Application Editor

Explanation:
A field other than the one currently selected is marked as the TP Code field for 
this record. To mark this field as the TP Code, you must first unmark the other 
one. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Click the field in this record currently marked as the Record ID and 
click Unmark Record ID on the Mark menu.

2 Click the field in this record you want to mark as the Record ID and 
click Mark Record ID on the Mark menu.

Step Action

1 Click the field currently marked as the TP Code, then click Unmark 
TP Code on the Mark menu. 

2 Click the field you want to mark as the TP Code and click Mark TP 
Code from the Mark menu.
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Name Name <list name> already exists. Do you wish to overwrite it?

Message Type: Warning
Program Module: Synonym and Thesaurus Editors

Explanation:
The name entered is currently assigned to another synonym or thesaurus list. You 
can overwrite the original list or save this file under another name. 

Procedure:
Use one of these responses if you receive this message

No No data selected to copy.
No data selected to cut.

Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
Currently, no items are marked. The Copy Marked and Cut Marked options are 
available only when one or more items are marked. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

IF you want to... THEN select...

Overwrite the original list Yes.

Save this list under another name and 
preserve the original

No and enter another name for this 
list.

Step Action

1 Click the item(s) you want to copy or cut and press F5. 

2 Click Copy Marked or Cut Marked on the Edit menu.
Maintenance and Troubleshooting Guide – August 2004



System Messages Messages in Alphabetical Order (Not Starting with Variables) 2 - 127
No No element sequence number information

Message Type: Error
Program Module: Visual Mapper (Fast Entry Mode)

Explanation:
When in Fast Entry Mode, the Visual Mapper can map standard or 
implementation guide items to the selected item only if the segment ID and the 
sequence number of the element or sub-element are entered. No element and/or 
subelement sequence was entered for the selection you are mapping.

Procedure:
Enter the sequence number of the element and/or subelement and click ENTER. 

No No field has yet been made a Record ID

Message Type: Error
Program Module: Application Editor

Explanation:
The Unmark Record ID option is available only if the selected record contains a 
field marked as the Record ID. Currently, no field in the selected record is marked 
as the Record ID.

Procedure:
No other action is necessary. You can now mark a field in this record as the 
Record ID.

No No field has yet been made a TP Code

Message Type: Error
Program Module: Application Editor

Explanation:
The Unmark TP Code option is available only if the selected record contains a 
field marked as the TP Code. Currently, no field in the selected record is marked 
as the TP Code. 

You can mark only one field as the TP Code. That record must be in the first 
record.

Procedure:
No other action is necessary. If the focus is in the first record, you can now mark a 
field in this record as the TP Code.

(Continued on next page)
Maintenance and Troubleshooting Guide – August 2004



Messages in Alphabetical Order (Not Starting with Variables) System Messages2 - 128
No No field information

Message Type: Error
Program Module: Visual Mapper (Fast Entry Mode)

Explanation:
When in Fast Entry Mode, the Visual Mapper can map application items items to 
the selected item only if the Record ID and field name of the destination item are 
entered. No field name was entered for the item you are mapping.

Procedure:
Enter the name of the field and press ENTER.

No No GROUP was selected for mapping instructions

Message Type: Error
Program Module: Visual Mapper

Explanation:
You can edit mapping instructions only after selecting an item and the name of the 
mapping GROUP you want to modify. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Click a mapped item and, if necessary, highlight the name of the 
mapping GROUP for which you want to edit mapping instructions. 

2 Highlight the name of the mapping GROUP that contains the 
mapping instructions you want to edit.

3 Click the Mapping Instructions button on the toolbar.
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No No LABEL information

Message Type: Error
Program Module: Visual Mapper (Fast Entry Mode)

Explanation:
You must enter label information in the Field/Element label text box when the 
Use labels for Quick Entry option is active. No label was entered for the selected 
item. 

Procedure:
Enter the label of the selected field or element in the Field/Element label text box 
and press ENTER.

No No mapping instructions found for this record.

Message Type: Informational
Program Module: Visual Mapper

Explanation:
The Visual Mapper can sort mapping instruction only if they exist. Currently, no 
mapping instructions exist for the selected record or segment.

Procedure:
Use one of these responses if you receive this message

◗ Create mapping instructions for the selected source or segment and then sort 
them. 

◗ Click another source record or segment that has mapping instructions.

No No remaining disk space encountered attempting to write <file name>

Message Type: Error
Program Module: Installation

Explanation:
There is insufficient disk space available to allow the installation program to write 
the specified .DLL file.

Procedure:
You must make more disk space available, then run the installation program 
again. 

(Continued on next page)
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No No segment/record information

Message Type: Error
Program Module: Visual Mapper (Fast Entry Mode)

Explanation:
When in Fast Entry Mode, the Visual Mapper can map standard or 
implementation guide items to the selected item only if the segment ID and the 
sequence number of the element or sub-element are entered. No record or 
segment ID was entered for the selection you are mapping.

Procedure:
Enter the ID of the record/segment containing the field/element you want to map 
and press ENTER.

No No standard files found. Check preference paths.

Message Type: Error
Program Module: Standard/IG Editor and Visual Mapper

Explanation:
The directory specified does not contain any standards files. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Click Setup Directories on the Settings menu of the Main or the 
Visual Mapper menu bar.

2 Enter the path and name for the directory containing the standards 
in the Setup Directories dialog box. 

If no standards exist, run the installation process again and copy 
the standards required to your hard drive or network drive.
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No No Synonym Filename has been assigned.

Message Type: Error
Program Module: Synonym Editor

Explanation:
An internal error has occurred in Gentran:Server.

Procedure:
Call Gentran:Server Customer Support. Provide them with the complete text of 
this message and the version of Gentran:Server you are running.

Nothing Nothing to delete

Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
The Delete Marked option is available only when you select a marked item. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Click the item(s) you want to delete, then press F5.

2 Click Delete Marked on the Edit menu.
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Nothing Nothing to edit. First select a condition, mapping, or macro to edit

Message Type: Error
Program Module: Compiler

Explanation:
The Edit button in the Mapping Instructions window is active only when a 
condition, a mapping, or a macro is selected. 

Procedure:
Use this procedure in response to this message:

Number Number of attributes must be less than 50

Message Type: Error
Program Module: Application Editor

Explanation:
The Descriptions column in the Read Application Data Description Layout 
dialog box can list a maximum of 50 attributes Currently the column list more than 
50 attributes.

Procedure:
Reduce the number of attributes in the Description Fields column to 50 or fewer.

Number Number of output files exceeded max of <Number>

Message Type: Error
Program Module: Iftran

Explanation:
Gentran:Server is unable to open all of the output files required to process the 
data. 

Procedure:
Restructure your use of output files or split the data so that the pieces are 
processed separately.

(Continued on next page)

Step Action

1 Click a condition, a mapping, or a macro.

2 Click the Edit button.
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Only Only a field of the first record of the application can be marked as a TP Code

Message Type: Error
Program Module: Application Editor

Explanation:
The selected field is not in the first record of the application. You can mark 
only a field in the first record as the TP Code.

Procedure:
Click the a field in the first record, then click Mark TP Code on the Mark menu.

Only Only allowed to cut one selected block of data at a time.

Message Type: Error
Program Module: Application and Standard/IG Editors

Explanation:
The Cut Marked option is active only when a single block of data is marked. 
Currently, two or more blocks of data are marked and selected. A block of data is 
a contiguous string consisting of element, composite element, and element.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Click Clear All Marks on the Mark menu.

2 Click one block of data and press F5.

3 Click Cut Marked on the Edit menu.
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Operation Operation <operation> does not make sense in this context.

Message Type: Error
Program Module: Compiler

Explanation:
The identified operation is not valid for the mapping instruction you are creating.

Procedure:
Change the operation you are using to create the mapping instruction. 

Reference
See the chapter Working with Mapping Instructions in the Gentran:Server for 
UNIX and Workstation Mapping and Translation Guide for information about using 
operations in mapping instructions.

Operation Operation <operation> is incomplete. It is missing argument number <num-
ber>.

Operation <operation> is incomplete. It is missing required data.

Message Type: Error
Program Module: Compiler

Explanation:
The currently displayed mapping instruction lacks a required argument or data 
item. The message indicates the number of the missing argument (in order -- from 
left to right) when appropriate.

Procedure:
Modify the mapping instruction to include all required arguments and data items. 

Reference
See the chapter Mapping in the Gentran:Server for UNIX and Workstation 
Mapping and Translation Guide for information about the arguments and data 
items required for this operation.

(Continued on next page)
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Permanently Permanently delete all marked items?

Message Type: Prompt
Program Module: Application and Standard/IG Editors

Explanation:
Gentran:Server requires you to confirm that you want to delete all marked items. 

Procedure:
Use this procedure in response to this prompt.

(Continued on next page)

Step Action

1 Verify that you want to permanently delete all of the items marked. 
The names of marked items are in blue. 

2 Use this table to determine your next action.

IF you... THEN...

Want to delete all 
items marked

Click Yes.

Do not want to delete 
all items marked

1. Click No. 

2. Click Clear All Marks on the Mark 
menu. 

3. Mark only those items you want to 
delete.

4. Click Delete Marked from the Edit 
menu.
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Permanently Permanently delete <GROUP name>? If you delete you will lose all <GROUP 
name> mapping instructions as well.

Permanently delete item <label> from <GROUP name>?

Message Type: Warning
Program Module: Visual Mapper

Explanation:
Gentran:Server requires you to confirm that you want to delete a GROUP name or 
an item from a GROUP. 

When you delete a GROUP, you also delete all mapping instructions in it.

When you delete an item from a GROUP, all mapping instructions containing it 
become incomplete. 

Comment
Display a Mapping Mini-report to see the mapping instructions in the GROUP.

Procedure:
Use one of these responses if you receive this message

Note
You can delete individual instructions from the GROUP in the Mapping 
Instructions window.

(Continued on next page)

IF you want to... THEN...

Delete all of the mapping instructions in the GROUP 

Delete the item from all mapping instructions in the GROUP

Click Yes.

Save at least one of the mapping instructions in the GROUP

Retain the item in at least one of the mapping instructions in 
the GROUP

Click No. 

Step Action

1 Open the Mapping Instructions window.

2 Use the DELETE key to delete one or more of the mapping 
instruction.
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Please Please select a record first.

Message Type: Prompt
Program Module: Visual Mapper

Explanation:
The Map if Record is absent option is active only when a record is selected.

Procedure:
Select the record that you want to mark and click the option again.

Process Process all MTIMER jobs, even those scheduled to run before <current sys-
tem date and time>

Message Type: Prompt
Program Module: Main Window (Tools)

Explanation:
The Task Scheduler is uncertain whether to run batch files scheduled for a time 
previous to the current date and time. 

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF you want to run... THEN...

All scheduled jobs Click Yes.

Only tasks scheduled from the current date and time 
forward 

Click No.

Note
To stop the Task Scheduler after starting it, press ALT+F4.
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 Record Record <label> is a start of a loop. Deleting it will delete all the items in the 
loop as well. Proceed?

Message Type: Warning
Program Module: Application and Standard/IG Editors

Explanation:
Gentran:Server is prompting you to confirm the deletion. The record/segment you 
are trying to delete or cut is the first in a loop. If you delete or cut the first record/
segment in a loop, the editors automatically delete or cut the entire loop. You can 
delete the first item only by first removing the loop structure.

Procedure:
Use one of these responses if you receive this message

Record Record ID field and TP Code field cannot be the same
Message Type: Error
Program Module: Application Editor

Explanation:
The selected field is currently marked as the Record ID or TP Code field. 
Gentran:Server allows you to mark a field only as one or the other, not both.

Procedure:
Select another field for the Record ID or TP Code or remove the mark and 
proceed as intended. 

(Continued on next page)

IF you want to... THEN click...

Delete or cut all records/segments in the loop Yes.

Retain other records/segments in the loop No. 
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Save Save illegal instruction?

Message Type: Prompt
Program Module: Compiler

Explanation:
The mapping instruction created is illegal. Gentran:Server is prompting you to 
save the illegal mapping instruction. This allows you to correct the instruction later. 

Procedure:
Use one of these responses if you receive this message

SEQ SEQ number length too large; must not exceed 32760

SEQ number must be a numeric

Message Type: Error
Program Module: Standard/IG Editor

Explanation:
The SEQ (sequence) number must be a positive numeric value from 1 to 32760 
inclusive.

Note
This field displays a maximum of 4 positions, but will accept a 5-position value.

Procedure:
Enter a SEQ number less than or equal to 32760.

(Continued on next page)

IF you want to... THEN click...

Save the mapping instruction and correct it later Yes.

Delete the illegal mapping instruction No. 
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Source Source file: <file name> does not exist

Message Type: Error
Program Module: Main Window (Translate)

Explanation:
Gentran:Server is unable to locate the source file specified.

Procedure:
Use this procedure in response to this message:

Source Source file: <file name> is not a valid file

Message Type: Error
Program Module: Main Window (Translate)

Explanation:
The selected file does not contains valid EDI data. Gentran:Server is able to open 
only valid EDI file. 

Procedure:
Specify a valid EDI file.

(Continued on next page)

Step Action

1 Identify the name of the directory in which you store your source 
files using the Setup Directories dialog box found under Settings 
on the Gentran:Server window.

2 Use File Manager to determine whether the file exists and whether 
it is in the correct directory. 

3 Use this table to determine your next action.

IF the file... THEN...

Is in the wrong directory Move it.

Does not exists Recreate the file or specify 
another file.
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Standards Standards Load Error 
Can't open <file name>, check file permissions

Message Type: Error
Program Module: Standard/IG Editor (UNIX only)

Explanation:
The Standard/IG Editor does not have read permission for the selected standards 
file and/or the standards file directory.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Select Setup Directories from the Settings menu to open the 
Setup Directories dialog box from the Main window.

2 Determine what directory is specified for your standards files.

3 Correct the permissions of the standards file directory so that 
Gentran:Server has read permissions.
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Suspend Suspend current MTIMER job processing and resume on next MTIMER exe-
cution?

Message Type: Prompt
Program Module: Main Window (Tools)

Explanation:
Gentran:Server is prompting you to suspend the execution of the Task Scheduler. 
The program displays this prompt when you close the Task Scheduler before all 
tasks are completed. If you suspend execution, the Task Scheduler retains a list of 
executed commands. When you run the Scheduler again, you will have the option 
of running only those tasks not previously executed or running all tasks lists.

Procedure:
Use one of these responses if you receive this message

Tblload Tblload allocation error: <number>

Message Type: Error
Program Module: Iftran

Explanation:
There is not enough memory free to continue the translation. This can occur after 
compiling a map for Windows and then moving the Map Table to UNIX.

Procedure:
Chose one of these in response to this error:

◗ Close all other applications to free additional memory.
◗ Recompile the map for UNIX and then proceed.

If neither of these options correct the error, contact Gentran:Server Customer 
Support. You must provide them with the exact text of this message and the 
version of Gentran:Server you are running. 

Note
The error number in the message points to the part of the code that requires more 
memory than is available.

(Continued on next page)

IF you want to... THEN click...

Retain the list of completed jobs Yes.

Delete the list of completed tasks No.
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The The compiler corrected placement of the misplaced symbol <expression>. 
Please recheck the mapping instruction.
Message Type: Warning
Program Module: Compiler

Explanation:
Gentran:Server found the identified symbol in an invalid position and moved it to a 
valid position. However, the new position may not meet your needs.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Check the map and locate the symbol.

2 Review the modified mapping instruction.

3 Use this table to determine your next action.

If the symbol is positioned... THEN...

As you intended No further action is required. 

Not as you intended Move it and recompile the map.
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The The compiler detected a circular reference in the instruction <mapping in-
struction> for group <GROUP name>. Compilation Stopped.

Message Type: Error
Program Module: Compiler

Explanation:
Gentran:Server is unable to evaluate a mapping instruction that refers to itself. 
This mapping instruction contains a macro that refers back to the originating 
instruction or that references another macro that refers back to the originating 
instruction. 

Procedure:
Use this procedure in response to this message:

The The compiler detected a misplaced <expression>. It was ignored.

Message Type: Warning
Program Module: Compiler

Explanation:
The compiler found a mapping instruction with an argument or data item that is 
invalid in its current position. Gentran:Server ignored the argument or data item.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Look at the map and find the identified mapping GROUP and the 
identified mapping instruction for that GROUP.

2 Check the macros used in the mapping instruction for a macro that 
references another macro that refers back to the originating 
instruction.

3 Correct the circular reference, and then recompile the map.

Step Action

1 Check the map to find the misplaced argument or data item. 

2 Correct or remove the misplaced argument or data item and 
recompile the map before using it again.
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The The destination elements <element names> have multiple mappings of vary-
ing nature. This, together with retain being set for them, would result in in-
consistent mapping/translation. The map is not successfully compiled.

Message Type: Error
Program Module: Compiler

Explanation:
The Retain Field Value option is set for destination elements to which multiple 
source items are mapped. This option sets the default value Gentran:Server uses 
for the destination field. If there are multiple sources mapped, Gentran:Server is 
unable to consistently apply the same default value. Any translation resulting from 
the use of this map may be inaccurate. To prevent the inaccurate translation of 
data, Gentran:Server will not compile the map.

Procedure:
To correct this error, you must modify the map such that the Retain Field Value 
option is set for a destination element to which only a single source item is 
mapped. 

The The last or only subelement of a composite element cannot be individually 
deleted. Delete the composite element instead.

Message Type: Error
Program Module: Standard/IG Editor

Explanation:
The selected item is either the last or only subelement of a composite element. 
The Delete Marked option is not available if the composite element has only one 
subelement or will have none after this action. 

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF you want to... THEN you must...

Delete the subelement Delete the composite element.

Delete the subelement but retain the 
composite element 

Add a new subelement before deleting 
the one currently selected.
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The The mapping instruction <mapping instruction> might result in data which 
will not match the data type of <destination element>.

Message Type: Warning
Program Module: Compiler

Explanation:
The selected source value may have a different data type than the selected 
destination item. This may cause expected when used in a translation.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Cancel this mapping instruction and close the Mapping 
Instructions window.

2 Click on the destination side of the map to make it active. 

3 Click the Standard/IG Editor (or Application Editor) toolbar 
button. 

4 With the editor open, determine the data type of the destination 
item identified in the message.

5 Change the data type to match that of the source item if necessary. 

6 Save and close the implementation guide or application 
description.

7 Create the mapping instruction again. 

Comment
It is safer to map source items only to destination values that have 
the same data type.
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The The mapping instruction you are deleting or modifying is referenced in other 
locations. Are you sure you want to proceed?

Message Type: Warning
Program Module: Compiler

Explanation:
The selected macros is used in multiple mapping instructions. Deleting the macro 
will invalidate all mapping instructions in which it is used. Gentran:Server is 
prompting you to confirm the deletion request.

Procedure:
Use one of these responses if you receive this message 

(Continued on next page)

IF you want to... THEN click...

Delete the macro and invalidate all mapping instructions in 
which it is used

Yes.

Cancel the deletion request No.
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The The mapping instructions for this GROUP were edited in expert mode, and 
so this session will temporarily be set to expert mode

Message Type: Informational
Program Module: Visual Mapper (Mapping Instructions)

Explanation:
Mapping instructions for a GROUP can be edited only in the mode in which they 
were originally were created or edited. 

The mapping instructions for the selected GROUP is created or in expert mode. 
Gentran:Server will automatically set the Visual Mapper to the mode necessary to 
allow the edit to continue.

Procedure:
No action required; session is temporarily set to expert mode.

Use this procedure to change the mapping instructions for this mapping GROUP 
from expert mode to standard mode.

(Continued on next page)

Step Action

1 Delete all mapping instructions from this GROUP.

Note
When the Mapping Instructions window closes, Gentran:Server will 
automatically delete the GROUP. 

2 Click User Setup on the Settings menu to open the User Setup 
dialog box 

3 Uncheck the Expert Mode check box

4 Select OK.

5 Recreate the mapping GROUP and create the mapping 
instructions in standard mode.
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The The name entered is too long, synonym file name is limited to 19 letters.

Message Type: Error
Program Module: Compiler

Explanation:
Synonym file list names can be a maximum of 19 characters in length. The list 
name entered contains more than 19 characters.

Procedure:
Enter synonym file list name that is from 1 to 19 characters in length.

The The sub-elements (or components) of a composite element cannot be indi-
vidually cut; cut the composite element instead.

Message Type: Error
Program Module: Standard/IG Editor

Explanation:
The Cut Marked option is active only when an entire composite element is 
selected. Currently only a single sub-element is selected. 

Procedure:
Use one of these responses if you receive this message

(Continued on next page)

IF you want to... THEN...

Cut all sub-elements in this composite 
element

1. Mark only the composite element

2. Click Cut Marked on the Edit 
menu.

Retain at least one of the sub-
elements in this composite element

No action is needed.
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The The value you entered is not numeric. Please enter a number.

Message Type: Error
Program Module: Compiler

Explanation:
The compiler requires a positive whole number (1, 2, 3, 4) in this field. The value 
entered is a real number, an alphabetic character(s), or a symbol(s).

Procedure:
Enter a positive whole number in the selected field.

There There are more fields in your test data segment <segment name> than exist 
in the standard segment <segment name>. Ignoring extra fields.

Message Type: Warning
Program Module: Standard/IG Editor (AutoTrim)

Explanation:
The AutoTrim facility found fields in the sample EDI data that do not exist in the 
standard. AutoTrim will ignore the extra fields. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Determine whether the document version you are using is correct.

2 Use this table to determine your next action.

IF the document version 
is... THEN...

Not correct Run AutoTrim again with the correct 
document version.

Correct Map the information in the extra fields 
to elements in different segments if 
you want AutoTrim to map them.
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There There are no more mapping instructions in this group that can be deleted. If 
you would like to remove any reference to this mapping, please delete the 
group <group> itself.

Message Type: Warning
Program Module: Compiler

Explanation:
The currently selected mapping GROUP contains no mapping instructions. 
Gentran:Server will delete the currently selected GROUP unless you add 
instructions before exiting the Mapping Instructions window. 

Procedure:
To eliminate this warning, you must add mapping instructions to the GROUP.

Note

You can delete the GROUP by clicking Done on the Mapping Instructions window 
and responding Yes to the prompt that Gentran:Server then displays.

There There is a circular reference in macro <macro> to itself.

Message Type: Error
Program Module: Compiler

Explanation:
The identified macro references itself or another macro by which it is referenced. 
The compiler is unable to evaluate the macro because of this circular reference.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Look at the map and find the identified macro.

2 Correct the circular reference.

3 Compile the map again.
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This This action will delete the entire mapping instruction. Proceed?

Message Type: Warning
Program Module: Visual Mapper

Explanation:
Gentran:Server is prompting you to confirm your decision to delete the entire 
mapping instruction.

Procedure:
Use one of these responses if you receive this message.

This This group <GROUP name> contains no mapping instructions, it will be de-
leted if you exit the Mapping Instructions screen now, continue?

Message Type: Warning
Program Module: Visual Mapper

Explanation:
The currently selected GROUP is empty and will be deleted when you exit the 
Mapping Instruction window. Gentran:Server is prompting you to confirm your 
request to exit the Mapping Instruction screen and delete the identified GROUP.

Procedure:
Use one of these responses if you receive this message.

(Continued on next page)

IF you want to... THEN...

Delete the entire mapping instruction Click Yes. 

Retain the entire mapping instruction Click No.

Want to delete only part of a condition, 
mapping, or macro

Double-click on the condition, 
mapping, or macro to delete it. 

IF you want to... THEN click...

Delete this GROUP Yes

Save this GROUP No.

Note
You must add one or more mapping instructions to 
this GROUP in order to save it.
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This This is a redundant mapping. All of the mapped elements are contained in 
mapping group <GROUP name>.

Message Type: Error
Program Module: Visual Mapper

Explanation:
The Visual Mapper is unable to accept a new mapping GROUP that is an exact 
copy of another GROUP. The new GROUP you are trying to add is an exact 
duplicate of one listed under another GROUP name.

Procedure:
Use one of these responses if you receive this message

(Continued on next page)

IF you want to... THEN...

Create a new mapping instruction for 
the selected GROUP

1. Select an item in the GROUP

2. Click the MI button on the toolbar.

3. Create the new mapping 
instructions.

Add or delete an item from the 
GROUP

1. Select an item in the GROUP

2. Click View Mapped Items.

3. Select the GROUP and click Add/
Delete Item to/from GROUP on the 
Map Items menu.
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This This type of mapping requires a source item within a condition. This mapping 
will not be written to the compiled map.

Message Type: Error
Program Module: Visual Mapper

Explanation:
Gentran:Server is able to map system variables or a function of a system variable 
to a destination only if the mapping instruction contains a source item or a 
condition that references a source item.

Procedure:

Use this procedure in response to this message:

This This version does not support dates beyond the year 2036.

Message Type: Information
Program Module: lftran

Explanation:
The system displays this message when the date entered is greater or equal to 
2036. This version of the software is unable to manipulate dates occurring during 
or after the year specified.

(Continued on next page)

Step Action

1 Add the desired source item to the mapping GROUP 

2 Open the Mapping Instructions window and display the mapping 
instruction that lacks a source.

3 Edit the mapping instruction to add a condition that refers to the 
source item. 

Note
When determining the type of condition to add, consider when you 
want Gentran:Server to execute this mapping instruction.
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Trading Trading Partnership File records are of the wrong format. Perhaps you did 
not run a TP file conversion.

Message Type: Error
Program Module: tpadmin

Explanation:
You tried to access Trading Partner records created with a version of 
Gentran:Server prior to 5.2 or Gentran:Mentor prior to 1.7. The structure of 
Trading Partner records changed in Gentran:Server 5.2/Mentor 1.7. The version 
5.2 tpadmin runs only on Trading Partner records converted with tp_cvrt or 
created with Gentran:Server 5.2 or Gentran:Mentor 1.7. 

Procedure:
Run tp_cvrt before you try to access the Trading Partner records. 

Reference
See the Gentran:Server for UNIX and Workstation Upgrade and Data Conversion 
Guide for information about tp_cvrt.

Unable Unable to access File: <file name> for writing

Message Type: Error
Program Module: Visual Mapper

Explanation:
The Visual Mapper was unable to write the indicated file. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Check the amount of available disk space left on the disk to which 
Gentran:Server is trying to write the file. Provide additional disk 
space if necessary.

2 Check the permissions of the file and the directory containing map 
files. Change the permissions as necessary.
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Unable Unable to access source file: <file name>

Message Type: Error
Program Module: Main Window (Translate)

Explanation:
Gentran:Server cannot access the source file selected for this translation. 

Procedure:
Use this procedure in response to this message:

Unable Unable to get a new AbcDisamFile instance

Message Type: Error
Program Module: Visual Mapper

Explanation:
This message appears when there is an internal error in Gentran:Server.

Procedure:
Call Gentran:Server Customer Support. Give them the complete text of this 
message and tell them what version of Gentran:Server you are running.

(Continued on next page)

Step Action

1 Use File Manager to determine whether the file and directory exist, 
whether the file is stored in the directory specified, and whether the 
file is empty.

2 Use this table to determine your next action.

IF the... THEN...

Directory does not exist Create it. 

Directory exists but the file does 
not

Create the file and move it to the 
correct directory or specify 
another file as the source for this 
translation.

File exists and is in the proper 
directory

1. Check the read permissions 
on the file and directory. 

2. Change the permissions of 
the file or directory.
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Unable Unable to open/create automapping thesaurus files

Unable to open/create generic synonym files

Message Type: Error
Program Module: Thesaurus/Synonym Editor

Explanation:
The Thesaurus/Synonym Editor was unable to find, open, or create the thesaurus 
file specified or generic synonym (generic.dat/idx) file. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 View the Setup Directories dialog box and identify the directory in 
which you are storing Map Files. This directory also stores 
thesaurus and synonym files.

2 Use the File Manager to determine whether the specified directory 
exists and whether it contains the file.

3 Use this table to determine your next action.

IF the... THEN...

Map directory does not exist Create it and move the file into 
it. 

Map directory exists, but the file 
does not 

Check the write permissions on 
the directory and create the file. 

File exists and is in the correct 
directory

Check the read permissions on 
the file and directory, changing 
them if necessary.
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Unable Unable to open file <file name>

Message Type: Error
Program Module: Various

Explanation:
Gentran:Server cannot open the file specified. 

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 View the Setup Directories dialog box and determine where the 
file should be stored. 

2 Use File Manager to determine whether the file exists and its 
location.

3 Use this table to determine your next action.

IF the file... THEN...

Does not exist Create or copy it.

Exists, but the directory does 
not

Create the directory and move 
the file into it. 

And the directory exist, but the 
file is not in the correct directory 

Move the file.

Has the correct name and is in 
the correct directory

Check the permissions and 
change them if necessary.
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Unable Unable to open 'mentor.vrf'. Make sure this file is in the defined Screen Lib 
directory.
Message Type: Error
Program Module: Various

Explanation:
Gentran:Server is unable to open one of the files necessary to display some 
screens. This message usually displays only when opening Gentran:Server.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Use the File Manager to view the directory containing 
Gentran:Server screen files.

2 Move the mentor.vrf file to that directory. 

Note
If you are unable to find the file, reinstall Gentran:Server as an 
upgrade and load only programs.

3 IF the file... THEN...

Does not exist Create it.

Exists, but the correct directory 
does not

Create the directory and move 
the file into it. 

And the directory exist, but the 
file is not in the correct directory 

Move the file.

Has the correct name and is in 
the correct directory

Check the permissions and 
change them if necessary.
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Unable Unable to write file: <file name>

Message Type: Error
Program Module: Application Editor

Explanation:
The Application Editor was unable to write the indicated file. 

Procedure:
Use this procedure in response to this message:

WARNING WARNING: <expression> is of type <argument type>, this is not a valid argu-
ment type for the operation <operation>.

Message Type: Warning
Program Module: Compiler

Explanation:
The argument entered is invalid for this operation. The compiler will accept an 
operation with invalid argument types, but may provide unexpected results.

Procedure:
Change the mapping instruction to include only arguments with correct data types. 

Reference
See the chapter Mapping in the Gentran:Server for UNIX and Workstation 
Mapping and Translation Guide for information about valid arguments for this 
operation and valid data types for each argument.

(Continued on next page)

Step Action

1 Gentran:Server was trying to write the file. Provide more disk space 
if necessary.

2 Check the permissions of the file and the directory containing it. 
Change the permissions if necessary.
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WARNING WARNING: Incompatible type: <expression> is a <data type>, a <data type> 
is required.

Message Type: Warning
Program Module: Compiler

Explanation:
Change the mapping instruction to use a valid data type for the specified item or 
expression in this context.

Reference
See the chapter Mapping in the Gentran:Server for UNIX and Workstation 
Mapping and Translation Guide for information about valid arguments for this 
operation and valid data types for each argument.

WARNING WARNING: Mapping expression <mapping instruction> has not been cor-
rected in the editor, it will not be compiled.

Message Type: Warning
Program Module: Compiler

Explanation:
The compiler found an invalid mapping instruction. Gentran:Server will ignore the 
mapping instruction and excluding it from the compiled version of the map. Using 
this map in a translation may cause unexpected results.

Procedure:
Use this procedure in response to this message:

(Continued on next page)

Step Action

1 Look at the map and locate the mapping instruction identified in the 
message.

2 Correct or delete the mapping instruction and compile the map 
again.
Maintenance and Troubleshooting Guide – August 2004



Messages in Alphabetical Order (Not Starting with Variables) System Messages2 - 162
WARNING WARNING: Mapping instruction <mapping instruction> results in data which 
does not match the data type <data type> of its destination element <desti-
nation element>.

Message Type: Warning
Program Module: Compiler

Explanation:
The source value you are mapping to this destination item has a different data 
type than the destination item. Only some data items (for example, AN and ID) are 
interchangeable. This may cause unexpected results when the map is used for 
translation. It is safer to map source values to destination items that have the 
same data type.

Procedure:
Use this procedure in response to this message:

WARNING WARNING: The number entered is too large.
Message Type: Error
Program Module: Compiler

Explanation:
The number entered exceeds the maximum value of this field. 

Procedure:
Check online help and/or the documentation to find the maximum limit of this 
value and then enter another number into this field.

(Continued on next page)

Step Action

1 Cancel this mapping instruction and close the Mapping 
Instructions window.

2 Click the destination side of the map.

3 Check the data type of the destination item specified and change it 
in the Application or Standard/IG Editor if necessary.

4 Save and close the application or implementation guide.

5 Create the mapping instruction again. 
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WARNINGS/
ERRORS

WARNINGS/ERRORS occurred in the <location of error> while working on: 
<mapping instruction>
WARNINGS/ERRORS occurred in the <location of error> while working on 
<mapping instruction> in group <GROUP name> which contains elements 
<element>:
Message Type: Warning and/or error
Program Module: Compiler

Explanation:
The compiler found one or more unspecified errors or conditions that could cause 
problems.

Procedure:
Use this procedure in response to this message:

Would Would you like to save the changes made in <file name>?

Message Type: Prompt
Program Module: Application and Standard/IG Editors and Visual Mapper

Explanation:
Gentran:Server is prompting you to save the changes made in the currently open 
file. 

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

Step Action

1 Check the part of the map indicated.

2 Check the identified mapping instruction.

3  Make any corrections necessary and compile the map again.

IF you want to... THEN click...

Save the changes to this file during the current session Yes. 

Lose the changes made since you last saved No.
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You You are about to delete the last mapping instruction from this group. Pro-
ceed?

Message Type: Warning
Program Module: Compiler

Explanation:
If you delete the last mapping instruction from a mapping GROUP, 
Gentran:Server automatically deletes the GROUP when you exit the Mapping 
Instructions window. 

Procedure:
Use one of these responses if you receive this message:

 You You have already accessed all the mapping instructions for this group. Do 
you want to add a new one?

Message Type: Informational
Program Module: Compiler

Explanation:
Gentran:Server prompts you to create a new mapping instruction in the following 
situations:

◗ You click the Previous button on the Mapping Instructions window while 
viewing the first mapping Instruction in a GROUP.

◗ You click the Next button on the Mapping Instructions window while viewing 
the last mapping instruction in a GROUP.

Procedure:
Use one of these responses if you receive this message:

(Continued on next page)

IF you want to... THEN click...

Retain the mapping instruction Yes. 

Delete the mapping instruction and the GROUP No.

IF you... THEN enter...

Want to add a new mapping instruction Yes

Do not want to add a new mapping instruction No
Maintenance and Troubleshooting Guide – August 2004



System Messages Messages in Alphabetical Order (Not Starting with Variables) 2 - 165
You You must change to view all mode to <delete/discard/cut> the current item, 
change to view all mode now?

Message Type: Informational
Program Module: Standard/IG Editor

Explanation:
The last used item in an implementation guide can be deleted, discarded, or cut 
only when in View All mode. Currently, the editor is in View Only Used Items mode 
and, if the action were allowed, would display only a blank segments and 
elements box.

Procedure:
Use one of these responses if you receive this message:

You You must save Untitled App before generating SQL. Save now?

Message Type: Prompt
Program Module: Application Editor

Explanation:
The Database/Auto Create SQL File option is available only when the currently 
displayed application has been saved. You must save a database application 
before you generate an SQL file. 

Procedure:
Use one of these responses if you receive this message:

IF you want to view... THEN click...

All items (used and discarded) and delete the marked item Yes.

Only used items but retain the marked item No.

IF you want to... THEN click...

Save the currently displayed database application before 
generating an SQL File

Yes.

Avoid saving the currently displayed application and cancel the 
generation of an SQL file

No. 

Close the message window without taking any other action Cancel.
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Gentran:Server Return Codes

atext This table lists the return codes defined for the atext command.

ediarc The system issues the default return code of zero (0) for error messages with 
numbers less than 200 if the -e parameter is not used. 

This table lists the return codes for the ediarc command.

(Continued on next page)

Return Code Definition

0 Success

1 Cannot use one file as input and output file

300 or 45* Missing or invalid arguments

Note
Some systems support return codes only up to 255 before they 
cycle back to zero.

380 or 125* Failed to open file

Note
Some systems support return codes only up to 255 before they 
cycle back to zero.

Return Code Definition

0 Success

1 A required argument was not sent to arcset

2 Failed to open a file

4 Failed to write a file

5 Failed to archive a set
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edifrmat The following table lists the return codes defined for the edifrmat command.

(Continued on next page)

Return Code Definition

0 Success

Note
Return code 0 would also be returned if edifrmat failed to run 
due to an invalid number of parameters (invocation screen) or if 
it could not find the file msgrecs.vda (necessary for VDA 
standard); See error message 180 for more information

1 Interchange has no trailer; See error message 379 for more 
information

2 Invalid data; See the following error messages for more 
information:

1) 361 Invalid set count
2) 362 Invalid group count

3) 377 Interchange count errors

4) 377 Segment id too long

5) 378 Invalid characters in interchange

6) 387 Invalid segment id

3 Header rejected; See the following error messages for more 
information:

1) 100 Defined Terminator could not be found, or 
Separator and Terminator are the same character, or 
Separator, Sub-separator or Terminator is invalid

2) 200 Encountered segment too long to process

126 No EDI header information found in input file; no header count; 
See error message 126 for more information

380 Failed to open file; See error message 380 for more 
information

382 Failed to write file; See error message 382 for more information
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envelope This table lists the return codes defined for the envelope command.

lftran This table describes the lftran return codes.

Return Code Definition

0 Success/No data to envelope

300 or 45* Failed to open file

380 or 125* Failed to read file

Note
Some systems support return codes only up to 255 before they 
cycle back to zero.

382 or 127* Failed to write file

Note
Some systems support return codes only up to 255 before they 
cycle back to zero.

Return 
Code Meaning Symbol

1 Reached the end of the file 
unexpectedly

FILEEND

2 Error in invocation of translation ARGERR

3 Unable to load translation table 
(compiled map/translation object)

TBLERR

4 Unable to open a file OPNERR

5 Could not read, write, or update 
Trading Partnership record

TPERR

6 Application file is not formatted as 
expected. Could be corrupt.

APPFMTERR

7 Could not find Trading Partnership 
Code in the application file

APPTPERR

8 Ran out of memory ALLOC_FAIL

(Continued on next page)
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udfsort The following table lists the return codes defined for the udfsort command.

9 Call to database failed DBERR

10 The version of the translator does not 
match the product version

VERSION

12 Error occurred during compliance 
checking

CMPCHKERR

13 Failed to load the ID code file into 
memory

IDCODEERR

14 Error in application data APPDATAERR

15 Error parsing NCPDP file RECIDERR

16 Input file is not new-line terminated NO_NEWLINE

17 Could not read, write, or update 
organization records

ORGERR

20 Incoming set sequence number not as 
expected

SEQUENCE_ERROR

25 Error parsing the XML file XMLFILEERR

26 Translation error. See the dtlLog.err file 
for explanation.

COMMON_LIB_ERROR

50 Duplicate sets found DUPLICATE_SET

80 Unable to determine the type of the 
input record

UNDEF_REC_TYPE

 (Contd)
Return 
Code Meaning Symbol

Return Code Definition

0 Success

-1 Missing or invalid arguments

No data in input file
(Continued on next page)
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Failed to allocate memory

Error writing file

-380 or -125* Failed to open file

Note
Some systems support return codes only up to 255 before they 
cycle back to zero.

 (Contd)
Return Code Definition
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UNIX Error Codes
1 Not super-user

2 No such file or directory

3 No such process

4 Interrupted system call

5 I/O error

6 No such device or address

7 Arg list too long

8 Exec format error

9 Bad file number

10 No children

11 No more processes

12 Not enough core

13 Permission denied

14 Bad address

15 Block device required

16 Mount device busy

17 File exists

18 Cross-device link

19 No such device

20 Not a directory

21 Is a directory

22 Invalid argument

23 File table overflow

24 Too many open files

25 Not a typewriter

26 Text file busy

27 File too large

28 No space left on device

29 Illegal seek

30 Read only file system

31 Too many links

32 Broken pipe

(Continued on next page)
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33 Math arg out of domain of func

34 Math result not representable

35 No message of desired type

36 Identifier removed

37 Channel number out of range

38 Level 2 not synchronized

39 Level 3 halted

40 Level 3 reset

41 Link number out of range

42 Protocol driver not attached

43 No CSI structure available

44 Level 2 halted

45 Deadlock condition

46 No record locks available

50 Invalid exchange

51 Invalid request descriptor

52 Exchange full

53 No anode

54 Invalid request code

55 Invalid slot

56 File locking deadlock error

57 Bad font file fmt

60 Device not a stream

61 No data (for no delay i/o)

62 Timer expired

63 Out of streams resources

64 Machine not on the network

65 Package not installed

66 The object is remote

67 The link has been severed

68 Advertise error

69 Srmount error

70 Communication error on send

71 Protocol error

(Continued on next page)
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74 Multihop attempted

76 Cross mount point (not really error)

77 Trying to read unreadable message

78 Path or path component exceeds limit

80 Given .log name not unique

81 f.d. invalid for this operation

82 Remote address changed

83 Can’t access a needed shared lib.

84 Accessing a corrupted shared lib.

85 .lib section in a.out corrupted

86 Attempting to link in too many libs.

87 Attempting to exec a shared library

135 Structure needs cleaning

137 Not a name file

138 Not available

139 Is a name file

140 Remote I/O error

141 Reserved for future

142 Error 142
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DISAM Error Codes
UNIX System errors usually are 1 through 99. See your UNIX system 
documentation for additional information about these errors.

#define EDUPL 100 /*duplicate record*/

#define ENOTOPEN 101 /*file not open*/

#define EBADARG 102 /*invalid argument*/

#define EBADKEY 103 /*invalid key description*/

#define ETOOMANY 104 /*out of file descriptors*/

#define EBADFILE 105 /*invalid isam file format*/

#define ENOTEXCL 106 /*exclusive lock required*/

#define ELOCKED 107 /*record claimed by another*/

#define EKEXISTS 108 /*key already exists*/

#define EPRIMKEY 109 /*primary key may not be used*/

#define EENDFILE 110 /*beginning or end of the file reached*/

#define ENOREC 111 /*no match was found*/

#define ENOCURR 112 /*there is no “current” established*/

#define EFLOCKED 113 /*entire file locked by another*/

#define EFNAME 114 /*file name too long*/

#define ENOLOK 115 /*cannot create lock file*/

#define EBADMEM 116 /*memory allocation request failed*/

#define EBADCOLL 117 /*bad custom collating*/

#define EUSER 129 /*too many users*/

#define EVIRTUAL 140 /*unable to reopen virtual file */
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Overview 0

Introduction

In this chapter This chapter contains an overview of the process of moving files from a source 
environment to a destination environment. To move files successfully, follow the 
recommended approach described in this chapter.

Key terms This table lists the key terms used in this chapter.

Term Description

destination 
environment

The area to which you are moving files. 

Example
Your production environment, where Gentran:Server 
processes your live data, is the destination when 
moving files from your test area.

load The process of converting a .unl file (ASCII file) back to 
an ISAM file format with a utility designed for this 
purpose.

source environment The area in your computer from which you are moving 
files.

Example
Your test environment, where you test software 
upgrades, run data conversion programs, or test new 
maps, Trading Partnership records, and other 
Gentran:Server components, is the source when 
moving files to your production environment.

unload The process of converting an ISAM file to an ASCII file 
with a utility designed for this purpose.
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The Source-to-Destination Process

Introduction This section provides critical information about difficulties you may encounter 
when moving files and suggests procedures for avoiding those difficulties. This 
section also provides a diagram and procedure that describe the process of 
moving files from a source environment to a destination environment.

When and why to
move files

You may find it necessary to move files from one environment to another in the 
following situations:

◗ Map files created in a test environment are ready for use in production.
◗ You want to use the map files from one installation in another.
◗ You are upgrading to a new Standards version.

Difficulties with
moving entire
directory tree

WARNING
You may encounter serious difficulties if you attempt to copy the 
entire source area directory tree (executable and data files) to the 
destination area. 

When you copy an entire directory tree to a new location, the copying process 
breaks links among linked files. If you have the Gentran:Server for UNIX with EC 
Workbench product (or higher), the translation data manager’s run directory is at 
risk. If the links in that directory are broken, the translation data manager is unable 
to start.

Recommended
approach

You should build your destination area first and then move data files from the 
source area, rather than attempting to copy the entire source area to the 
destination area.

Move all data files at once

If you are moving data files to another machine, you can unload all the data files 
you need to move onto media, such as a tape, and then load them to the new 
machine from media. You do not have to move each data file separately. 

Caution
You must use the procedures described in this guide to unload and load each type 
of data file. Using other methods to load or unload files could corrupt your data.

(Continued on next page)
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Moving ISAM
files

Files in Indexed Sequential Access Method (ISAM) format require special 
handling. Gentran:Server provides special utilities to move these files.

Reference
See the section Moving ISAM files in this guide for more information about this 
process. 

Process flow
diagram

This illustration shows the process flow for moving files from a source 
environment to a destination environment.

(Continued on next page)

1
Plan the move

2
Install and set up
the destination
environment

3
Set up the source

environment

4
Verify that directory
structures are the

same in both
environments

5
Prepare for the move

6
Move the files

7
Perform clean-up tasks
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Source-to-
destination task

summary

This table describes the stages in the source-to-destination process.

Stage Description

1 Plan the move.

Reference
See the chapter Planning the Move in this guide.

2 Install and set up the destination environment.

Reference
See the Gentran:Server for UNIX Getting Started Guide and 
Installation Checklists for more information about the process of 
installing and setting up an environment.

3 Prepare the source environment.

Reference
See the topic Preparing the Source Environment in the chapter 
Preparing to Move Files for more information about this process.

4 Verify that the directory structures of the source and destination 
environments are the same.

Warning
Differences between your source and destination directory 
structures can affect Gentran:Server’s ability to find the files it 
needs to process data.

Reference
See the the chapter Planning the Move for more information about 
this process.

5 Prepare for the move.

Reference
See the chapter Planning the Move in this guide.

6 Move the files.

Reference
See the chapter Moving Files in this guide.

7 Perform clean-up tasks.

Reference
See the chapter Cleaning Up After the Move in this guide.
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Introduction

In this chapter This chapter explains how to plan the movement of files from a source to a 
destination environments.

Key terms This table lists the key terms used in this chapter.

Term Description

destination 
environment

The area on a computer to which you are moving the 
files.

source environment The area on a computer from which you are moving 
your files. 

unload The process of converting an ISAM file to an ASCII file 
with a utility designed for this purpose.
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The Planning Process

Introduction Planning before you move files from a source environment to a destination 
environment helps ensure that you:

◗ Move all necessary files
◗ Avoid file permission problems
◗ Do not mistakenly overwrite files
◗ Avoid processing conflicts.

Process diagram This illustration shows the tasks in the planning process.

(Continued on next page)
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Task summary This table describes the tasks in the planning process.

Task Description

1 Describe your source and destination environments.

Reference
See Describing the Source and Destination Environments in this 
chapter.

2 Identify the files you need to move.

Reference
See the section How to Identify the Files to Move in this chapter.

3 Select a time to move the files.

Reference
See the section How to Select a Time to Move Files in this chapter.
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Describing the Source and 
Destination Environments0

Overview

Introduction This section provides the basic process for describing the source and destination 
environments involved in the file movement process.

Importance The structure of your source and destination environments determines the steps 
you perform to move files from a source to a destination. 

Questions to
answer

Answer this list of questions to describe your source and destination 
environments.

◗ Have you created both your source area and your destination area for 
Gentran:Server?

◗ How is your Gentran:Server system structured?
In other words, do you have one source environment and one destination 
environment? Or, do you have a source area and destination area, each of 
which has two or more environments?

◗ Is the destination environment on the same machine as the source 
environment, or is it on a different machine?

◗ Is the directory structure of the destination environment an exact duplicate of 
the source environment?

If not, what are the differences?

(Continued on next page)
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Environment
examples

These examples represent four types of environments. Your environment may 
reflect all or some of the characteristics found in each of these examples

Example: PC to
PC

Your source data is on one PC and your destination data is on another PC. The 
directory names are identical on both machines. The PCs are not linked for file 
transfers.

Example: PC to
UNIX

You develop and test your maps on a PC and then transfer them to a UNIX host. 
On the UNIX host, you have a destination area with two environments: one for 
purchase orders (POPROD) and the other for invoices (INVPROD).

Note
This example applies only to clients who use Gentran:Server Workstation and one 
additional Gentran:Server product. 
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Choosing a File Transfer 
Method 0

Transfer Types, Methods, and File Types

Basis for method
of moving file

The way in which you move a file depends on the following:

◗ Type of transfer
◗ Type of file
◗ Transfer method.

Types of
transfers

These are the types of file transfers:

◗ PC to linked UNIX host
◗ PC to unlinked UNIX host
◗ PC to linked PC
◗ PC to unlinked PC

Types of files These are the types of moveable files:

◗ ASCII
◗ Converted indexed
◗ Binary

(Continued on next page)
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Gentran:Server
file types

This table indicates the file types of the main Gentran:Server files.

File Type File Name ASCII Indexed Binary

Uncompiled Application 
Integration map (binary)

<mapname>.map X

Compiled Application 
Integration map 

<mapname>.tpl X

File definition (Application 
Integration)

<filename>.ddf X

Trading Partnership record tp.dat and tp.idx

tpmisc.dat and 
tpmisc.idx

X

Tradacom supplementary 
record

tradacom.dat and 
tradacom.idx

X

Organization record org.dat and 
org.idx

X

Contact record contact.dat and 
contact.idx

X

Category records cattype.dat X

catvalue.dat and 
catvalue.idx

X

Reconciliation ID records tprecon.dat and 
tprecon.idx

X

EDI document specifier 
mapping files

ds_map.dat and 
ds_map.idx

ds_name.dat and 
ds_name.idx

ds_tptbl.dat and 
ds_tptbl.idx

X

(Continued on next page)
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(Continued on next page)

APP document specifier 
mapping files

ds_map_app.dat 
and 
ds_map_app.idx

ds_name.dat and 
ds_name.idx

ds_tptbl_app.dat 
and 
ds_tptbl_app.idx

X

Agent configuration 
records

dm.dat and 
dm.idx

X

Data managers .dmcfg.dat and 
.dmcfg.idx 

X

Translation script <filename>.<ext> X

Pattern files pat.dat and 
pat.idx

patlst.dat and 
patlst.idx.

X

Post processing script <filename>.<ext> X

Communication script <filename>.<ext> X

Standards Cross 
Reference

xtable.dat and 
xtable.idx

X

Application TP Rules apptptbl.dat and 
apptptbl.idx

X

Application TP Cross 
Reference

appxref.dat and 
appxref.idx

X

 (Contd)
File Type File Name ASCII Indexed Binary
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Visual Mapper
file types

This table indicates the file types of other Gentran:Server files you may have if 
you use the Visual Mapper.

Note
This information is for prior customers who use the Visual Mapper.

XML translation
option file types

This table indicates the file types of selected Gentran:Server files you may have if 
you have the XML translation option with your Gentran:Server product.

File Type File Name ASCII Indexed Binary

Uncompiled Visual Mapper 
map

<mapname>.vmp X

Compiled Visual Mapper 
map 

<mapname>.tbl X

Specific synonym list <listname>.dat 
<listname>.idx

X

Generic synonym list generic.dat and 
generic.idx

X

Thesaurus list thesaurus.dat and 
thesaurus.idx

X

Implementation guide <mapname>.ig X

Application description <mapname>.app X

File Type File Name ASCII Indexed Binary

First Level Element xmlspl1.dat and 
xmlspl1.idx

X

Second Level Element xmlspl2.dat and 
xmlspl2.idx

X

Third Level Element xmlspl3.dat and 
xmlspl3.idx

X

Trading Partnership Rules xmltbtpl.dat and 
xmltbtpl.idx

X

(Continued on next page)
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Transfer
methods

You can transfer files using:

◗ Copy commands, such as cp, cpio, and copy
◗ FTP operations for ASCII and Binary files (asc/bi protocols respectively)

Conversion
utilities

Before you move Indexed Sequential Access Method (ISAM) database files from 
one machine to another, you must convert the file into an ASCII file. The resulting 
file has a .unl extension. After you move the file, you must convert it back to an 
indexed file.

To convert an ISAM file into an ASCII file, you use a Gentran:Server unload 
utility.

To convert an ASCII file into an ISAM file, you use a Gentran:Server load utility.

Trading Partnership Cross 
Reference

xmlxref.dat and 
xmlxref.idx

X

XML document specifier 
mapping files

ds_map_xml.dat 
and 
ds_map_xml.idx

ds_name.dat and 
ds_name.idx

ds_tptbl_xml.dat 
and 
ds_tptbl_xml.idx

X

 (Contd)
File Type File Name ASCII Indexed Binary
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How to Choose a File Transfer Method

Introduction The method you use to transfer a file depends on the type of transfer and the type 
of file.

Decision table Use this table to choose a file transfer method.

IF the type of transfer 
is…

AND the file type 
is… THEN…

One environment to 
another on same host or 
PC

ASCII or binary Use the copy file command.

Indexed (ISAM) Use the copy file command.

PC or UNIX host to 
connected UNIX host 
(running same operating 
system)

ASCII Use the FTP command for 
ASCII files.

Binary Use the FTP command for 
binary files.

Indexed (ISAM) 1.Unload the file.

2.FTP (ASCII) the file to the 
destination.

3.Load the file at the 
destination.

PC or UNIX host to 
unconnected UNIX host

ASCII or binary 1.Copy the file to tape or other 
media.

2.Copy the file to the new 
host.

Indexed (ISAM) 1.Unload the file.

2.Copy the file to tape or other 
media.

3.Copy the file to the new host

4.Load the file at the 
destination.
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How to Identify the Files to Move

Introduction When you create and test a file, such as a map or a new Trading Partnership, you 
often create a number of related files. When you move the new file to your 
destination area, you must also identify and move the related files that affect 
processing.

Decision table
for new maps

Use this table to decide which map-related files you need to move in addition to 
moving the new map.

(Continued on next page)

IF the map is for… THEN move the…

Outbound processing Data definition (.ddf) file used for the compiled 
Application Integration map (.TPL) file.

Application description (.app) file used for the 
compiled Visual Mapper mapping table (.TBL) 
file.

A Visual Mapper map that is 
linked to a synonym list

Generic or specific synonym list:

◗ generic.dat and generic.idx
◗ <mapname>.dat and <mapname>.idx

A new Trading Partnership Trading Partnership records:

◗ tp.dat and tp.idx
◗ tpmisc.dat and tpmisc.idx
◗ org.dat and org.idx
◗ xtable.dat and xtable.idx

An application that uses the 
Trading Partnership Rule 
Definition feature

◗ apptptbl.dat and apptptbl.idx
◗ appxref.dat and appxref.idx

XML processing

Note
Available only if you have the 
XML translation option.

◗ xmlspl1.dat and xmlspl1.idx
◗ xmlspl2.dat and xmlspl2.idx
◗ xmlspl3.dat and xmlspl3.idx
◗ xmltbtpl.dat and xmltbtpl.idx
◗ xmlxref.dat and xmlxref.idx
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Decision table
for Trading

Partnerships

Use this table to decide which Trading Partnership and Trading Partnership-
related files you need to move to the destination area.

Note
If you have DOS batch files used in your Gentran:Server installation, you may 
need to move them as well.

IF the Trading Partnership… THEN move the…

Is new Trading Partnership records:

◗ tp.dat and tp.idx
◗ tpmisc.dat and tpmisc.idx
◗ org.dat and org.idx

Is part of a new category Category files:

◗ cattype.dat
◗ catvalue.dat and catvalue.idx

Has a new contact list record Contact files: contact.dat and contact.idx

Is new and uses reconciliation IDs 
for inbound acknowledgments

Trading Partnership reconciliation ID files:

◗ tprecon.dat and tprecon.idx

Code is used in a cross reference 
table

Appropriate table: 

◗ xtable.dat and xtable.idx
◗ appxref.dat and appxref.idx
◗ xmlxref.dat and xmlxref.idx.

Is for an XML trading partner

Note
Available only if you have the XML 
translation option.

XML-related files:

◗ xmlsp1.dat and xmlsp1.idx
◗ xmlsp2.dat and xmlsp2.idx
◗ xmlsp3.dat and xmlsp1.idx
◗ xmltptbl.dat and xmltptbl.idx
◗ xmlxref.dat and xmlxref.idx
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File Checklist

When to use Use the checklist in this topic when you need a quick reference to remind you of 
the files you need to include in a source-to-destination move.

We suggest that you make a copy of the list so that you can use it each time you 
move files.

Checklist Use this list to check off and record the names of the files you need to move.

File Type File Name

Application Integration 
Map

__________________________.map

__________________________.TPL

Visual Mapper Map __________________________.vmp

__________________________.TBL

Data definition file __________________________.ddf

Application Description __________________________.app

Implementation Guide __________________________.ig

Specific synonym list <mapname>.dat and <mapname>.idx

Generic synonym list generic.dat and generic.idx

Thesaurus list thesaurus.dat and thesaurus.idx

Trading Partnership 
records

tp.dat and tp.idx

tpmisc.dat and tpmisc.idx

TRADACOMS 
supplementary Trading 
Partnership records

tradacom.dat and tradacom.idx

Category records cattype.dat 

catvalue.dat and catvalue.idx

Reconciliation ID records tprecon.dat and tprecon.idx
(Continued on next page)
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Trading Partnership 
Contact records

contact.dat and contact.idx

Trading Partnership 
Organization records

org.dat and org.idx

EDI document specifier 
mapping files

ds_map.dat and ds_map.idx

ds_name.dat and ds_name.idx

ds_tptbl.dat and ds_tptbl.idx

APP document specifier 
mapping files

ds_map_app.dat and ds_map_app.idx

ds_name.dat and ds_name.idx

ds_tptbl_app.dat and ds_tptbl_app.idx

Agent configuration 
records

dm.dat and dm.idx

Data managers .dmcfg.dat and .dmcfg.idx 

Note
In most cases, you modify this file in 
the destination environment rather 
than unloading the file.

Translation script _________________________xltr.scr

Patterns pat.dat and pat.idx

patlst.dat and patlst.idx.

Post processing script ___________________________.scr

Communication script ___________________________.scr

Custom shell scripts ___________________________.sh

DOS batch files ___________________________.bat

LOCKS files LOCKS/_______________________

Standards cross 
reference files

xtable.dat and xtable.idx
(Continued on next page)

 (Contd)
File Type File Name
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Trading Partnership 
Contact records

contact.dat and contact.idx

Trading Partnership 
Organization records

org.dat and org.idx

EDI document specifier 
mapping files

ds_map.dat and ds_map.idx

ds_name.dat and ds_name.idx

ds_tptbl.dat and ds_tptbl.idx

APP document specifier 
mapping files

ds_map_app.dat and ds_map_app.idx

ds_name.dat and ds_name.idx

ds_tptbl_app.dat and ds_tptbl_app.idx

Agent configuration 
records

dm.dat and dm.idx

Data managers .dmcfg.dat and .dmcfg.idx 

Note
In most cases, you modify this file in 
the destination environment rather 
than unloading the file.

Translation script _________________________xltr.scr

Patterns pat.dat and pat.idx

patlst.dat and patlst.idx.

Post processing script ___________________________.scr

Communication script ___________________________.scr

Custom shell scripts ___________________________.sh

DOS batch files ___________________________.bat

LOCKS files LOCKS/_______________________

Standards cross 
reference files

xtable.dat and xtable.idx
(Continued on next page)
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If you have the XML translation option, you may need to move these files.

Application TP rules files apptptbl.dat and apptptbl.idx

Application TP Cross 
Reference

appxref.dat and appxref.idx

File Type File Name

First level Elements xmlspl1.dat and xmlspl1.idx

Second level Elements xmlspl2.dat and xmlspl2.idx

Third level Elements xmlspl3.dat and xmlspl3.idx

Trading Partnership rules xmltbtpl.dat and xmltbtpl.idx

Trading Partnership cross 
reference

xmlxref.dat and xmlxref.idx

XML document specifier 
mapping files

ds_map_xml.dat and ds_map_xml.idx

ds_name.dat and ds_name.idx

ds_tptbl_xml.dat and ds_tptbl_xml.idx

 (Contd)
File Type File Name
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How to Select a Time to Move Files

Introduction When you move files from source to destination, you stop Gentran:Server 
processing. For Gentran:Server for UNIX product levels, you also stop client 
access to the host. For this reason, you should move files when halting 
processing is least likely to cause problems for your organization and for your 
users.

Questions to
answer

Answer these questions to find the best time for moving files.

◗ What day of the week or month, if any, does your organization not run 
Gentran:Server?

◗ What time of day is processing least likely?
◗ Which Gentran:Server processes are scheduled and when are they run?
◗ How long do you think it will take to move the files to the destination 

environment?
◗ When are other users least likely to require access to Gentran:Server?
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Overview 0

Introduction

In this chapter This chapter describes the tasks and procedures you must complete before 
moving files from the source environment to the destination environment.

Key terms This table lists the key terms used in this chapter.

Term Description

absolute path name The full address or path to a file starting at root or /.

ASCII A text based code for representing alphanumeric 
information in a computer.

environment variable A variable that assigns default values within a specific 
environment. Sometimes called keyword variables or 
user-defined variables.

FTP command A command used to transfer files between machines that 
have a direct connection.

host The server in a client/server network that performs the 
system security, data storage, and major computing 
tasks.

ISAM Indexed sequential access method. A two-part file 
organization in which records are stored in one file, 
while another file contains an index that shows the 
location of each record.

isops A Gentran:Server utility used to unload and load 
selected ISAM files.

load The process of converting a .unl file (ASCII file) back to 
an ISAM file format with a utility designed for this 
purpose.

destination 
environment

The area in your computer that runs Gentran:Server to 
process live data.

(Continued on next page)
Maintenance and Troubleshooting Guide – August 2004



Preparing to Move Files Introduction 5 - 3
source environment The area in your computer that you use to: 

◗ Test software upgrades,
◗ Run data conversion programs, or
◗ Test new maps, Trading Partnership records, and 

other Gentran:Server components.

.unl The file extension for an ISAM file that has been 
converted to an ASCII file by a Gentran:Server unload 
utility.

unload The process of converting an ISAM file to an ASCII file 
with a utility designed for this purpose.

unload/load utility A Gentran:Server utility program that converts an 
ISAM file to an ASCII file and reconverts it after you 
have moved it to another machine. 

user login A UNIX ID with associated password and permissions.

user master file The file that contains the Gentran:Server security 
system’s user records.

 (Contd)
Term Description
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Preparing the Destination 
Environment 0

Overview

Introduction Indexed Sequential Access Method (ISAM) files must exist on the destination 
environment before you move files from the source environment. You must create 
empty files on the destination environment if none currently exist. 

You should perform these tasks before you prepare your source environment in 
order to reduce the amount of time your system is unavailable to other users.

In this section This section provides the procedure for creating empty ISAM and pattern files on 
the destination environment. 
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How to Create Empty ISAM Files

Introduction The load utility overwrites existing ISAM files; it does not create new files. 
Therefore, you must create empty ISAM and files on the destination environment 
before moving files from your source environment. 

When to use Use this procedure to create an empty ISAM file when the destination machine 
does not have the ISAM files that you want to move.

Procedure Use this isops command to create an empty ISAM file.

isops -l -f <isams_prefix> </dev/null

where <isams_prefix> is the name of the ISAM file.

Example
Use this command to create an empty pattern file.

isops -l -f pat </dev/null

Note
You also can run isops from the Run Program option on the Tools menu.

Reference
See the Command Reference in the Gentran:Server for UNIX and Workstation 
Technical Reference Guide for more information about running the isops 
program.
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Preparing the Source 
Environment 0

Overview

Introduction The process of moving files from one environment to another requires that the 
source environment be unavailable to all other users and clients. There are a 
number of steps you must take to ensure that no files or data are lost or damaged. 

In this section This section provides the procedures and information you need to safely move 
files from your source environment. You must follow these procedures in order to 
prevent unnecessary work and to minimize the amount of time that the system is 
unavailable to other users.

Before you begin Before you begin preparing for the movement of files from one environment to 
another, you must complete the planning process explained in the chapter 
Planning the Move of this guide. If you have completed the planning process, you 
are ready to begin preparing your destination and source environments for the 
movement of files.
Maintenance and Troubleshooting Guide – August 2004



Preparing to Move Files The Workstation Preparation Process 5 - 7
The Workstation Preparation Process

Process diagram This illustration shows the preparation process for the Workstation product.

(Continued on next page)
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Tasks in the
preparation

process

This table describes the tasks in the preparation process.

Task Description

1 Choose the file transfer method.

Reference
See the section Choosing a File Transfer Method in the Planning 
the Move chapter for instructions.

2 Back up your source files.

Reference
See your operating system documentation for instructions.

3 Set up and install Gentran:Server in the destination environment.

Reference
See your operating system documentation for instructions.

4 Stop FTP processes within the destination environment.

Reference
See your operating system documentation for instructions.
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Introduction

In this chapter This chapter contains general instructions for how to move these types of files:

◗ ASCII files
◗ Binary files
◗ ISAM files

The chapter also contains specific instructions for moving:

◗ Trading Partnership records
◗ Trading Partnership-related files
◗ Maps and related files
◗ LOCKS files
◗ Custom shell scripts.

Key terms This table lists the key terms used in this chapter.

Term Description

ASCII A text-based code for representing alphanumeric 
information in a computer.

FTP File Transfer Protocol. Protocol used to transfer files 
between computers.

ISAM Indexed sequential access method--a two-part file 
organization in which records are stored sequentially in 
one part of the file, while another part of the file 
contains an index that shows the location of each 
record. 

isops A Gentran:Server utility used to unload and load ISAM 
files.

load The process of converting a .unl file (ASCII file) back to 
an ISAM file format with a utility designed for this 
purpose.

protocol A standard set of rules, instructions, or formats for 
organizing data so it can be transferred between 
computer systems.

(Continued on next page)
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.unl The file extension for an ISAM file that has been 
converted to an ASCII file by the Gentran:Server 
unload utility. 

unload The process of converting an ISAM file to an ASCII file 
with a utility designed for this purpose.

unload/load utility A Gentran:Server utility program that enables you to 
convert an ISAM file to an ASCII file and reconvert it 
after you have moved it to another machine. 

 (Contd)
Term Description
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Moving ASCII and Binary 
Files 0

Overview

What is an ASCII
file?

ASCII is a national standard for encoding American computer data. It has a 
standard 7-bit code with a parity code used for the interchange of data between 
software and hardware.

An ASCII file is a data file that contains words, program sources, shell scripts, or 
other text that conforms to the ASCII standard. Most UNIX systems use ASCII text 
for recording character data.

What is an ASCII
file?

A file containing a string of bits, initially utilized to define a file that contains codes 
not part of the ASCII set. 

File extensions Gentran:Server files with the following extensions are ASCII files.

◗ .unl 
◗ .vmp
◗ .ddf
◗ .app
◗ .ig
◗ .scr
◗ .bat

Gentran:Server files with the following extensions are binary files.

◗ .map
◗ .tpl
◗ .TBL

(Continued on next page)
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Moving ASCII
and binary files

You move ASCII and binary files with copy commands and file transfer 
commands. The command you use depends on whether you are moving a file to 
another location on the same machine, to media, or to a linked machine.
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How to Move a Single ASCII or Binary File

Introduction The command you use to move a single ASCII or binary file depends on whether 
you are moving a file to another location on the same machine or to a different 
machine.

Same PC In Windows Explorer or My Computer, click the file or folder you want to move.

Use your Windows® operating system’s copy and paste options (Edit menu) or 
drag and drop functions to move the file into the destination folder.

Reference
See your Windows documentation for complete instructions on moving files.

 PC to PC To move a file, you can use:

◗ Windows Explorer
◗ My Computer
◗ FTP software

Example
To move a file to an unlinked PC machine, in Windows Explorer or My 
Computer, select the file or folder you want to move. Use your Windows® 
operating system’s copy and paste options (Edit menu) or drag and drop 
functions to move the files to media, such as a diskette. Then, copy the file 
from the media to the destination PC. 

Note
If you use a tape as your transfer medium, use the tape software to transfer 
the file to and from the tape. 

Reference
See your Windows documentation for complete instructions.
Maintenance and Troubleshooting Guide – August 2004



Moving Files How to Move Several ASCII or Binary Files 6 - 7
How to Move Several ASCII or Binary Files

Introduction You can move several ASCII or binary files at once. To do so, create a list of the 
files you want to move. You then issue a copy command, using the list name in 
place of the file name. This prompts the system to move all the files on the list. 

Comment
To move an ISAM file, you must first use an unload utility to change it into 
an ASCII file.

PC to PC In Windows Explorer or My Computer, hold down the CTRL key, and then click the 
items you want to move.

Use your Windows® operating system’s copy and paste options (Edit menu) or 
drag and drop functions to move the files to media, such as diskettes.

Note
If you use a tape as your transfer medium, use the tape software to transfer 
the files to and from the tape.
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Moving ISAM Files 0

Overview

ISAM file
extensions

Indexed Sequential Access Method (ISAM) files have a special type of file 
organization. You can recognize ISAM files by their .dat and .idx file name 
extensions.

File structure In ISAM files, records are stored in one part of the file. Another part of the file 
contains an index that shows the location of each record for access purposes.

Unload and load
utilities

You must change ISAM files to ASCII before moving them to another machine. 
Simple copy and FTP commands are unable to correctly handle ISAM files. 

Gentran:Server provides utilities that change ISAM files to ASCII files (unload)   
and change ASCII files back to ISAM files (load). 

Example
The utility used to unload and load Trading Partnership files is tpmv.

Reference
For a complete list of the unload/load utilities, see the chapter Command 
Reference in the Gentran:Server for UNIX and Workstation Technical 
Reference Guide.

(Continued on next page)
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Specific unload
and load utilities

The ISAM files below have unload and load utilities designed especially for them. 
The utilities are available from either the command line or a menu of the 
subsystem editor (for example, from the Tools menu in Trading Partnership 
Administration).

◗ Trading Partnership records
◗ Supplementary TRADACOMS Trading Partnership records
◗ Generic synonym lists
◗ Specific synonym lists
◗ Thesaurus lists
◗ Contact records
◗ Organization records
◗ Category records
◗ Archive data records.
◗ Trading Partnership cross-reference records
◗ XML Configuration records (if you have the XML translation option)

isops utility The Gentran:Server isops utility is a generic unload and load utility that you can 
use to unload or load any ISAM file, including those for which specially designed 
utilities exist. 

You can run isops from the command line or from the Run Programs command 
under the Main window Tools menu.

This table lists the file names defined for the isops command and the product 
levels to which they apply.

CAUTION
Use the same path on the source and destination machine for the 
<dm>_arch, edihist, mboxfr, and .q files. 

File name Definition Product Level

apptptbl Application Trading 
Partnership Rules Table

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

appxref Trading Partner Code 
cross reference table for 
application files

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

(Continued on next page)
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catvalue Trading Partner 
category values file

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

contact Trading Partner contact 
file

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

dlname The distribution list file. Gentran:Server for UNIX with 
Process Control Manager and 
higher.

dm The data manager 
configuration record file.

Gentran:Server for UNIX with 
Process Control Manager and 
higher.

<dm>_arch The archive file for the 
specified data manager.

Gentran:Server for UNIX with EC 
Workbench and higher.

.dmcfg The data manager 
configuration file.

Gentran:Server for UNIX with 
Process Control Manager and 
higher.

dstlst The distribution mailbox 
list file.

Gentran:Server for UNIX with 
Advanced Data Distribution and 
higher.

ds_name The document 
reference number 
specifier file.

Gentran:Server for UNIX with 
Process Control Manager and 
higher.

ds_map The EDI document 
reference number 
specifier mapping file.

Gentran:Server for UNIX with 
Process Control Manager and 
higher.

ds_tptbl The EDI document 
reference number 
specifier TP file.

Gentran:Server for UNIX with 
Process Control Manager and 
higher.

ds_map_app The APP document 
reference number 
specifier mapping file.

Gentran:Server for UNIX with 
Process Control Manager and 
higher.

(Continued on next page)
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File name Definition Product Level
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ds_tptbl_app The APP document 
reference number 
specifier TP file.

Gentran:Server for UNIX with 
Process Control Manager and 
higher.

edihist The EDI history file. Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

mbox The Mailbox file. Gentran:Server for UNIX with 
Advanced Data Distribution and 
higher.

mboxfr The Mailbox file 
register.

Gentran:Server for UNIX with 
Advanced Data Distribution and 
higher.

org The Trading Partner 
organization file.

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX

pat Pattern file Gentran:Server for UNIX with 
Process Control Manager and 
higher.

patlst Pattern list file Gentran:Server for UNIX with 
Process Control Manager and 
higher.

.q The queue file. Gentran:Server for UNIX with 
Process Control Manager and 
higher.

.scrcfg The script configuration 
file.

Gentran:Server for UNIX with 
Process Control Manager and 
higher.

stdin Records are read from 
standard input (used 
with -l).

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

stdout Records are written to 
standard output (used 
with -u).

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

(Continued on next page)
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(Continued on next page)

stderr Write all user messages 
to standard error.

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

tp The Trading Partner file. Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

tpmisc Miscellaneous Trading 
Partner information file.

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

tprecon Trading Partner 
reconciliation file.

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

tradacom The Tradacom file Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

trn The transaction register 
file.

Gentran:Server for UNIX with 
Process Control Manager and 
higher.

xtable The Standard Cross 
Reference Table file

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

 (Contd)
File name Definition Product Level
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XML translation option
If you have the XML translation option, you can also use isops to unload 
and load these files:

File name Definition Product Level

xmlspl1
xmlspl2
xmlspl3

Splitting Element Table 
files (by level)

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

xmltptbl XML Trading 
Partnership Rules table

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.

xmlxref Trading Partnership 
Cross Reference table

Gentran:Server Workstation.

All levels of Gentran:Server for 
UNIX.
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How to Unload an ISAM File

Introduction An unload utility converts an ISAM file format into an ASCII file so that you can 
move the file to another machine.

Specific unload
and load utilities

The following ISAM files have unload and load utilities designed especially for 
them. The utilities are available from either the file editor or the command line.

◗ Trading Partnership records
◗ Supplementary TRADACOMS Trading Partnership records
◗ Contact records
◗ Organization records
◗ Standard cross-reference records
◗ Generic synonym lists (Visual Mapper only)
◗ Specific synonym lists (Visual Mapper only)
◗ Thesaurus lists (Visual Mapper only)
◗ XML Configuration records (if you have the XML translation option)

Reference
See the topic How to Move All Trading Partnership Records in this chapter 
for instructions on moving all your Trading Partnership records.

Using isops to
unload an ISAM

file

If a specific unload option is not available from the Gentran:Server menus or 
command line, you can use the isops command to unload the ISAM file. You can 
runs isops from the command line or from the Run Programs command under the 
Main window Tools menu.

Procedure Use this isops command to unload an ISAM file.
isops -u -f <filename> > <filename>.unl

Example
Use this isops command to unload the ds_name file to ds_name.unl.

isops -u -f ds_name > ds_name.unl

Reference
See the Command Reference chapter in the Gentran:Server for UNIX and 
Workstation Technical Reference Guide for detailed descriptions of all 
isops options.
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How to Load an ISAM File

Introduction A load utility converts a .unl file (ASCII file) back to an ISAM file format.

When to use Use this procedure after you have unloaded an ISAM file to a .unl ASCII file and 
moved the .unl file to the destination.

Specific unload
and load utilities

The ISAM files below have unload and load utilities designed especially for them. 
The utilities are available from either the file editor or the command line.

◗ Trading Partnership records
◗ Supplementary TRADACOMS Trading Partnership records
◗ Contact records
◗ Organization records
◗ Generic synonym lists (Visual Mapper only)
◗ Specific synonym lists (Visual Mapper only)
◗ Thesaurus lists (Visual Mapper only)
◗ XML Configuration records (if you have the XML translation option)

Reference
See the topic How to Move All Trading Partnership Records in this chapter 
for instructions on moving all your Trading Partnership records.

Using isops to
load an ISAM file

If a specific load option is not available from the Gentran:Server menus or 
command line, you can use the isops command to load the ISAM file. You can 
runs isops from the command line or from the Run Programs command under the 
Main window Tools menu.

(Continued on next page)
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Procedure Use this isops command to load an a .unl file to an ISAM file.

isops -l -f <filename> < <filename>.unl

Example
Use this isops command to load the ds_name.unl file to ds_name.dat/.idx.

isops -l -f ds_name < ds_name.unl

Reference
See the Command Reference chapter in the Gentran:Server for UNIX and 
Workstation Technical Reference Guide for detailed descriptions of all 
isops options.
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How to Move ISAM Files to Another Machine

Introduction You can move either all records or some records in an ISAM file to another 
machine.

Procedure Use this procedure to move the records in an ISAM file.

Step Action

1 Go to the source environment and unload the ISAM files.

System Response
The utility reads the ISAM file and converts the data to an 
ASCII file and gives it an extension of .unl.

Reference
See the topic Moving Other Process Files in this chapter for 
instructions.

Note
Some unload utilities are available from a Gentran:Server 
menu or from the command line.

2 Do you want to move all the ISAM records in the file?

◗ If YES, continue with Step 3.
◗ If NO, use an editor to remove the unwanted records from the 

.unl file and save your changes.

Reference
See the Gentran:Server for UNIX and Workstation Technical 
Reference Guide for selected ISAM file record layouts.

3 Using an ASCII file transfer method, send or copy the .unl file to the 
appropriate directory on the destination machine.

4 Log on to the destination machine and change the current directory 
to the Gentran:Server root directory for the destination 
environment.

(Continued on next page)
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5 Does the ISAM file already exist in the destination environment?

◗ If YES, continue with Step 6.
◗ If NO, you must create an empty one.

Reference
See the topic How to Create Empty ISAM Files in the chapter 
Preparing to Move Files for more information about creating 
empty ISAM files.

6 Load the .unl file to the appropriate directory.

System Response
Gentran:Server copies the file, converts the copy to an ISAM 
file, and appends the new file to the existing file.

Reference
See the topic How to Load an ISAM File in this chapter for 
instructions.

 (Contd)
Step Action
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Moving Trading 
Partnership Records and 
Related Files 0

Overview

Trading
Partnership

records

The Trading Partnership core records include inbound and outbound translation 
information. They also include all Trading Partnership information for X12 and 
EDIFACT translation except organization and contact information. 

Files related to the Trading Partnership core records include:

◗ Category records
◗ Contact records
◗ Organization records
◗ Standard Cross Reference records
◗ Supplementary TRADACOMS Trading Partnership records

The load/unload
file utility

To move Trading Partnership records from one machine to another, use the load/
unload utility. This is the recommended method. 

◗ The unload utility reads a Trading Partnership file (ISAM) and converts the 
data to an ASCII file that you can safely move. The ASCII files have the 
extension .unl.

◗ The load utility converts an ASCII file to its original ISAM format. ISAM files 
have an extension of .dat and .idx.

Moving options You can move:

◗ All Trading Partnership records
◗ Selected records
◗ All TRADACOMS supplementary Trading Partnership records.

The topics within this section contain instructions for each type of move.

(Continued on next page)
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Before you begin Before you begin moving trading partnership records, you must check the TP 
directory on the source and destination machines for the required ISAM files and 
create empty copies of any missing files. You must also open Trading Partnership 
Administration in Gentran:Server.

Checking ISAM
files

You can open Trading Partnership Administration only if these files exist in the TP 
directory.

◗ tp.dat, tp.idx
◗ tpmisc.dat, tpmisc.idx
◗ tprecon.dat, tprecon.idx
◗ tradacom.dat, tradacom.idx
◗ contact.dat, contact.idx
◗ org.dat, ord.idx
◗ xtable.cat/idx

You must create empty versions of any missing files before opening Trading 
Partnership Administration.

Note
You can create settings only if these files exist in the TP directory.

◗ cattype.dat
◗ catvalue.dat, catvalue.idx

You must create empty versions of any missing files before creating settings.

Creating ISAM
files

To create empty versions of required ISAM files, run the appropriate command 
line programs on the machine from which they are missing. This table describes 
the command line programs you must run to create the required ISAM files.

IF you want to create... THEN run the...

Trading Partnership files: tp.dat, tp.idx tpcreate command line program.

TRADACOM files: tradacom.dat, 
tradacom.idx

tccreate command line program.

Category files: cattype.dat, 
catvalue.dat, catvalue.idx

catcreat command line program.

Contact files: contact.dat, contact.idx cocreate command line program
(Continued on next page)
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Reference
See the topic How to Create Empty ISAM Files in the chapter Preparing to 
Move Files for more information about creating empty ISAM files.

Opening Trading
Partnership

Administration

You must open Gentran:Server Trading Partnership Administration on the source 
machine before unloading files. You unload files as part of the process by which 
you move files. 

You will load the files after opening Gentran:Server Trading Partnership 
Administration on the destination machine.

To open Gentran:Server and the Trading Partnership Administration window, 
follow this procedure.

Organization files: org.dat, org.idx orgcreat command line program

Standard Cross Reference Table files: 
xtable.dat, xtable.idx

xcreat command line program

 (Contd)
IF you want to create... THEN run the...

Step Action

1 Open Gentran:Server

2 Click the Trading Partnership Administration icon.
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How to Move All Trading Partnership Records

Names of
Trading

Partnership files

Your Trading Partnership file, tp.dat and tp.idx, is an indexed file that contains all 
the basic Trading Partnership records in your Gentran:Server environment. 
Additional Trading Partnership information is stored in these files:

◗ tpmisc.dat and tpmisc.idx
◗ tradacom.dat and tradacom.idx
◗ tprecon.dat and tprecon.idx

Moving a
Trading Partner

file

Use this procedure to move a Trading Partnership file.

Step Action

1 Start a client that connects to the source environment.

2 Click on the Trading Partnership Administration icon from the Main 
window.

System Response
The Trading Partnership Administration window is displayed.

3 Select Tools.

4 Click Unload on the Tools menu.

5 Click Trading Partnership Record on the Unload submenu.

System Response
Gentran:Server copies the Trading Partnership files and 
converts the copies to ASCII files with these names:

◗ tp.unl
◗ tpmisc.unl
◗ tradacom.unl
◗ tprecon.unl

The system displays a message that indicates the number of 
records it unloaded.

6 Using an ASCII transfer method, send or copy the .unl files to the 
trading partner directory on the destination machine.

7 Exit the client that is logged into the source environment.
(Continued on next page)
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8 Start the client that connects to the destination environment and 
open Trading Partnership Administration.

9 Click Tools on the menu bar.

10 Click Load on the Tools menu.

11 Click Trading Partnership Record on the Load submenu. 

System Response
Gentran:Server copies the files, converts the copies to 
indexed Trading Partnership files, and appends the new files 
the existing files. The system displays a message that 
indicates the number of records it loaded.

 (Contd)
Step Action
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How to Move Selected Trading Partnership Records

Introduction You can select and unload Trading Partnership records by Group Organization 
Code or Interchange Organization Code.

Moving Selected
Records for

Multiple Codes

When you move selected Trading Partnership records, Gentran:Server overwrites 
the existing ASCII Trading Partnership files.

◗ tp.unl
◗ tpmisc.unl
◗ tradacom.unl
◗ tprecon.unl
◗ contact.unl
◗ org.unl

You must copy the files for the first code to the destination machine and load them 
before moving the records for a second code.

Warning
Gentran:Server overwrites the existing ASCII Trading Partnership files 
each time you move selected records. These files can contain only the 
records for one code at a time when you move selected Trading Partnership 
records.

Procedure Use this procedure to move selected Trading Partnership records from one PC to 
another or from one UNIX machine to another.

Step Action

1 Select Unload from the Tools menu on the Trading Partnership 
Administration menu bar.

2 Click Selective Unload of the Trading Partnership.

System Response
The system displays the Selective Unload of Trading Partner 
Records dialog box.

(Continued on next page)
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3 Do you want to unload Trading Partnership records by Interchange 
Level Organization?

◗ If YES, click the Interchange Level Organization option 
button and GO TO Step 5.

◗ If NO, continue with the next step.

4 Click the Group Level Organization option button.

5 Click Selective Organization.

System Response
The system displays the Select Interchange/Group 
Organization To Unload Trading Partnerships dialog box.

6 Select the Interchange ID or Organization Code for the records you 
are moving, then click OK.

System Response
Gentran:Server copies the selected Trading Partnership 
records and converts the copies to ASCII files with these 
names:

◗ tp.unl
◗ tpmisc.unl
◗ tradacom.unl
◗ tprecon.unl
◗ contact.unl
◗ org.unl

The system displays a message that indicates the number of 
records it unloaded.

7 Using an ASCII transfer method, send or copy the .unl files to the 
Trading Partner directory on the destination machine.

8 Exit the client that is logged into the source environment or the 
Workstation computer that contains the environment.

9 Start the Windows client or Workstation computer that connects to 
the destination environment and open TP Administration.

10 Click Tools on the menu bar.

11 Click Load on the Tools menu.
(Continued on next page)

 (Contd)
Step Action
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12 Click Trading Partnership Record on the Load submenu.

System Response
Gentran:Server copies the Trading Partner file, converts the 
copy to an indexed Trading Partnership file, and appends the 
new file to the existing file. The system displays a message 
that indicates the number of records it loaded. 

13 Click Contact Records on the Load submenu.

System Response
Gentran:Server copies the file, converts the copy to an 
indexed Contact Records file, and appends the new file to 
the existing file. The system displays a message that 
indicates the number of records it loaded. 

14 Click Organization Records on the Load submenu.

System Response
Gentran:Server copies the file, converts the copy to an 
indexed Organization Records file, and appends the new file 
to the existing file. The system displays a message that 
indicates the number of records it loaded. 

 (Contd)
Step Action
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How to Move TRADACOMS Supplementary TP 
Records

Introduction Additional information is available for Trading Partnerships using TRADACOMS 
standards. This information is kept in supplementary records. The file containing 
this information is named tradacom.

Procedure Use this procedure to move TRADACOMS supplementary Trading Partnership 
records from one machine to another.

Step Action

1 Unload the TRADACOMS supplementary Trading Partnership 
records by issuing this command from the command line:
tcmv -u -cp <path to config file>

System Response
Gentran:Server copies the TRADACOMS records and 
converts the copy to an ASCII file with the name 
tradacom.unl. The system displays a message indicating the 
number of records it unloaded.

2 Using an ASCII transfer method, send, or copy the tradacom.unl file 
to the trading partner directory on the destination machine.

Reference
See the topic How to Move a Single ASCII or Binary File in 
this chapter for instructions.

3 Log on to the destination machine and change the current directory 
to the Gentran:Server root directory.

(Continued on next page)
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4 Load the tradacom.unl file to the trading partner directory on the 
destination PC by issuing this command from the DOS command 
line: tcmv -l -cp <path to config file>

System Response
Gentran:Server copies the file, converts the copy to an 
indexed Trading Partnership file, and appends the new file to 
the existing file. The system displays a message indicating 
the number of records it loaded.

Reference
See the chapter Command Reference in the Gentran:Server 
for UNIX and Workstation Technical Reference Guide for 
information about related parameters.

 (Contd)
Step Action
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How to Move Organization Records

Introduction The file containing the Trading Partnership organization records is the 
organization file (org.dat/idx).

You must move the organization file if you move the Trading Partnership records 
to which they are related. 

Moving
Organization

files to another
machine

Use this procedure to move files from one machine to another.

Step Action

1 Click Tools on the Trading Partnership Administration menu bar.

2 Select Unload from the Tools menu.

3 Select Organization Record from the Unload menu.

System Response
Gentran:Server copies the organization file and converts the 
copy to an ASCII file with the name org.unl. The system 
displays the number of records that it unloaded.

4 Using an ASCII transfer method, send or copy the org.unl file to the 
trading partner directory on the destination machine.

5 Exit the client that is logged into the source environment or the 
Workstation computer that contains the environment.

6 Start the Windows client or Workstation computer that connects to 
the destination environment and open Trading Partnership 
Administration.

7 Click Tools on the menu bar.

8 Click Load on the Tools menu.

9 Click Organization Record from the Tools menu.

System Response
Gentran:Server copies the file, converts the copy to an 
indexed organization file, and appends the new file to the 
existing file. The system displays the number of records that 
it loaded.
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Moving Contact Records

Introduction The file containing contact records is the contact file (contact.dat/idx). 

You must move this file if you move the Trading Partnership records to which they 
are related.

Moving contact
records

Use this procedure to move files from one machine to another.

Step Action

1 Click Tools on the Trading Partnership Administration menu bar.

2 Click Unload on the Tools menu.

3 Click Contact Record on the Unload submenu.

System Response
Gentran:Server copies the contact file and converts the copy 
to an ASCII file with the name contact.unl. The system 
displays the number of records that it unloaded.

4 Using an ASCII transfer method, send or copy the contact.unl file to 
the trading partner directory on the destination machine.

5 Exit the client that is logged into the source environment or the 
Workstation computer that contains the environment.

6 Start the Windows client or Workstation computer that connects to 
the destination environment and open Trading Partnership 
Administration.

7 Click Tools on the Trading Partnership Administration menu bar.

8 Click load on the Tools menu.

9 Click Contact Record on the Load submenu.
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How to Move Standard Cross Reference Records

Introduction The file containing the Standard Cross Reference Table records is the file 
(xtable.dat/idx).

Moving Standard
Cross Reference

files to another
machine

Use this procedure to move files from one UNIX machine to another.

Step Action

1 Click Tools on the Trading Partnership Administration menu bar.

2 Select Unload from the Tools menu.

3 Select Standard Cross Reference Records from the Unload 
menu.

System Response
Gentran:Server copies the file and converts the copy to an 
ASCII file with the name xtable.unl. The system displays the 
number of records that it unloaded.

4 Using an ASCII transfer method, send or copy the xtable.unl file to 
the destination machine.

5 Exit the client that is logged into the source environment.

6 Start the client that connects to the destination environment and 
open Trading Partnership Administration.

7 Click Tools on the Trading Partnership Administration menu bar.

8 Click Load on the Tools menu.

9 Click Standard Cross Reference Records from the Tools menu.

System Response
Gentran:Server copies the file, converts the copy to an 
indexed organization file, and appends the new file to the 
existing file. The system displays the number of records that 
it loaded.
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Moving Maps and Map-
related Files 0

Overview

Introduction Maps usually have one or more related files that must be moved along with the 
map. Related files include:

◗ Trading Partnership record
◗ File definition (Application Integration maps only)
◗ Application description (Visual Mapper maps only)
◗ Generic synonym list (Visual Mapper maps only)
◗ Specific synonym list (Visual Mapper maps only)
◗ Thesaurus list (Visual Mapper maps only)

Procedure Use this procedure to move map files.

Step Action

1 Move the map.

Reference
See the topic How to Move Application Integration Maps in 
this chapter for instructions.

2 Is the map for outbound processing?

◗ If YES, use an ASCII file transfer method to move the file 
description associated with the map.

◗ If NO, you are finished moving the map file.

Reference
See the topic How to Move a Single ASCII or Binary File in 
this chapter for instructions.
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How to Move Application Integration Maps

Introduction Uncompiled and compiled Application Integration maps are stored as binary files 
(<mapname>.map). You can move both map types using a binary transfer 
method such as FTP using the binary (bi) switch. 

Moving compiled
maps

Use this procedure to move compiled maps from one machine to another.

Step Action

1 Using a binary transfer method, send or copy the following file(s) to 
the appropriate directories on the destination machine:

◗ <map_directory>\<mapname>.tpl
◗ <map_directory>\<mapname>.map
◗ <file_definition>\<file_definition_name>.ddf. (Use ASCII 

transfer method)

Note
The file definition is necessary for outbound maps in all 
Gentran:Server product levels.

2 Did you transfer uncompiled map files?

◗ If YES, compile the transferred maps.
◗ If NO, you are finished.

Reference
See the Gentran:Server for UNIX and Workstation 
Application Integration Guide for instructions on compiling 
maps.
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How to Move Visual Mapper Maps

Introduction If you use the Visual Mapper, you should move only uncompiled maps from one 
machine to another, and compile the maps after you move them. Uncompiled 
maps are stored as map files with a .vmp extension (<mapname>.vmp).

Moving
uncompiled

maps

Use this procedure to move uncompiled maps from one machine to another.

Step Action

1 Using an ASCII transfer method, send or copy the following file(s) to 
the appropriate directories on the destination machine:
◗ <map_directory>\<mapname>.vmp
◗ <app_directory>\<appname>.app

2 Compile the transferred maps.

Reference
See the Gentran:Server for UNIX and Workstation Mapping 
and Translation Guide for instructions on compiling maps.
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How to Move the Generic Synonym List

Introduction If you use the Visual Mapper, you may need to move the generic synonym list. 
The generic synonym list applies to one or more (or even all) maps. You can have 
only one generic synonym file in your Gentran:Server environment at any one 
time. The name of the generic synonym file is generic.dat/idx. 

Moving a generic
synonym file

Use this procedure to move the Visual Mapper’s generic synonym file from one 
machine to another.

Step Action

1 Open the Synonym Editor in Gentran:Server. 

2 Click File on the Synonym Editor menu bar.

3 Click Unload File on the File menu.

System Response
Gentran:Server reads and converts the generic synonym file to an 
ASCII file with the name generic.unl. The system displays the 
number of records it unloaded.

4 Specify the path and generic.unl in the Unload File dialog box.

5 Using an ASCII transfer method, send or copy the generic.unl file to 
the maps directory on the destination machine.

6 Start the Windows client or Workstation computer that connects to 
the destination environment and change to the Gentran:Server root 
directory.

7 If there is no generic synonym file on the destination machine, 
create an empty one now by issuing this command from the 
command line:
sncreate <map_directory>/generic -cp <config path>

8 Exit the client that is logged into the source environment or the 
Workstation computer that contains the environment.

9 Start the Windows client or Workstation computer that connects to 
the destination environment and open Trading Partnership 
Administration.

(Continued on next page)
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10 Open the Synonym Editor in Gentran:Server.

11 Click File on the Synonym Editor menu bar.

12 Click Load File on the File menu.

13 Specify the path and generic.unl in the Load File dialog box.

System Response
Gentran:Server copies the file, converts the copy to an indexed 
generic synonym file, and appends the new file to the existing file. 
The system then displays the number of records it loaded.

 (Contd)
Step Action
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How to Move Specific Synonym Lists

Introduction If you use the Visual Mapper, you may need to move the specific synonym lists 
associated with your maps. A specific synonym list applies to a single map. You 
can have one specific synonym file in your Gentran:Server system for each map. 
The name of the specific synonym file is <mapname>.dat/idx, where <mapname> 
represents the name of the map. 
The file contains all the specific synonym lists for a map in the following format:
listname|original value|substitute value.

Moving specific
synonym lists

Use this procedure to move all specific synonym lists for a Visual Mapper map 
from one machine to another.

Step Action

1 Unload the specific synonym file by issuing this command from the 
UNIX command line: 
synmv <map_directory>/<mapname> -u -cp<config path>

System Response

Gentran:Server reads and converts the specific synonym file 
to an ASCII file with the name <mapname>.unl. The system 
then displays the number of records it unloaded.

2 Using an ASCII transfer method, send or copy the <mapname>.unl 
file to the maps directory on the destination machine.

3 Start the Windows client or Workstation computer that connects to 
the destination environment and change to the Gentran:Server root 
directory.

4 If there is no specific synonym file with this name on the destination 
machine, create an empty one now by issuing this command from 
the command line:
sncreate <map_directory>/<mapname> -cp <config path>

(Continued on next page)
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5 Load the <mapname>.unl file to the maps directory on the 
destination machine by issuing this command from the command 
line:
synmv <map_directory>/<mapname> -lo -cp <config path>

System Response
Gentran:Server copies the file, converts the copy to an 
indexed specific synonym file, and appends the new file to the 
existing file. The system displays the number of records it 
loaded.

Note
Use the -l command to overwrite the existing synonym file 
instead of appending to it.

Reference
For an explanation of the parameters recommended here for 
synmv and sncreate, see the chapter Command Reference 
in the Gentran:Server for UNIX and Workstation Technical 
Reference Guide.

 (Contd)
Step Action
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How to Move a Thesaurus List

About thesaurus
lists

If you use the Visual Mapper, you may need to move the thesaurus list. 
Thesaurus lists are available for use when automapping any map in your 
Gentran:Server environment. You can have only one thesaurus file in your 
Gentran:Server environment at any time. The name of the thesaurus file is 
thesaurs.dat/idx.

The load/unload
file feature

You must use the file load/unload feature to move the Visual Mapper’s thesaurus 
file. this feature enables you to import and export the thesaurus list as ASCII files. 

Moving the
Thesaurus

Use this procedure to move the Visual Mapper’s thesaurus file from one machine 
to another.

Step Action

1 Open the Thesaurus Editor in Gentran:Server.

2 Click File on the menu bar.

3 Click Unload File on the File menu.

4 Specify the path and thesaurs.unl in the Unload File dialog box, then 
click OK.

System Response
Gentran:Server copies the thesaurus file and converts the copy to 
an ASCII file with the name thesaurs.unl. The system then displays 
the number of records that it unloaded.

5 Using an ASCII transfer method, send or copy the thesaurs.unl file 
to the maps directory on the destination machine.

6 Exit the client that is logged into the source environment or the 
Workstation computer that contains the environment.

7 Start the Windows client or Workstation computer that connects to 
the destination environment and open Trading Partnership 
Administration.

8 Open the Thesaurus Editor in Gentran:Server.
(Continued on next page)
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9 Click File on the menu bar.

10 Click Load File on the File menu.

11 Specify the path and thesaurs.unl in the Load File dialog box.

System Response
Gentran:Server copies the file and converts the copy to an 
indexed thesaurus file. If a thesaurus file exists, 
Gentran:Server appends the new file to the existing file. The 
system then displays the number of records that it loaded.

 (Contd)
Step Action
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Moving Other Process Files

Process File Checklist

Introduction Your organization may have created custom UNIX shell scripts, DOS batch files, 
component files, and user administration files to work with your Gentran:Server 
processes. When you move Gentran:Server files from one machine to another, 
you need to move these custom files, your extension configuration files, and any 
other files that affect Gentran:Server processing.

Checklist Use this checklist to help identify other process files you may need to move. Add 
to the list any other files that affect your Gentran:Server data flow and processing.

Note
Many of the files in this list are used only with Gentran:Server for UNIX. If 
you have Gentran:Server Workstation, you will not have many of these file 
types

✔ File Type

LOCKS files (both communication device and script name locks)

Custom UNIX shell scripts or DOS batch files

User administration files

Custom Mail_Proc files

Address lists

Custom component files associated with custom shell process:

◗ C and C++ executable files
◗ Cross-reference tables
◗ Associated directory structure or permissions structure

Communications software

Custom Life Cycle entries and processes (for example, ODBC linkage)

JCL/RCL files used to wrap-around files being sent to mainframe 
computers

(Continued on next page)
Maintenance and Troubleshooting Guide – August 2004



Process File Checklist Moving Files6 - 42
Logon and FTP address information, if configured differently between 
machines

Extension entries and configuration files (for example, Baan, Oracle, 
SAP)

Other Files

✔
 (Contd)
File Type
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How to Move DOS Batch Files

Introduction DOS batch files are scripts or command files that your organization has created.

Procedure Use this table to select a file transfer method for a batch file.

Reference
See the section Moving ASCII and Binary Files in this chapter for 
instructions on transferring ASCII and binary files.

IF the file is… THEN use…

Compiled code A binary file transfer method.

Not compiled code An ASCII file transfer method.
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Cleaning Up After the Move

Contents Overview
◗ Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
◗ The Clean-Up Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Procedures
◗ How to Reset the Interchange and Group Control Numbers  . . . . . . 5
◗ How to Update the Interchange and Group ID Codes  . . . . . . . . . . . 6
◗ How to Update the Interchange Control Header Field . . . . . . . . . . . 7
◗ How to Edit Files with Absolute Path Names . . . . . . . . . . . . . . . . . . 8
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Overview 0

Introduction

In this chapter This chapter describes the tasks you must complete after you move files from a 
source environment to a destination environment.

Key terms This table lists the key terms used in this chapter.

Term Description

absolute path name The full address or path to a file starting at root, /, or \.

control numbers The counters used to keep track of the business 
documents that you send and receive.

Interchange and 
Group ID codes

Unique identifiers that are inserted into the Interchange 
envelope when data is translated.
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The Clean-Up Process

Introduction After you move Gentran:Server Workstation files from a source environment to a 
destination environment, you must clean up the destination area.

Process diagram This illustration shows the tasks in the clean-up process.

Tasks Use this task list to perform the clean-up tasks.

1
Change file ownership

if necessary

2
Edit files that reference
absolute path names

3
Reset control numbers

4
Update Interchange
and Group ID codes

5
Update the

Interchange Control
Header field

Task Description

1 If necessary, change the ownership of the files you moved so that 
the user owner of the source environment and the destination 
environment are the same.

2 Edit files that reference absolute path names.

Reference
See the topic How to Edit Files with Absolute Path Names in 
this chapter for instructions.

(Continued on next page)
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3 Do you want to reset the Interchange and Group control numbers?

◗ If YES, modify the Interchange Organization or Group 
Organization record.

Reference
See the topic How to Reset the Interchange and Group 
Control Numbers in this chapter.

◗ If NO, continue with Task 5.

4 Do you want to update the Interchange and Group ID codes?

◗ If YES, modify the Interchange Organization or Group 
Organization record.

Reference
See the topic How to Update the Interchange and Group 
ID Codes in this chapter.

◗ If NO, continue with Task 6.

5 Do you want to update the Interchange Control Header field?

◗ If YES, modify the field in the Trading Partnership record.

Reference
See the topic How to Update the Interchange Control Header 
Field in this chapter.

 (Contd)
Task Description
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Procedures 0

How to Reset the Interchange and Group Control 
Numbers

Introduction The Interchange and Group Control Numbers are the counters used to track the 
business documents that you:

◗ Send to your trading partner
◗ Receive from the trading partner.

These control numbers increase when you create a Trading Partnership record in 
a source environment and send and receive source documents. To track the 
actual counts during destination processing, you should reset the control numbers 
after you move the Trading Partnership record to the destination environment.

Procedure Use this procedure to reset the control numbers.

Reference
If you have a very large number of Trading Partner records to edit, you may 
want to use the mass edit utility. See the Working with Trading Partnerships 
chapter in the Gentran:Server for UNIX and Workstation Application 
Integration User’s Guide for instructions.

Step Action

1 Start Gentran:Server.

2 Open Trading Partnership Administration.

3 Select the Interchange Organization or Group Organization record 
that you want to modify.

4 Select Selected Item from the Edit menu to display the record.

5 Modify the values in the Control numbers fields.

6 Click OK to save your changes.
Maintenance and Troubleshooting Guide – August 2004



How to Update the Interchange and Group ID Codes Cleaning Up After the Move7 - 6
How to Update the Interchange and Group ID Codes

Introduction The Interchange and Group ID codes are unique identifiers that Gentran:Server 
inserts into the Interchange envelope when it translates data.

If you used source Interchange and Group ID codes when you created the 
Trading Partnership record in the source environment, you must replace the 
codes after you move the Trading Partnership record to the destination 
environment.

Procedure Use this procedure to update the Interchange and Group ID codes.

Comment
If you have a very large number of Trading Partner records to edit, you may 
want to use the mass edit utility. See the Working with Trading Partnerships 
chapter in the Gentran:Server for UNIX and Workstation Application 
Integration User’s Guide for instructions.

Step Action

1 Start Gentran:Server.

2 Open Trading Partnership Administration.

3 Select the Interchange Organization or Group Organization record 
that you want to modify.

4 Select Selected Item from the Edit menu to display the record.

5 Modify the values in the Interchange IDs or Group IDs fields.

6 Click OK to save your changes.
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How to Update the Interchange Control Header Field

Introduction The Interchange Control Header field defines the type of header segment used 
for the Interchange envelope.

Procedure Use this procedure to update the Interchange Control Header field.

Comment
If you have a very large number of Trading Partner records to edit, you may 
want to use the mass edit utility. See the Working with Trading Partnerships 
chapter in the Gentran:Server for UNIX and Workstation Application 
Integration User’s Guide for instructions.

Step Action

1 Start Gentran:Server.

2 Open the Trading Partnership record that you want to modify in the 
Trading Partnership Editor.

3 Click the Outbound EDI tab or the Outbound Acknowledgment 
tab.

System Response
Gentran:Server displays the outbound information.

4 Click the Edit button that is next to the Interchange Control 
Header field.

5 Enter P for Production (Destination) in the ISA15 Test/Production 
Indicator field.

6 Click OK to save your changes.
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How to Edit Files with Absolute Path Names

Definition An absolute path name is the full address or path to a file starting at root, / or \.

Moving files with
references to
absolute path

names

When you move files that reference absolute path names, you must edit the 
absolute path name to match the directory structure of the new environment. If 
you do not, Gentran:Server will not be able to find the file.

Files that may
contain absolute

path names

These types of files may contain absolute path names:

◗ Trading Partnership records
◗ Batch files (.bat)

Procedure Use this procedure to edit absolute path names in files.

Step Action

1 Open the file or record in the appropriate editor and check for any 
references to absolute path names.

2 Replace the absolute path with a relative path, a variable-based 
path, or another absolute path that matches your destination 
environment’s directory structure.

Example
Relative Path: c:\*\<file name>

Absolute Path: c:\win\mainframe\<file name>.

3 Save your changes.
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